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Introduction

Copyright statement

Copyright © 2020

Nanjing Decowell Automation Co., LTD. All rights reserved. Without the written permission of
the Company, no unit or individual is allowed to extract or reproduce the contents of this
document in part or in whole, and shall not be transmitted in any form.

MR VY E kL. WELLLINKIO A1l arc trademarks of our company.Other
registered trademarks appearing in this document shall be owned by their respective owners.

Due to product version upgrade or other reasons, the contents of this document will be updated
from time to time.Except as otherwise agreed, this document is for reference only. All statements,
information and recommendations contained in this document do not constitute a warranty of any
kind, express or implied.

The scope of this document

This document is applicable to EX series remote I/O systems

Content introduction
This document describes the technical specifications, installation, and commissioning of EX
series remote I/O modules.The main contents include:

® System Overview: Mainly introduces EX series remote I/O module product ordering
information, product composition, system architecture, product transportation, storage
environment and other contents;

Product Description: Describes the technical parameters of EX series remote I/O modules.

Installation and Disassembly Guide: Describes the installation and disassembly of EX series
remote I/O modules.

® Mechanical and Electrical Drawing: EX remote IO module dimension drawing and electrical
wiring diagram;

® Usage Guide: Through examples, the EX series remote I/O module and the communication
between the main PLC connection;

Attention

Email:contact@welllinkio.com 6
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This document describes in detail the use of well-Link's EX series remote I/O modules for those
with engineering experience.Nanjing Deckwell shall not be responsible for any consequences
arising from the use of this material.

Before using the device, read the precautions carefully and follow the safety precautions and
operating procedures for installation and commissioning.See the following symbols for the
possible hazards and extent of damage caused by incorrect use of the equipment

A Warning

This marker means

A Attention

This marker means

o Reminder

This marker means

The applicable objects

This manual provides information on the installation and commissioning of EX series remote 1/O
modules. It is designed for engineers, installers, maintenance personnel, and electricians with
automation knowledge.

Recovery and disposal

To ensure that recycling and disposal of used equipment meets environmental requirements,
contact an accredited e-waste service.

Online support

In addition to this manual, you can also refer to the official website for more product information.

http://www.welllinkio.com

Email:contact@welllinkio.com 7
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1 Overview of the EX Remote I/O system

1.1 What is a Distributed I/O System

EX series IO is a highly flexible, scalable distributed I/O module for connecting process
signals to upper controllers via a fieldbus.

1.2 Modules of an EX Distributed I/O System

EX series remote I/O modules are composed of adapter module, I/O module
(digital/analog/function module), power module, and terminal module.

s
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Figure 1-1 EX series I/O system architecture

1.3 Features of the EX distributed I/O Module

Strong combination
[ There are various I/O o Supports a variety of

communication

module models
protocols, such as

a Nna cuctam ran caticfiy

. ) e
Compact module structure, o High electrical isolation, stable

Save installation space
communication, data does not

() Direct plug terminal, Save lose packets.
system wiring time r )
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Figure 1-2 Features of The EX series /O modules

1.4 Application Domains of EX Distributed 1/0

EX series of distributed I/O modules are widely used in various fields, such as new energy,
lithium, non-standard automation, robotics, CNC machine tools, intelligent garage, logistics
sorting, educational equipment, environmental protection, heating, etc.

2 EX Remote 1/0 Module Parameters

2.1 EX Series Adapters

Adapter module can support a variety of bus communication protocols and achieve seamless
connection with the mainstream PLC; An adapter module can be connected to a maximum of 32
I/O modules and supports a maximum of 1024 signal points. A variety of status diagnosis
functions and status indicators are designed. Screw free terminal, wiring is convenient and
reliable, and the design of 45 degree network port, reduce the stress of network port, increase the
reliability of the product.Through the buttons on both sides of the module, multiple modules can
be fixed to each other, to increase the seismic performance of the system using the standard
DIN35 guide rail installation.

2.1.1 DeviceNet Adapter

® DeviceNet Adapter model and order number

Model Specifications description The order no.

EX-1010 DeviceNet adapter module 02-01-01

EX-1130 Modbus TCP bus adapter 02-01-11

Email:contact@welllinkio.com 9
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EX-1030 Modbus RTU adapter module 02-01-03
EX-1100 EtherCAT adapter module 02-01-04
EX-1110 PROFINET adapter module 02-01-05
EX-1040 Cc-link adapter module 02-01-06
EX-1050 CANopen adapter module 02-01-11
EX-1120 EtherNet/IP adapter 02-01-08
EX-1121 EtherNet/IP adapter 02-01-08-1
EX-1140 CC-Link IEFB bus adapter 02-01-09

® DeviceNet Adapter indicator definition

Serial Indicator Instructions Meaning
number
Blinking at o
Communication is normal
1Hz
Blinking at .
/O lost from the station
SHZ
System )
1 SYS o green One flash one | 10 module station number
indicator . .
out assignment failed
Two flashes I/0O module fails to be
one out configured
out 10 module is not running
System power supply is
on
UNIT System power normal
2 o green
PWR indicator .
. System power supply is
ou
not connected or faulty
I/0 power supply is
10 power on normal
3 10 PWR L green
indicator
out I/O power supply is not

Email:contact@welllinkio.com 1 0
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connected or faulty
Communication is normal,
on data transmission is
Runnin normal
4 NET-RUN Lo g green
indicator
Communication stops.
out
Data transfer stops
.. on Communication is normal
Communication
5 NET-PWR interface red .
Communication is
indicator out .
disconnected or abnormal
I/0 module system is
on
. faul
System failure ty
6 NET-ERR o red
indicator . .
I/O module is running
out
properly

® DeviceNet Adapter communication interface definition

Bit
DeviceNet communication interface Signal Signal definition
number

1 V- Power supply cathode
2 CAN L Data signal negative

Bit number 1

Bimmbe2 S8 3 SHIELD Shielding wire

Bit number 3

Bit number 4 4 CAN H Data signal positive
5 V+ Power supply positive

® DeviceNet Adapter Dial Settings

Email:contact@welllinkio.com 1 1
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DeviceNet
T Communic Communication rate
i * ation rate 2
/ cotting setting
; Dial
)| Dl 0 125kbps
Y| - Dy 1 250kbps
J setting
2 500kbps
[ J

DeviceNet Adapter parameters

Technical parameters

Bus protocol

DeviceNet
Address set 0~63
Expanding the number of I/ OS 32

Maximum input/output bytes

Bus rate 125, 250, 500kbps

Transmission distance

500 m (Max)
System side power input DC24V (18 to 36)
The system side provides 2 2 (Max)
current

Power input of the I/O port DC24V (+/-20%)

Output current of the I/O port 10 a (Max)

Power consumption

56mA

Conventional parameters

System side electrical isolation

AC500V

Protection against reverse

. support
connection PP

Over current protection This function is supported by the system, but not by the I/O

Over voltage protection

support

Email:contact@welllinkio.com
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Wire specifications 0.2 ~ 1.5 mm squared

Connection mode No screw
Overall dimensions 90 x 67 x 34 mm

Weight 240g

Protection grade 1P20
Temperature range Operating temperature - ;)0:82 i;C, storage temperature:
Relative humidity 95% no condensation

2.1.2 Modbus TCP adapter
®  Modbus TCP bus adapter model and order number

Model Specifications descrption The order no.
EX-1010 DeviceNet adapter module 02-01-01
EX-1130 Modbus TCP bus adapter 02-01-11
EX-1030 Modbus RTU adapter module 02-01-03
EX-1100 EtherCAT adapter module 02-01-04
EX-1102 EtherCAT adapter module 02-01-04-2
EX-1110 PROFINET adapter module 02-01-05
EX-1040 CC-link adapter module 02-01-06
EX-1050 CANopen adapter module 02-01-11
EX-1120 EtherNet/IP adapter 02-01-08
EX-1121 EtherNet/IP adapter 02-01-08-1
EX-1140 CC-Link IEFB bus adapter 02-01-09

2.1.3 Modbus RTU Adapters

® Modbus RTU adapter model and order number

Email:contact@welllinkio.com 1 3
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model Specifications description The order no.
EX-1010 DeviceNet adapter module 02-01-01
EX-1130 Modbus TCP bus adapter 02-01-11
EX-1030 Modbus RTU adapter module 02-01-03
EX-1100 EtherCAT adapter module 02-01-04
EX-1110 PROFINET adapter module 02-01-05
EX-1040 CC-link adapter module 02-01-06
EX-1050 CANopen adapter module 02-01-11
EX-1120 EtherNet/IP adapter 02-01-08
EX-1121 EtherNet/IP adapter 02-01-08-1
EX-1140 CC-Link IEFB bus adapter 02-01-09

Serial Indicator

number

Modbus RTU adapter indicator definition

Instructions

Blinking at 1Hz

Meaning

Communication is normal

Blinking at SHZ

1/0 lost from the station

One flash one out

10 module station number

1 SYS System indicator green assignment failed
Two flashes one 1/O module fails to be
out configured
out 10 module is not running
on System power supply is normal
System power
2 UNIT PWR green .
indicator System power supply is not
out
connected or faulty
3 10 PWR 10 power indicator | green on 1/O power supply is normal

Email:contact@welllinkio.com
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I/O power supply is not
out
connected or faulty
Communication is normal, data
on
. transmission is normal
Running indicator
4 NET-RUN lioh green
ight
& Communication stops. Data
out
transfer stops
i on 1/0 module system is faulty
System failure
5 NET-ERR i red
indicator . .
out 1/0O module is running properly
L. on Data transmission in progress
Data transmission
6 NETTX green
indicator light .
out Data is stopped or abnormal
. flash Data receiving
Data reception
7 NETRX green
indicator light .
out Data is stopped or abnormal

® Modbus RTU adapter communication interface definition

® Sct S . . o dip
Modbus RTU communication interface Bit number Signal definition
1 A RS485+
2 B RS485-
Bit number 1
Bit number 2 3 - -
Bit number 3
4 - -
Bit number 4
5 - -

switches for the Modbus RTU adapter
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Communic
ation rate

cetting

setting x

setting

Modbus RTU communication

rate setting

1 115200bps

2 57600bps

3 38400bps

4 19200bps

5 9600 BPS (default)
6 4800bps

7 2400bps

8 1200bps

® Modbus RTU adapter support function code

Function code function Functional meaning note
0x01 Read Read digital quantity output For example, the EX-3XXX module
0x02 Read Read digital quantity input For example, the EX-2XXX module
0x03 Read Read analog output For example, the EX-5XXX module
0x04 Read Read analog input For example, the EX-4XXX module
0x05 Write Write a single numeric quantity For example, the EX-3XXX module
0x06 Write Write a single analog quantity For example, the EX-5XXX module
0x0F Write Write multiple numeric quantities For example, the EX-3XXX module
0x10 Write Write multiple analog quantities For example, the EX-5XXX module

® Modbus RTU adapter communication parameters

Email:contact@welllinkio.com
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Technical parameters

Bus protocol Modbus RTU
Address set 0~99
Expanding the number of I/ OS 32

Maximum input/output bytes

Input: 256 Byte/Output: 256 Byte

The bus rate Optional: 1200/2400/57.6/38.4/19.2/4800/9600 k k k / 115.2 k
Transmission distance 1200 m (Max)
System side power input DC24V (18 to 36)
The system side provides current 2 a (Max)

Power input of the I/O port

DC24V (+/ - 20%)

Output current of the I/O port

10 a (Max)

Power consumption

System side electrical isolation

69mA

Conventional parameters

AC500V

Protection against reverse

connection

support

Over current protection

This function is supported by the system, but not by the I/O

Over voltage protection

support

Wire specifications

0.2 ~ 1.5 mm squared

Connection mode No screw
Overall dimensions 90 x 67 x 34 mm
Weight 240g

Protection grade 1P20

Temperature range

Operating temperature: -10 ~ 55°C, storage temperature: -20 ~ 85°C

Relative humidity

95% no condensation

Email:contact@welllinkio.com
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2.1.4 EtherCAT Adapter

®  EtherCAT adapter model and order number

Model Specifications description The order no.
EX-1010 DeviceNet adapter module 02-01-01
EX-1130 Modbus TCP bus adapter 02-01-11
EX-1030 Modbus RTU adapter module 02-01-03
EX-1100 EtherCAT adapter module 02-01-04
EX-1110 PROFINET adapter module 02-01-05
EX-1040 Cc-link adapter module 02-01-06
EX-1050 CANopen adapter module 02-01-11
EX-1120 EtherNet/IP adapter 02-01-08
EX-1121 EtherNet/IP adapter 02-01-08-1
EX-1140 CC-Link IEFB bus adapter 02-01-09

®  EtherCAT adapter indicator definition

Serial

Indicator

Instructions

number

Blinking at 1Hz

Meaning

Communication is normal

Blinking at 5SHZ

1/0 lost from the station

One flash one

10 module station number assignment failed

1 SYS System indicator green out
Two flashes one )
1/0 module fails to be configured
out
out 10 module is not running
on System power supply is normal
System power
2 UNIT PWR green
indicator .

out System power supply is not connected or faulty

Email:contact@welllinkio.com
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on I/O power supply is normal
3 10 PWR 10 power indicator green
out 1/O power supply is not connected or faulty
Communication is normal, data transmission is
on
normal
Running indicator flash Communication initialization complete, pre-run
4 NET-RUN . green
light
one flash Installation Run Status
out Initialization status
on Communication error
two flashes App watchdog timeout
System failure
5 NET-ERR red one flash Local error
indicator
flash Configuration error
out No Error
. on The network connection is normal
Indicators of
6 LINK/ACT1 green
Network Port 1
out Network not connected or abnormal
. on The network connection is normal
Indicators of
7 LINK/ACT2 green
network Port 2
out Network not connected or abnormal
® EtherCAT adapter communication interface definition
Ethernet interface Bit number Signal Signal definition
1 TX+ Positive end of data transmission
2 TX- Negative end of data transmission
= 1:TX+
2:TX- . L
3:RX+ 3 RX+ Positive data receiving end
4: TERM
5:TERM
£ ‘. AR 6:RX- 4 _ _
/FTTANNN\.  7:TERM
( | | | | 8:TERM
00000060 5 - -
6 RX- Data receiving negative end

Email:contact@welllinkio.com
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Connector housing PE Chassis grounding

® EtherCAT adapter communication parameters

Technical parameters

Bus protocol

EtherCAT

Address set

According to the main

Expanding the number of I/ O

32

Maximum input/output bytes

Input: 1024 Byte/Output: 1024 Byte

The bus rate

100Mbps

Transmission distance

100m (station to station distance)

System side power input

DC24V (18 to 36)

The system side provides
current

2 a (Max)

Power input of the I/O port

DC24V (+/ - 20%)

Output current of the I/O port

10 a (Max)

Power consumption

System side electrical isolation

219mA

Conventional parameters

AC500V

Protection against reverse
connection

support

Over current protection

This function is supported by the system, but not by the I/O

Over voltage protection

support

Wire specifications

0.2 ~ 1.5 mm squared

Connection mode

No screw

Overall dimensions

90 x 67 x 34 mm

Email:contact@welllinkio.com
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The weight of the 240g
Protection grade 1P20

Temperature range

Operating temperature: -10 ~ 55°C, storage temperature:
-20 ~ 85°C

Relative humidity

95% no condensation

2.1.5 PROFINET Adapter

® PROFINET adapter model and order number

model Specifications description The order no.

EX-1010 DeviceNet adapter module 02-01-01
EX-1130 Modbus TCP bus adapter 02-01-11
EX-1030 Modbus RTU adapter module 02-01-03
EX-1100 EtherCAT adapter module 02-01-04
EX-1110 PROFINET adapter module 02-01-05
EX-1040 CC-link adapter module 02-01-06
EX-1050 CANopen adapter module 02-01-11
EX-1120 EtherNet/IP adapter 02-01-08
EX-1121 EtherNet/IP adapter 02-01-08-1
EX-1140 CC-Link IEFB bus adapter 02-01-09

® PROFINET Adapter indicator definition

NSst:1

number

Indicator

SYS System indicator

instructions

Blinking at 1Hz

Meaning

Communication is normal

green Blinking at SHZ

1/0 lost from the station

One flash one out

10 module station number assignment
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Two flashes one

1/O module fails to be configured

out
out 10 module is not running
on System power supply is normal
System power
2 UNIT PWR green .
indicator System power supply is not connected
out
or faulty
on I/0 power supply is normal
3 10 PWR 10 power indicator | green .
1/O power supply is not connected or
out
faulty
Communication is normal, data
on
L transmission is normal
Running indicator
4 NET-RUN lieh green
1ght
& Communication stops, data transfer
out
stops
on The network is not connected
) The network is connected, PN
System failure flash
5 NET-ERR red communication abnormal
indicator
The network is connected, PN
Out . . . .
communication invalid
. on The network connection is normal
Indicators of
6 LINK/ACT1 orange
Network Port 1
out Network not connected or abnormal
. on The network connection is normal
Indicators of
7 LINK/ACT2 orange
network Port 2
out Network not connected or abnormal

® PROFINET adapter communication interface definition

Ethernet interface

Bit number

signal

Signal definition

|

1. TX+

TX+

Positive end of data
transmission
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) TX- Negative end of
data transmission

3 RX+ Positive data
receiving end

4 -- --

5 -- --

6 RX- Data receiving
negative end

7 -- --

8 -- --

Connector PE Chassis ground
housing

® PROFINET Adapter parameters

Technical parameters

Bus protocol

PROFINET

Address set

According to the main

Expanding the number of 1/
(0N

32

Maximum input/output
bytes

Input: 340 Byte/Output: 340 Byte

The bus rate

100Mbps

Transmission distance

100m (station to station distance)

System side power input

DC24V (18 to 36)

The system side provides
current

2 a (Max)

Power input of the I/O port

DC24V (+/ - 20%)

Output current of the I/O
port

10 a (Max)

Power consumption

270mA
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Conventional parameters

System side electrical
isolation

AC500V

Protection against reverse
connection

support

Over current protection

This function is supported by the system, but not by the
1/0

Over voltage protection

support

Wire specifications

0.2 ~ 1.5 mm squared

Connection mode No screw
Overall dimensions 90 x 67 x 34 mm

The weight of the 240g

Protection grade 1P20

Temperature range

Operating temperature: -10 ~ 55°C, storage temperature:
-20 ~85°C

Relative humidity

95% no condensation

2.1.6 CC-link adapter

® (CC-link adapter model and order number

Model Specifications description The order no.
EX-1010 DeviceNet adapter module 02-01-01
EX-1130 Modbus TCP bus adapter 02-01-11
EX-1030 Modbus RTU adapter module 02-01-03
EX-1100 EtherCAT adapter module 02-01-04
EX-1110 PROFINET adapter module 02-01-05

EX-1040

CC-link adapter module 02-01-06

EX-1050

CANopen adapter module 02-01-11
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EX-1120 EtherNet/IP adapter 02-01-08
EX-1121 EtherNet/IP adapter 02-01-08-1
EX-1140 CC-Link IEFB bus adapter 02-01-09

® (CC-link Adapter indicator definition

Serial Indicator

number

Instructions

Blinking at 1Hz

Meaning

Communication is normal

Blinking at SHZ

1/0 lost from the station

One flash one out

10 module station number

1 SYS System indicator green assignment failed
Two flashes one 1/0O module fails to be
out configured
out 10 module is not running
on System power supply is normal
System power
2 UNIT PWR green .
indicator System power supply is not
out
connected or faulty
on 1/0 power supply is normal
3 10 PWR 10 power indicator | green .
1/0 power supply is not
out
connected or faulty
Communication is normal, data
on
L transmission is normal
Running indicator
4 NET-RUN green
light .
Communication stops, data
out
transfer stops
on Cc-link communication error
System failure
5 NET-ERR red . Lo
indicator Cc-link communication is
out

normal
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L. flash Data transmission in progress
Data transmission
6 NETTX green
indicator light .
out Data is stopped or abnormal
. flash Data receiving
Data reception
7 NETRX green
indicator light .
out Data is stopped or abnormal

CC-link adapter communication interface definition

CC-link Communication
Bit number signal Signal definition
interface
Bit number 1
Bit ber 2 . . .
i nmber 1 DA A communications line
Bit number 3
Bit number 4
2 DB Communication line B
Communication
3 DG
common end
4 SLD Shielding wire
5 FG Chassis ground

Set the DIP switch for the CC-Link adapter

Communic
ation rate

cotting

* Dial

setting x

f— )y

setting

Cc-link Communication rate setting

Corresponding

Dial the code =~ Communication
transmission
number rate

distance
0| 5 156kbps 1200m
1 6 625kbps 600m
2 7 2.5 Mbps 200m
3 8 SMbps 150m
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CC-link Dip switch corresponds to the station id

. Fixed logic Dial the Dial the Dial the Dial the Dial the
Rate distance
. station code: 0 code: 1 code: 2 code: 3 code: 4
corresponding
to dip station . . . . . .
Variable Dial the Dial the Dial the Dial the Dial the
number . .
logic station code: 5 code: 6 code: 7 code: 8 code: 9
156kb 625kb 2.5 Mb SMb 10Mb
CC-link Communication rate ps ps ps ps ps
and transmission distance 1200m 600m 200m 150m 100m

CC-link Indicates the number of all secondary site bits (I/O and registers)

Number of remote I/O points 2048 DI1/2048 DO
Remote register RW W 256 AO (Master station -> Remote, local station)
Remote register RW r 256 point AI (primary -> Remote, local)

Number of connection points per site

Number of remote 1/O points 32 DI points, 32 DO points
Remote register RW W 4 AO (Master station -> Remote, local station)
Remote register RW r 4 points Al (Primary -> Remote, local)

CC-link Bus stations/points

Max: 4 Max: 128 DI, 128 DO, 16 Al, 16 AO

Maximum number of I/O
modules that can be expanded 4 x (32DI+ 32DO +4AI+4A0)
by CC-Link bus

®  (CC-link adapter parameters

Technical parameters

Bus protocol CC-Link
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Address set 1-64
Expanding the number of I/ 0

oS

Maximum input/output

Input: 48 bytes /Output: 48 bytes

current

bytes
The bus rate 156 KBPS /625 KBPS /2.5 Mbps / 10 Mbps
Transmission distance 1200 m (Max)
System side power input DC24V (18 to 36)
The system side provides 2 2 (Max)

Power input of the I/O port

DC24V (+/-20%)

Output current of the I/O
port

10 a (Max)

Power consumption

System side electrical
isolation

205mA

Conventional parameters

AC500V

Protection against reverse
connection

support

Over current protection

This function is supported by the system, but not by the
1/0

Over voltage protection

support

Wire specifications

0.2 ~ 1.5 mm squared

Connection mode No screw
Overall dimensions 90 x 67 x 34 mm

The weight of the 240g

Protection grade 1P20

Temperature range

Operating temperature: -10 ~ 55°C, storage temperature:
-20 ~ 85°C
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Relative humidity 95% no condensation

2.1.7 CANopen Adapter

® CANopen adapter model and order number

model Specifications describe The order no.
EX-1010 DeviceNet adapter module 02-01-01
EX-1130 Modbus TCP bus adapter 02-01-11
EX-1030 Modbus RTU adapter module 02-01-03
EX-1100 EtherCAT adapter module 02-01-04
EX-1110 PROFINET adapter module 02-01-05
EX-1040 Cc-link adapter module 02-01-06
EX-1050 CANopen adapter module 02-01-11
EX-1120 EtherNet/IP adapter 02-01-08
EX-1121 EtherNet/IP adapter 02-01-08-1
EX-1140 CC-Link IEFB bus adapter 02-01-09

® CANopen adapter parameters

Technical parameters

Bus protocol CANopen

Address set 0~99

Expanding the number of I/
(O]

32

Maxi i t/ t
aximum input/outpu Input: 512 Byte/Output: 512 Byte

bytes
The bus rate 10 KBPS ~ 1 MBPS
Transmission distance 1000 m (Max)
System side power input DC24V (18 to 36)
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The system side provides
current

2 a (Max)

Power input of the I/O port

DC24V (+/ - 20%)

consumption

System side electrical
isolation

Output current of the /0 10 a (Max)
port
System power current 126mA

Conventional parameters

AC500V

Protection against reverse
connection

support

Over current protection

This function is supported by the system, but not by the
/0

Over voltage protection

support

Wire specifications

0.2 ~ 1.5 mm squared

Connection mode No screw
Overall dimensions 90 x 67 x 34 mm

The weight of the 240g

Protection grade 1P20

Temperature range

Operating temperature: -10 ~ 55°C, storage temperature:
-20 ~ 85°C

Relative humidity

95% no condensation

2.1.8 EtherNet/IP Adapter (EX-1120)

® EtherNet/IP adapter model and order number

Model Specifications description The order no.
EX-1010 DeviceNet adapter module 02-01-01
EX-1130 Modbus TCP bus adapter 02-01-11
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EX-1030 Modbus RTU adapter module 02-01-03
EX-1100 EtherCAT adapter module 02-01-04
EX-1110 PROFINET adapter module 02-01-05
EX-1040 Cc-link adapter module 02-01-06
EX-1050 CANopen adapter module 02-01-11
EX-1120 EtherNet/IP adapter module 02-01-08
EX-1121 EtherNet/IP adapter 02-01-08-1
EX-1140 CC-Link IEFB bus adapter 02-01-09

®  EtherNet/IP adapter indicator definition

Serial Indicator Instructions

number

Blinking at 1Hz

Meaning

Communication is normal

The I/0 slave station lost or detected the

1 SYS System indicator green Blinking at SHZ
factory restore button signal
on The factory Settings are restored
on The system power supply is normal
System power
2 UNIT PWR green .
indicator The system power supply is not
out
connected or faulty
on The I/O power supply is normal
3 10 PWR 10 indicat
powerindicator | - green The I/O power supply is not connected or
out
faulty
Device operation: Communication is
Green light on
normal
Module status
4 MS o Green light flash Standby state:
indicator
(1HZ) Module not configured

Green red green

Self-test: power-on self-test status of the
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light flash (1HZ) module
Red light flash Glitch: The device detects a recoverable
(1HZ) glitch
Major fault: The device has detected a
Red light on
major fault error that cannot be recovered
out No power supply: No power supply
Connection established: The IP address is
) configured and at least one CIP
Green light on ) ]
connection has been established. The
master connection has not timed out.
Connection not established: The IP
Green light flash | 54dress is configured, the CIP connection
is not established, and the master station
(1HZ)

connection has not timed out.

Network status | Greenred green
5 NS indicator light flash Self-test: power-on self-test status of the
module
(1HZ)
Red light Connection timeout: The primary
connection times out after the IP address
(1 HZ) is configured
Duplicate IP address: The IP address has
Red light on
been used
out No power, no IP address
. on Network connection normal
Indicators of
6 LINK/ACT1 N « Port 1 green

t Tt

etwork ro out The network is disconnected or abnormal

. on Network connection normal
Indicators of
7 LINK/ACT2 green
network Port 2 Lo
out The network is disconnected or abnormal

®  EtherNet/IP adapter communication interface definition

Ethernet interface Bit number

signal Signal definition
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1 TX+ Positive end of data
transmission
) TX- Negative end of
data transmission
3 RX+ Positive data
receiving end
= 1:TX+
2:TX- 4 - -
3:RX+
4. TERM
5:TERM 5 _ .
CEL AR 6:RX-
7TTT\\\\  7:TERM
( ( ' | RX- Data receivin
00000000 6 . &
negative end
7 - -
8 - -
Connector PE Chassis grounding
housing

® EtherNet/IP DIP switch definition

1P Address
Hundred
Bitsx100

1P Address
Ten
Ritex 10

1P Address
Bitsx1

IP Address Setting

X 100 IP address hundred bits

X 10

IP address ten bits

X1

IP address bits

Note: The default network segment of ex-1120 is 192.168.0.x. Set the DIP switch to the IP address. For
example, set the 100 toggle to 1, 10 toggle to 9, and 1 toggle to 5.

®  EtherNet/IP adapter parameters

Technical parameters

Bus protocol

EtherNet/IP

Address set

Dip switch Settings
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Expanding the number of I/
OS

32

Maximum input/output
bytes

Input: 504 Byte/Output: 504 Byte

The bus rate

100Mbps

Transmission distance

100m (station to station distance)

System side power input

DC24V (18 to 36)

The system side provides
current

2 a (Max)

Power input of the I/O port

DC24V (+/ - 20%)

Output current of the /0
port

10 a (Max)

Power consumption

System side electrical
isolation

413mA

Conventional parameters

AC500V

Protection against reverse
connection

support

Over current protection

This function is supported by the system, but not by the
1/0

Over voltage protection

support

Wire specifications

0.2 ~ 1.5 mm squared

Connection mode No screw
Overall dimensions 90 x 67 x 34 mm

The weight of the 240g

Protection grade 1P20

Temperature range

Operating temperature: -10 ~ 55°C, storage temperature:
-20 ~ 85°C

Relative humidity

95% no condensation
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2.1.9 EtherNet/IP Adapter (EX-1121)

® EtherNet/IP adapter model and order number

Specifications description

The order no.

EX-1010 DeviceNet adapter module 02-01-01
EX-1130 Modbus TCP bus adapter 02-01-11
EX-1030 Modbus RTU adapter module 02-01-03
EX-1100 EtherCAT adapter module 02-01-04
EX-1110 PROFINET adapter module 02-01-05
EX-1040 Cc-link adapter module 02-01-06
EX-1050 CANopen adapter module 02-01-11
EX-1120 EtherNet/IP adapter module 02-01-08
EX-1140 CC-Link IEFB bus adapter 02-01-09

®  EtherNet/IP adapter indicator definition

Serial Indicator

number

Instructions

Blinking at 1Hz

Meaning

Communication is normal

The 1/0 slave station lost or

1 SYS System indicator green Blinking at SHZ detected the factory restore button
signal
on The factory Settings are restored
on The system power supply is normal
System power
2 UNIT PWR green .
indicator The system power supply is not

out

connected or faulty
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on The I/O power supply is normal
3 I0 PWR (0] indicat
powerindicator) - green The 1/O power supply is not
out
connected or faulty
Device operation: Communication
Green light on
is normal
Green light flash Standby state:
(1HZ) Module not configured
Green red green Self-test: power-on self-test status
Module status flash (1HZ) of the module
4 MS
indicator
Red light flash Glitch: The device detects a
(1HZ) recoverable glitch
Major fault: The device has
Red light on detected a major fault error that
cannot be recovered
out No power supply: No power supply
Connection established: The IP
address is configured and at least
Green light on one CIP connection has been
established. The master connection
has not timed out.
Connection not established: The IP
Green light flash address is configured, the CIP
connection is not established, and
Network status (1 HZ) . .
5 NS the master station connection has
indicator .
not timed out.
Green red green
flash Self-test: power-on self-test status
of the module
(1HZ)
Red light Connection timeout: The primary
connection times out after the IP
(1 HZ) address is configured
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Duplicate IP address: The IP
Red light on
address has been used
out No power, no IP address
on Network connection normal
Indicators of
6 LINK/ACT1 green Lo
Network Port 1 The network is disconnected or
out
abnormal
on Network connection normal
; LINK/ACT2 Indicators of
network Port 2 greetl The network is disconnected or
out

abnormal

®  EtherNet/IP adapter communication interface definition

Ethernet interface

Signal definition

TX+ Positive end of data
transmission
M| T+
2:TX-
3:RX+
4: TERM 1
5:TERM
LA 6:RX-
/ \\\ . T:TERM
- | 8:TERM
00000000
) TX- Negative end of data
transmission
3 RX+ Positive data receiving end
4 - -
5 - -
6 RX- Data receiving negative
end
7 - --
8 - -
Connector PE Chassis grounding
housing

® EtherNet/IP DIP switch definition
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IP Address
Hundred
Bitsx100

IP Address
Ten
Ritex 10

IP Address
Bitsx1

Dip switch definition

Three combination

) IP address setting method
dip set values

0 Set through BOOTP.

001-254. Set the low 1byte of the IP address by turning the switch.

The module status indicator (MS) is blinking red because the settings
More than 255

are incorrect

Note:

@ The IP address is assigned and the module works in BOOTP mode.

@ The ex-1121 adds a button to restore factory Settings. Hold down the button for more than 2 seconds.
When the SYS indicator changes from blinking to steady on, the factory Settings are restored.

®  EtherNet/IP adapter parameters

Technical parameters

Bus protocol EtherNet/IP

Address set Dip switch Settings

Expanding the number of I/ 0
oS

Maxi i t/output
AXImum mputoutpu Input: 504 Byte/Output: 504 Byte

bytes
The bus rate 100Mbps
Transmission distance 100m (station to station distance)
System side power input DC24V (18 to 36)
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The system side provides
current

2 a (Max)

Power input of the I/O port

DC24V (+/ - 20%)

System side electrical
isolation

Output current of the /0 10 a (Max)
port
Power consumption 360mA

Conventional parameters

AC500V

Protection against reverse
connection

support

Over current protection

This function is supported by the system, but not by the
1/0

Over voltage protection

support

Wire specifications

0.2 ~ 1.5 mm squared

Connection mode No screw
Overall dimensions 90 x 67 x 34 mm

The weight of the 240g

Protection grade 1P20

Temperature range

Operating temperature: -10 ~ 55°C, storage temperature:

-20 ~85°C

Relative humidity

95% no condensation

2.1.10 CC-link TEFB Adapter

® (CC-link IEFB adapter model and order number

EX-1010

Specifications description The order no.

DeviceNet adapter module 02-01-01
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EX-1130 Modbus TCP bus adapter 02-01-11
EX-1030 Modbus RTU adapter module 02-01-03
EX-1100 EtherCAT adapter module 02-01-04
EX-1110 PROFINET adapter module 02-01-05
EX-1040 Cc-link adapter module 02-01-06
EX-1050 CANopen adapter module 02-01-11
EX-1120 EtherNet/IP adapter module 02-01-08
EX-1121 EtherNet/IP adapter 02-01-08-1

EX-1140 CC-Link IEFB bus adapter 02-01-09

® CC-link IEFB adapter indicator definition

serial number indicator light illustrate meaning

destroy Non-maintenance status

Flashing and recovery during

red upgrade transfer process
Flashing (5Hz) Factory testing constants
System instructions Flashing (1Hz) System is running normally

The slave station is lost or the

SYS reset button is pressed
lamp Flashing (5Hz) Down
1 green
Bright Factory reset completed
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Two flashes and one out | Diagnostic configuration failed

System power
pointer The system side power supply is
UNIT PWR indicator light green Bright normal

abn

The system side is not powered on or orm

destroy the power supply is al.
Bright The 10 side power supply is normal
1O power
indicator
The 10 side is not powered or the
10 PWR lamp green destroy [power supply is abnormal.
Bright The device is running normally
NET-RUN Running lights green
destroy There is an error in the module

Module abnormality, such as duplication

Bright of slave stations, etc.

System failure

means

Device is operating normally or is not
INET-ERR indicator light red destroy receiving power

[P DIP switch is abnormal for you,

DIP

Flashing (1Hz) [Value exceeds 254
destroy The network is not connected properly

LINK/ACT1
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[Network connection is OK, but no
data
orange
LINK/ACT?2 Ethernet port color Bright interaction

The network connection is normal and

data is transferred

flashing

mutually beneficial

%100 Hundreds digit of IP address (valid range 0~2)
%10 Ten digits of IP address (valid range 0~9)
x1 IP address single digit dialing (valid range 0~9)

10 module input power supply (2L+, 2M)

4 power port Adapter input power (1L+, 1M)

® (CC-link IEFB adapter parameters

Basic parameters

Email:contact@welllinkio.com 4 2
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Dimensions 90mmx67mmx14mm
Operating temperature 0~55°C
storage temperature -20~85°C

Relative humidity 95% non-condensation
Protection level 1P20
Wiring specifications 0.2~ 1.5mm?
Wiring No screws

System side power input

DC24V (18~36V)

System side provides current 2A (Max)
10 port side power input DC24V (£20%)
IO port side output current 10A(Max)
System test electrical isolation AC500V
Anti-reverse connection
protection support
Overvoltage protection support

Overcurrent protection

The system test supports it, but the IO side does not support
it.

bus protocol

CC-Link IE Field Basic

Communication rate

100Mbps

Transmission distance

500m (distance between stations)

Email:contact@welllinkio.com
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128 points (occupies 2 stations)
192 points (occupies 3 stations)

256 points (occupies 4 stations)

64 points (occupies 1 station)

128 points (occupies 2 stations)
RY 192 points (occupies 3 stations)
[Maximum number of link points

256 points (occupies 4 stations)

32 points (occupies 1 station)
64 points (occupies 2 stations)
RW 06 points (occupies 3 stations)

128 points (occupies 4 stations)

32 points (occupies 1 station)

WX 64 points (occupies 2 stations)

96 points (occupies 3 stations)

128 points (occupies 4 stations)

2.2 Digital module

Digital module is divided into input and output two modules, according to the signal type is divided into
transistor and relay, transistor can be divided into NPN and PNP two kinds, according to the point can be divided

into 8, 16, 32 input/output points.

2.2.1 Digital input module

Digital input module includes PNP and NPN two signal types and 8 point, 16 point, 32 point three input
specifications, users can choose the appropriate model according to the actual demand.The input effective level
is divided into high level signal (PNP) and low level signal (NPN).

® Product Model Information

Model Specifications description The order no.
EX-2008 8 digital input, input signal is low level NPN 02-02-01
EX-2108 8 digital input, input signal is high level PNP 02-02-02
EX-200H 16 digital input, input signal is low level NPN 02-02-03
EX-210H 16 digital input, input signal is high level PNP 02-02-04
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EX-213S 32 digital input, input signal PNP 02-02-18
EX-203S 32 digital input, input signal NPN 02-02-17
EX2018 8 digital input, input signal is low level NPN, support 2/3 Wire 02-02-06
sensor
8 digital input, input signal is low level PNP, support 2/3
EX-2118 02-02-07
Wire sensor
EX-202H 16 02-02-08
EX-212H 02-02-09

® Module indicator

Channel indicator Color

green

Normally on

definition

The module has signal input

Out

The module has no signal input

® Module Parameters

Technical parameters

model EX-2008 | EX-2108 [EX-200H|EX-210H|EX-213S | EX-203S | EX-2018 | EX-2118
The product . o

name Digital quantity input module
Signal types | NPN PNP NPN PNP PNP NPN NPN PNP

Power 1 o 4mA | 24mA | 25mA | 25mA | ™A | 13mA | 17mA | 12mA
consumption

The input features

Input channel
number

8

16

32

8

Input rated
voltage

ov

24V

ov

24V

24V

ov

ov

24V

Time to
shake

The value ranges from 1 to 10ms. Default value: 3ms

Isolation of
pressure

AC500V
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Isolation Optical coupling isolation
method P pung

Physical parameters

i The’ 90 mm x 67 mm X 14 mm
dimensions

Working 0 55 oC
temperature

Storage o 5 o
temperature

Relative , .

humidity 95% no condensation
Protection P20

grade

2.2.2Digital output module

The output signal of the digital quantity output module is divided into transistor and relay. The effective
level of the output of the transistor type is divided into high level signal (PNP) and low level signal
(NPN).Digital output module has 8 point, 16 point, 32 point three types of specifications to choose from.

® Product Model Information

Model Specifications description The order no.
EX-3008 8-channel digital output, low level (NPN) 02-03-01
EX-3108 8 channels digital output, high level (PNP) 02-03-02

EX-300H 16 channels digital output, output signal is low level (NPN) | 02-03-03

EX-310H 16 channels digital output, output signal is high level (PNP) | 02-03-04

EX-3208 8-way relay output, output signal is relay (normally open) 02-03-05

EX-303S 32 channels digital output, output signal is low level (NPN) | 02-03-18

EX-313S 32 channels digital output, output signal is high level (PNP) | 02-03-19

® Module indicator
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Channel indicator Color

define

Normally on

The module has signal output
green

Out

The module has no signal output

® Module Parameters

Technical parameters

model EX-3008 | EX-3108 |[EX-300H|EX-310H| EX-3208 | EX-303S | EX-313S

The product Digital output module
name
Signal types NPN PNP NPN PNP relay NPN PNP
Current 50mA | SOmA | 72mA | 72mA | 45mA | 18mA | 19mA
consumption
Output characteristic
Output channel 3 3 16 16 3 1 1
number
Power oV 24V ov 24V - ov 24V
consumption
05A.2 Single channel load
Single channel load 500mA, each ) A ’ 500mA, each
The drive ability| continuous 8 channels maximum total DC3 O,V /A continuous 8
current 2A C125V channels maximum
total current 2A
The load type

Resistive load, inductive load, lamp load

Over current

. support
protection PP

Overheating support
protection PP

Isolation of AC500V
pressure

Isolation method

Optical coupling isolation

Physical parameters

The dimensions

90 mm x 67 mm x 14 mm
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Working 0~55°C

temperature
Storage 220 ~+85°C

temperature
Relative o .
humidity 95% no condensation

Protection grade 1P20

2.3 Analog module

Analog module is divided into input and output modules, voltage type and current type according to signal

type, 12-bit and 16-bit according to resolution, and 4-channel and 8-channel according to channel.

2.3.1 Analog input module

Analog input module is divided into voltage type and current type.Voltage input module has 4 ranges to
choose from, respectively 0 ~ 10V, £10V, 0 ~ 5V, £5V;Current input module is 4 ~ 20mA, 0 ~ 20mA, analog
input module resolution is 12bit (accuracy 0.1%) and 16bit (accuracy 0.02%).

® Product Model Information

Model Specifications description The order no.
4 channel voltage input, resolution 12bit, accuracy 0.1%,
02-04-01
The range is 0 ~ 10V
EX-4014
4 channel voltage input, resolution 12bit, accuracy 0.1%,
02-04-02
The range is 0 ~ 5V
4 channel voltage input, resolution 12bit, accuracy 0.1%,
02-04-03
Range £10V
EX-4114
4 channel voltage input, resolution 12bit, accuracy 0.1%,
02-04-04
Measuring range £5V
4 channel voltage input, resolution 16bit, accuracy 0.02%,
02-04-05
Range 0-10V
EX-4054
4 channel voltage input, resolution 16bit, accuracy 0.02%,
02-04-06
Range 0-5V
EX-4154 4 channel voltage input, resolution 16bit, accuracy 0.02%, 02-04-07
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Range £10V
4 channel voltage input, resolution 16bit, accuracy 0.02%,
02-04-08
Measuring range £5V
4 channel current input, resolution 12bit, accuracy 0.1%,
02-04-09
The range is 4 ~ 20mA
EX-4414
4 channel current input, resolution 12bit, accuracy 0.1%,
02-04-10
The range is 0 ~ 20mA
4 channel current input, resolution 16bit, accuracy 0.02%,
02-04-11
The range is 4 ~20mA
EX-4454
4 channel current input, resolution 16bit, accuracy 0.02%,
02-04-12
The range is 0 ~20mA
8 channel voltage input, resolution 12bit, accuracy 0.1%,
02-04-29
The range is 0 ~ 10V
EX-4018
8 channel voltage input, resolution 12bit, accuracy 0.1%,
02-04-30
The range is 0 ~ 5V
8 channel voltage input, resolution 12bit, accuracy 0.1%,
02-04-31
Range +10V
EX-4118
8 channel voltage input, resolution 12bit, accuracy 0.1%,
02-04-32
Measuring range =5V
8 channel current input, resolution 12bit, accuracy 0.1%,
02-04-33
The range is 4 ~20mA
EX-4418
8 channel current input, resolution 12bit, accuracy 0.1%,
02-04-34
The range is 0 ~ 20mA

® Module indicator

Channel indicator Color

Definition

green

Email:contact@welllinkio.com
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Normally on

Analog input is out of range

Out

No analog signal input

The following table is the corresponding numerical table of analog input range. The blue line in the broken line

diagram is voltage type, and the orange line is current type

® Analog quantity range corresponds to the value

Input type

Polarity

b il

0-10V, 0-5V
10V, £5V
0~4095
-2048~+2047

0~65535
-32768~+32767 =

® Analog voltage input module digital - analog curve

4~20mA
0~20mA
0~4095

0~65535

5000
4000
3000
2000
1000

0

- () ~ 10V

0 25
0 1024

12-bit voltage type unipolar input module range

5
2047

7.5 10
3071 4085

3000
2000
1000
0
-1000
-2000
-3000

-10 -5

=—8=-10 ~ 10V -2048  -1024

12-bit voltage type bipolar input module range

0
0

5 10
1024 @ 2047
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® Analog current mode input module digital - analog curve

12-bit current type input module range

5000
4000
3000
2000
1000

0
4 2 12 16 20

=g={ ~20mA 0 1024 2048 3071 4095

® 12-bit 4-20mA analogical conversion formula (X is current value, Y is the corresponding
value of current value) :
X—-4 Y
20—4 4095

® [2-bit 0-20mA analogical conversion formula (X is the current value, Y is the corresponding
value of the current value) :
X Y
20 4095
® 12-bit 0-10V digital-analog conversion formula (X is the voltage value, Y is the
corresponding value of the current voltage value) :
X Y
10 4095
® 16-bit 0-10V digital-analog conversion formula (X is the voltage value, Y is the
corresponding value of the current voltage value) :

X Y
10 65535

® Module Parameters

Technical parameters

model EX-4014 EX-4018|EX-4114| EX-418 |EX-4054 EX-4154 |EX-4414|EX-4454|EX-4418

The product Analog input module
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name
Plus or
i 0~ 10 v |minus 10
Signal types | 0to 10V,0to 5y |F1us or minus 10'v, v 4 ~20mA,0 ~ 20mA
+5v 0~5v
+5v
Power
. 82mA | 82mA | 82mA | 182mA| 82mA | 82mA | 53mA | 182mA| 182mA
consumption
The input features
Output channel 4 2 4 3 4 4 4 4 3
number
The input filter Configurable: level 0 to 3 (default 1)
The input > 500k Q 100 Q
impedance
The resolution
of the 12 16 12 16 12
precision 0.1% 0.02% 0.1% | 0.02% | 0.1%
Over voltage
protection support

Isolation of AC500V on the field side and digital side, channels are not isolated

pressure
Physical parameters
The dimensions 90 mm x 67 mm x 14 mm
Working 0 ~ 55 °C
temperature
Protection P20
grade

2.3.2 Analog output module

Analog output module is divided into voltage type and current type.Voltage input module has
4 ranges to choose from, respectively 0 ~ 10, £10V, 0 ~ 5V, £5V;Current input module is divided
into 4 ~ 20mA, 0 ~ 20mA.Analog output module resolution is 12bit (accuracy 0.1%) and 16bit
(accuracy 0.02%).

® Product Model Information

model Specifications description The order no.
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VL

4 channel voltage output, resolution 12bit, accuracy 0.1%,
02-05-01
The range is 0 ~ 10V
EX-5014
4 channel voltage output, resolution 12bit, accuracy 0.1%,
02-05-02
The range is 0 ~ 5V
4 channel voltage output, resolution 12bit, accuracy 0.1%,
02-05-03
Range +10V
EX-5114
4 channel voltage output, resolution 12bit, accuracy 0.1%, 02-05-04
measuring range =5V
4 channel voltage output, resolution 16bit, accuracy 0.02%,
02-05-05
The range is 0 ~ 10V
EX-5054
4 channel voltage output, resolution 16bit, accuracy 0.02%,
02-05-06
The range is 0 ~ 5V
4 channel voltage output, resolution 16bit, accuracy 0.02%,
02-05-07
Range +10V
EX-5154
4 channel voltage output, resolution 16bit, accuracy 0.02%,
02-05-08
Measuring range =5V
4 channel current output, resolution 12bit, accuracy 0.1%,
02-05-09
The range is 4 ~ 20mA
EX-5414
4 channel current output, resolution 12bit, accuracy 0.1%,
02-05-10
The range is 0 ~ 20mA
4 channel current output, resolution 16bit, accuracy 0.02%,
02-05-11
The range is 4 ~ 20mA
EX-5454
4 channel current output, resolution 16bit, accuracy 0.02%,
02-05-12
The range is 0 ~ 20mA
8 channel voltage output, resolution 12bit, accuracy 0.1%,
02-05-13
EX-5018 The range is 0 ~ 10V
8 channel voltage output, resolution 12bit, accuracy 0.1%, 02-05-14
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The range is 0 ~ 5V
8 channel voltage output, resolution 12bit, accuracy 0.1%,
02-05-15
Range +10V
EX-5118
8 channel voltage output, resolution 12bit, accuracy 0.1%,
02-05-16
Measuring range +5V
8 channel current output, resolution 12bit, accuracy 0.1%,
02-05-17
The range is 4 ~ 20mA
EX-5418
8 channel current output, resolution 12bit, accuracy 0.1%,
02-05-18
The range is 0 ~ 20mA
® Module indicator
Channel indicator Color State definition
Flash There is analog signal output
green Normally on Program channel value out of range
Out No analog signal output

The following table is the corresponding numerical table of analog input range. The blue line in
the broken line diagram is voltage type, and the orange line is current type

® Analog quantity range corresponds to the value

Input type Simulated Quantity Input Value

Voltage-mode Current-mode

0-10V, 0-5V 4~20mA
10V, +5V 0~20mA

Resolution Polarity

Unipolar 0~4095 0~4095
bipolar -2048~+2047 -
Unipolar 0~65535 0~65535
bipolar -32768~+32767 -

® Analog voltage output module modulus curve

12-bit voltage type unipolar input module range
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2047

2.5 5

40A5
10

3071
.5

=1}

12-bit voltage type bipolar input module range

15
10
5

-5

-149
-15

10V

® Analog voltage output module modulus curve

=g — 0l 4 g

12-bit current type input module range

5
20
15
10

2

4]

a 1024 2048

12

3071
16

4085
20

12-digit 4-20mA modulus conversion formula (X is the current value, Y is the corresponding

value of the current value) :
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X-4 Y
20—4 4095

® 12-bit 0-20mA modulus conversion formula (X is the current value, Y is the corresponding
value of the current value) :
X Y
20 4095
® [2-bit 0-10V modulus conversion formula (X is the voltage value, Y is the corresponding
value of the current voltage value) :
X _ Y
10 4095

® 16-bit 0-10V modulus conversion formula (X is the voltage value, Y is the corresponding
value of the current voltage value) :

® Module Parameters

Technical parameters

model EX-5014|EX-5018|EX-5114|EX-5118|EX-5054|EX-5154|EX-5414 |EX-5454|EX-5418
The product Analog output module
name
Plus or
; 0~ 10 v |minus 10
Signal types | 0 to 10V,0 to 5V |F1uS or minus 10'v, v 4 ~20mA,0 ~ 20mA
+tS5v 0~5v
+5v
Power
. 24mA | 2ImA | 24mA | 2ImA | 24mA | 24mA | 2ImA | 21mA | 21mA
consumption
The input features
Output channel 4 ] 4 ] 4 4 4 4 ]
number
The output load >10k Q <500 Q
The load type Impedance load
The resolution
of the 12 16 12 16 12
precision 0.1% 0.02% 0.1% | 0.02% | 0.1%
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Over voltage
protection support
Isolation of AC500V on the field side and digital side, channels are not isolated
pressure
Physical parameters
The dimensions 90 mm x 67 mm x 14 mm
Working 0~ 55°C
temperature
Protection P20
grade

2.4 Temperature Collection module

The temperature collection module is divided into thermocouple (TC) and thermal resistance
(RTD) according to the sensor type.
2.4.1 Thermocouple module

The filter of each channel of the thermocouple temperature collection module can be
configured separately (default is 10). The thermocouple temperature collection module can support
10 types of thermocouple sensors, which are K, J, T, E, N, S, R, B, C, and MV.

® Product Model Information
model Specifications description The order no.

4 channel K thermocouple acquisition module,

02-04-13
Range of -100 ~ 1370°C
4 channel J thermocouple acquisition module,
02-04-14
Range -100 ~ 1200°C
EX-46
54 4 channel T thermocouple acquisition module,
02-04-15

Range -100 ~ 400°C

4 channel TYPE E thermocouple acquisition
module, 02-04-16
Range -100 ~ 1000°C
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4-channel N-type thermocouple acquisition
module, 02-04-17
Range -100 ~ 1300°C

4-channel S-type thermocouple acquisition
module, 02-04-18
Range 0 ~ 1700°C

4 channel R thermocouple acquisition module,

02-04-19
Range 0 ~ 1700°C
4 channel B thermocouple acquisition module,
02-04-20
The range is 600 ~ 1800°C
4 channel C thermocouple acquisition module,
02-04-21
Range 0 ~ 2320°C
4 channel MV voltage signal acquisition module,
02-04-22

Range -100mv to 100mv

® Module indicator

Channel indicator -
definition

Color

Flash Thermocouple sensor has signal input

Thermocouple sensor signal out of
green Normally on
range

Out No thermocouple sensor signal input

® Table of values corresponding to temperature values measured in EX-4654

EX-4654

Type | Temperature(°C) Numerical (decimal) Bolt value Note

K -100~+1370 -1000~+13700 32767

The code value obtained by PLC is
J -100~+1200 -1000~+12000 32767 divided by 10 to obtain the actual
temperature value

T -100~+400 -1000~-+4000 32767
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E -100~+1000 -1000~-+10000 32767
N -100~+1300 -1000~-+13000 32767
S 0~+1700 0~-+17000 32767
R 0~+1700 0~-+17000 32767
B 600—+1800 6000~+18000 32767
C 042320 0423200 32767

The actual -100 mv to +100 mV is

mv | -100~+100mv -30000~30000 32767 mapped to the range of -30000 to

30000

® Module Parameters

Technical parameters

model EX-4654
Product name Thermocouple module
Power 41mA
consumption

The input features

Input channel
number

4

The input filter

The value ranges from 0 to 40. Default value: 10

The connection
method

2 wire system

- K,J,T.E,N,S

1gnal types

gnattyp R, B, C, mV
Temperature Default: TYPE K: -100..+ 1370 °C
range

The resolution of]
the

0.1 °C/ digital

precision

0.5% (full scale)
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Over voltage
protection support

Isolation of

pressure

Disconnect the
alarm

The dimensions

Diagnosis and Alarm
Physical parameters

ACS500V on the field side and digital side, channels are
not isolated

Supported (When the channel code value is 32767, the
channel is disconnected)

90 mm x 67 mm x 14 mm

Working o
temperature 0~55%C
Storage 220 ~+ 85 °C
temperature
R.elfmve 95% no condensation
humidity

Protection grade

1P20

2.4.2 Thermal Resistance Module

The filter of each channel of the thermal resistance temperature acquisition module can be
configured separately (the default is 10). The thermal resistance temperature acquisition module
can support six types of thermal resistance sensors, namely PT100, PT200, PT500, PT1000, Ni120,
and resistance measurement.

® Product Model Information

The ord
Specifications describe o
no.
EX-47 4 channel PT100 thermal resistance acquisition
54 module, 02-04-23
Range -200 ~ 800°C
4 channel PT200 thermal resistance acquisition
module, 02-04-24
Range of -200 ~ 630°C
4 channel PT500 thermal resistance acquisition 02-04-25
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module,

Range of -200 ~ 630°C

4 channel PT1000 thermal resistance
acquisition module, 02-04-26

Range -50 ~ 300°C

4 channel Ni120 thermal resistance acquisition
module, 02-04-27
Range -79 ~ 309°C

4-channel resistance value acquisition module,
02-05-28
The range is 0 ~ 400 ©

® Module indicator

Channel indicator

definition

Color

flashi The thermal resistance
ashin . .
£ sensor has signal input

Signal of thermal resistance
green Normally on ;
sensor is out of range

destr No thermal resistance
estro . .
Y sensor signal input

® Table of values corresponding to temperature values measured in EX-4754

EX-4754

o Numerical value
Type Temperature(°C) (decimal) Bolt value Note
PT100 .200~+800 -2000—+8000 32767 The code value obtained by PLC is
divided by 10 to obtain the actual

temperature value

PT200 -200~+630 -2000~+6300 32767

PT1000 -50~+300 -500~+3000 32767

INI120 -79—~+309 -790~+3090 32767

Resistance - Map the actual 0~2000 equal scale to

measurement 0 ~2000Q 0-~30000 32767 the range 0~30000
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® Module Parameters

Technical parameters

model EX-4754
The product Thermal resistance module
name
Power 38mA
consumption

The input features

Input channel
number

The input filter The value ranges from 0 to 40. Default value: 10

The connection 2-wire or 3-wire (default 3-wire)

method
Signal types PT100/PT200/PT500/PT1000/Ni20
T;r;lg :rature - 200...+800 degrees (PT sensor), -79...+309 degrees (Ni sensor)

The resolution of] 0.1 °C/ digital

the
precision +/-1°C
Over voltage supbort
protection pp

Isolation of
solation o ACS500V on the field side and digital side, channels are not isolated
pressure

Diagnosis and Alarm

Disconnect the Supported (When the channel code value is 32767, the channel is
alarm disconnected)
The dimensions 90 mm x 67 mm x 14 mm
tem;)::]roartll{llrzg 0~35°C
Storage -20~+85°C
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temperature
Rglgtlve 95% no condensation
humidity
Protection grade 1P20
2.5 Function Modules

Function module is divided into encoder module and high-speed pulse output module,
according to the input/output signal type into NPN, PNP, differential.
2.5.1 Encoder Module

The encoder module can be divided into NPN, PNP and differential according to the input
signal type, supporting encoder 1, 2 and 4 multiplier.

® Product Model Information

The ord
Specifications description SO
no.
EX-60 . .
01 1 channel NPN, maximum input frequency 1MHz, 02-06-01
EX-60 . .
1 1 channel PNP, maximum input frequency 1MHz, 02-06-02
EX-60 i i i i fr
1 channel differential, maximum input frequency 02-06-03
21 1MHz,

® Module Parameters

Technical parameters

model (ix'm EX-6011 EX-6021
The product name Encoder module
Power consumption 38mA 38mA 75mA

The input features

Input channel

1 channel
number

Input signal type NPN PNP The differential
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Counting mode

Linear, ring counter form

Count range

0 to 4294967295 or -2147483648 to 2147483648

Counting function
selection

pulse counter

Count disable, latch counter, sampling counter, cycle

Frequency, rotation speed, period measurement

Maximum input

1MHz
frequency
Orthogonal encoder x1. x2. x4
multiplier C
The input >5kQ
impedance

Electrical isolation

Optical coupling isolation

Maximum
connection distance of 2m 2m
signal cables

The dimensions

Physical parameters

90 mm x 67 mm x 14 mm

10m

Working
temperature

0~55°C

Protection grade

1P20

2.6 Communication Module

Communication modules are classified into RS485 communication modules, RS232 and
RS485 communication modules.

2.6.1 Communication module

® Product Model Information

The ord
model Specifications description SO
no.
EX-63 RS485 free port communication module, supporting
. 02-06-10
01 master/slave mode (default master station)
EX-63 RS232 Free port communication module, supporting 02-06-11
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11 master/slave mode (default master station)
EX-63 o
21 Modbus RTU Master communication module 02-06-14

® Module parameters

Technical parameters

Input channel

The input features

1

model EX-6301 EX-6311 EX-6321
The product R.S48i5 RS232 Modbus RTU
communication ..
name communication module Master
module
Current 195mA
consumption

Optional: 1200, 2400, 4800, 9600 (default), 19200, 38400,

Baud rate 57600, 115200kbps

Data bits 5, 6,7, 8 bits (default) eight
Check digit None (default), Odd, Even

Stop bit 1 (default), 2 stop bits

Time interval optional: 50ms,
Automatic 100ms, 200ms, 400ms, 500ms, 600ms,
timing sending 800ms, 1S (default), 1.5s, 285, 38, 48, 5s, Does not support
function 6,
8s,10s

A master-slave

Yes, default master mode

Only the primary

mode site is supported
After the primary
site sends a command, it
waits for the response
Response :
. time of the secondary
timeout

site. The value ranges

from 1 to 65535 (1000
ms by default)

Character space

Frame character
interval detection time
(the time for transmitting
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a single character,
depending on baud rate)
(default: 5 characters)

Physical parameters

The dimensions 90 mm x 67 mm x 14 mm
Working 0-55 °C
temperature
Storage -20~+85°C
temperature
Relative o .
humidity 95% no condensation
Protection P20
grade
2.7 Auxiliary Modules

Auxiliary modules are divided into power module and terminal module.A of psus, which respectively

provide extra load for I/O modules, You can configure the psus as required under specific conditions.

2.7.1 Power Module and Terminal Module

® Product Model Information

model Specifications description The order no.

EX-TERO1 Terminal module 02-00-00

System power I/0 and power module, side power supply

+59 i
EX-0100 voltage DC24V to voltage DC5V+5%, maximum output load 02-00-01

2A, used for adapter and 10 module processor power supply,

which can provide 10 power for 10A.

® Module Parameters

Technical parameters

model EX-0100

The product

name System power supply and I/O power module

Power supply features

Email:contact@welllinkio.com

66



= == uAF l®

j—] — —
EX Series Card 1/0 el VY E el

System side power

DC24V (18 to 36 v)
supply voltage

Output system

+/-50°
voltage SV(H/-5%)

Output system

current
Power supply 2 a (Max)
voltage of the I/O DC24V (18 to 36 v)
side 10 a (Max)
Load current on the
I/O side
Over vol'tage support
protection
Protection against support

reverse connection

Physical parameters

The dimensions 90 mm x 67 mm x 14 mm
Working 0-55 °C
temperature
Storage temperature -20~+85°C
Rela.tl\./e 95% no condensation
humidity
Protection grade 1P20

3 Module Installation

3.1 Basic Knowledge

All EX system modules are open equipment, which means that EX system I/O modules can
only be installed in the connection, control cabinet or electrical operating room, and dry
environment (protection class IP20).Provide safety protection in cabinets, control cabinets or
operating rooms to prevent electric shock and the spread of fire.

EX series I/O modules can be installed on mounting rails that comply with EN 60715 (35 x
7.5 mm or 35 x 15 mm).In the control cabinet, the installation guide rail needs to be separately
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grounded.Exception: If the guide rail is mounted on a grounded galvanized mounting plate, it is
not necessary to ground the guide separately.

3.2 Installation Clearance

When installing or removing an EX distributed I/O system, keep a minimum clearance, as shown
in Figure 3-1.

_.E

oooo _\

oooo |

40 30

Figure 3-1 Minimum installation clearance

3.3 INSTALLING I/O Modules

3.3.1 Installing the Entire Module Group

Secure the installed modules to the guide rails, as shown in Figure 3-2.
(1) Loosen guide rail buckles on all modules.

(2) The module is hooked on the installation guide rail.

(3) The module is fixed on the guide rail.

(4) Module guide rail latch is locked.
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Figure 3-2 Installing an entire module group

3.3.2 Adding an I/O Module

Figure 3-3 shows the sequence of adding an I/O module to the INSTALLED I/O system.
(1) Loosen the buckle of the module guide rail.

(2) Hook the module on the mounting guide rail.

(3) The module is fixed on the guide rail.

(4) Shift the module to the left from the guide rail.

(5) Latch the module guide rail.

Ey
o

o

o
T T
- - "f "I‘

<1
E.I.I.II

=

=

Bu
T =TT
=TT
= 1T 1T = 1111

8

Email:contact@welllinkio.com 6 9



= == uAF l®

j—] — —
EX Series Card 1/0 el VY E el

Figure 3-3 Adding an I/O module

3.4 Wiring standards and connecting standards

The diameter of the cable to be connected is 0.2-1.5, and the stripping length is 9-10mm. It is
recommended to use a tubular cord end terminal.

Figure 3-4 shows the system line standard.

Figure 3-4 wring standards

W terminal L/F Length of D tube Gb/mm Stripping
diameter the terminal diameter squared length /mm

0.751.5 10 mm+/-

2.83.0(2.8) 16.4/10 1.3 1.5(1.3) 075) A

The proposed dimensions are in front of the brackets, and the standard dimensions are in the brackets.

The dimensions of W, F and D are in mm

Use standard crimping pliers to crimp cables, as shown in Figure 3-5

Figure 3-5 Cable crimping mode
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4 Module size diagram and wiring diagram

4.1 Module size diagram

Module dimensions can be classified into adapter, [O module, and terminal module dimensions.
4.1.1 Adapter size diagram

Figure 4-1 shows the dimensions (length, width, height) of all adapter modules in the EX series.

66

i

NANNNN
J VUuvuvuuy

= |

90

Figure 4-1 Dimensions of the adapter module
4.1.2 1/0 Module Dimensions diagram

Figure 4-2 shows the dimensions of the 32-channel I/O module. Figure 4-3 shows the

dimensions of the other I/O modules.
._ 1
-] o |
[ | = | B

Figure 4-2 Dimensions of the digital 32 channel INPUT/output module

40
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Figure 4-3 DIMENSIONS of the I/O module

4.1.3 Terminal module size diagram

g0

Figure 4-4 Dimensions of a terminal module
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4.2 Module Wiring diagram

4.2.1 Adapter wiring diagram

All adapters in the EX series are connected to the same cable. The cable connections to the
adapter are divided into system power and I/O power. Figure 4-5 shows the cable connections.

0V =

247

OV -

AU
24V -

Ei-1110 0
g oooo
oooo
o
2]

Figure 4-5 Adapter wiring diagram
Note: EX series adapter power supply is divided into system power supply and I/O power supply. To
avoid interference to the system, you are advised to connect two sets of power cables from the same
DC24V power module to the system power supply and I/O power supply respectively.
4.2.2 Wiring diagram of digital input module

EX series digital quantity input module, EX-2008 /EX-200H input signal is NPN,
EX-2108/EX-210H input signal is PNP, EX-203S input signal support NPN and PNP.

® Figure 4-6 shows the wiring diagram of the EX-2008/EX-200H/EX-2108/EX-210H module.
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4.2.3 Wiring diagram of digital output module

EX series digital quantity output module, EX-3008 /EX-300H/EX-303S output signal is NPN,
EX-3108/EX-310H/EX-313S output signal is PNP, EX-3208 is relay output module.

® Figure 4-9 shows the wiring diagram of the EX-3008/EX-300H/EX-3108/EX-310H module.

® Figure 4-10 shows the ex-3208 module wiring diagram.

24V -

o0 1T
& ooo
= | ooo
L ooo
ooo

a

3]
|

TEE
HE

g

|
1

Figure 4-9 EX-3008 /EX-300H/EX-3108/EX-310H module wiring diagram
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Figure 4-10 Wiring diagram of the EX-3208 relay output module

4.2.4 Analog input module wiring diagram

The analog input module is divided into voltage and current according to the input signal

type. The voltage or current type connection mode is two-wire system.

Hint: Enter 2/3/4 and refer to 6.1.8

® Figure 4-11 shows the module wiring diagram for EX-4014, EX-4114, EX-4054, EX-4154,

EX-4018, and EX-4118.

® Figure 4-12shows the wiring diagram for the EX-4414/EX-4454/EX-4418 module.

T4t
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o
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Figure 4-11 Wiring diagram of voltage input signals

current input signals

For three-wire/four-wire connection, please refer to 6.1.8
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4.2.5 Analog output module wiring diagram

The analog output module is divided into voltage and current according to the output signal
type. The voltage or current type connection mode is two-wire system.

® Figure 4-13 shows the module wiring diagram of ex-5014, EX-5114, EX-5054, EX-5154,
EX-5018, and EX-5118.

® Figure 4-14 shows the wiring diagram for the EX-5414/EX-5454/EX-5418 module.

R | — .
E ( E-5154 E ¢ FI-5454
oooo oooo
= k=
g [=

E |-t
F

Figure 4-13 Voltage output signal wiring diagram Figure 4-14 Current type I/O
signal wiring diagram

4.2.6 Temperature Module wiring diagram

EX series products are divided into two types of temperature modules: thermocouple and
thermal resistance, with four input channels.

® Figure 4-15 shows the wiring diagram of the EX-4654 module.
® Figure 4-16 shows the wiring diagram of the EX-4754 module.
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Figure 4-15 Wiring diagram of the EX-4654 module Figure 4-16 Ex-4754 module
wiring diagram

For three-wire/four-wire connection, please refer to 6.1.8

4.2.7 Wiring diagram of Function Modules

Function module is divided into encoder module and high-speed pulse output module, according to
the signal type into differential, NPN, PNP three.

® Figure 4-17 shows the wiring diagram of the EX-6001/EX-6011 encoder (NPN/PNP) module.

® Figure 4-18 shows the wiring diagram of the EX-6021 encoder (differential) module.
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Figure 4-17 Wiring diagram of the EX-6001/EX-6011 encoder module
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Note: The longest connection line of NPN/PNP encoder shall not exceed 2m. The Latch input signal type of
EX-6001 and EX-6011 is NPN.
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Figure 4-18 Wiring diagram of the ex-6021 encoder module

Note: the longest connection line of differential encoder shall not exceed 10m
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4.2.8 Communication Module wiring diagram
® Figure 4-19 shows the wiring diagram of the EX-6301 module.
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® Figure 4-20 shows the wiring diagram for the EX-6311 module.
® Figure 4-21 shows the wiring diagram for the EX-6321 module.

i RS485
i A Master/Slave
t —og - Device -

[

Figure 4-19 Wiring diagram of the EX-6301 module

Note: The communication distance between the EX-6301 module and the RS485 master/slave device
depends on the communication medium (such as communication cable or wireless relay) or baud rate.
4

X-6311
& aaoono

e RS232
3 A _Master/Slave
9] <28 - Device

Figure 4-20 Wiring diagram of the EX-6311 module

Note: shielded cables are recommended for the communication distance between the ex-6311 module and
the RS232 master/slave device to be less than 15m.
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Figure 4-21 Wiring diagram of the EX-6321 module

4.2.9 Power Module Wiring Diagram

The ex-0100 power module needs to be connected to two sets of DC24V power cables.
1L+/1M for the system power supply and 2L+/2M for the I/O power supply. You are advised to
connect two sets of power cables from the same DC24V power module to the system power
supply and I/O power supply respectively, as shown in figure 4-22.

B

Figure 4-27 Power module wiring diagram
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5 EX Remote I/O configuration

This chapter mainly introduces the EX series remote 10 adapter with IO module and the
current industrial mainstream PLC configuration.

5.1 Connection between Ex-1100 and PLC

5.1.1 Connection and Configuration between TwinCAT2 and EX-1100

1. Communication connection diagram, as shown in Figure 5-1-1.

Programming computer

TwinCAT2

EtherCAT. ™

Adapter

g EX-210H | EX-3108 | EX-4014 | EX-5014
EX-1100

Figure 5-1-1 communication connection diagram
2. Table 5-1-1 shows the hardware configuration

Table 5-1-1 Hardware configuration table

Hardware Quantity Note

Computer programming 1 Install TwinCAT?2
EX-1100 1 EtherCAT adapter
EX-210H 1 Digital input
EX-3108 1 Digital output module
EX-4014 1 Analog input module
EX-5014 1 Analog output module

Ethernet cable A number of

3. Install the XML description file

Install the XML description file into TwinCAT2, as shown in Figure 5-1-2.(TwinCAT2
default path: C: TwinCAT\lo\EtherCAT)

Email:contact@welllinkio.com 8 1



j————— - — = —
EX Series Card 1/0 el VY E el

Fliz (F) EdE (E) Wiew Wy Favorte (F} Tool {T) Halp {H)
(eacknacgimy (T Search: Fodes ¥ (% 0] & % X M) - 5 FoierSwac
ULl i e *— o

In - 7 Fashbofd 2T o Fadiebarlid i, Feckital1 i Bl 6F TP + Rwikliarfl
File and Folder Tasks - _| Husind W itfaea @ Ceowsin o 1 oot | Conrane | 3 Crorsnn @ Ceomn|
w3 Perane This File _—
is Fi ' Eased Bllen b Farkbedd Bty 5 eyt Bl 5 Bt s Bechia ) 530 Beamert B
“;' B Coousen L& Cvoursant B s ﬂ' % Coorsmnn L Nt o Cooun
; Faslikrdf B L] B b i 2 ! E B Erier ] il =
3 i B e BT ) et A 7 Hacilarl His i f T
@) BEae Lghmuiime  Lgalewrone Lghlacenms  Lgh Mtamen g e
1 Esakaid Do % Narkded | iFban Vasirks ' s TETECY e Bt e [PESTTE
'i. ¥ Cooimamn L Lt ) T Brorsans L3 Cosmaib - ™ e I-.}:_-l
r *. Conurs

- % i il ¥ Euar i g v % e Bl v md - TR % Eabartatie
1..- = j.. TR F j... T 3.. 1
:f m - i ) e == 'r" =Ll ] Gl =it Gl

Figure 5-1-2 Installing the XML description file
4. New project and equipment configuration

Click the TwinCAT icon at the lower right corner of the computer and select "System
Manager" to open TwinCAT software, as shown in Figure 5-1-3.

T About TwinfAT...

= Log View

Banager

BB PLC Control

Router

System

o

FLE
Properties

Figure 5-1-3 Starting TwinCAT software

After the TwinCAT software is started, click I/O Devices on the left of the project and
right-click Scan Devices, as shown in Figure 5-1-4.

" = Fils By fefiom fie fpbima  [fels
O o ES A Mo RRE RS s e e R

ETTIEA Dol 1Ewr a8 Bmbar ferim Trpe
L - Cendiparyidan

| 9] |'n|.=..|m.
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-~ T <— )
B faris Swrla

st W B s 4 T

Figure 5-1-4 Selecting Scan Devices
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In the New 1I/O Devices Found window, select the network card that you want to connect to
EtherCAT I/O, as shown in Figure 5-1-5.

I new IO devices found

Figure 5-1-5 Selecting a network card

Select "Yes" in the prompt window "Scan for Boxes", and the adapter EX-1100 and the
attached I/O module are scanned, as shown in picture 5-1-6.

Mo Title faiecat Syiiem Eassirs

e wd i PR M e AR s R e

" FETIF = Canli P uilon Fmbar furiin frga
A = el iAo
- L~ G ands gareriom

= M 175 B i
™ ferion § Jiberlal)
Fufiings

Figure 5-1-6 Scanning the I/O module
5. I/O monitoring and forced output

Choose Box1 (EX-1100) > Module2 (EX-3108) > Channels Date from the left pane of the
project. Double-click Channel 1 to pop up the Set Value Dialog window, and Set the mandatory
Value to 1, as shown in Figure 5-1-7.
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Figure 5-1-7 Mandatory input values

6. Variable association

Right-click PLC-Configration on the left of the project, select Add PLC project, and associate
the defined INPUT and output variables to the I/O channel, as shown in Figure 5-1-8.
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Figure 5-1-8 Correlation of variables

5.1.2 Connection and Configuration between TwinCAT3 and EX-1100

1. Communication connection diagram, as shown in Figure 5-1-9.

Programming computer

TwinCAT3

EtherCAT. ™

Adapter |

EX-4014 | EX-5014

EX-1100

Figure 5-1-9 Communication connection diagram

2. Table 5-1-2 shows the hardware configuration

Table 5-1-2 Hardware configuration table

Hardware Quantity

Note

Computer programming

Install TwinCAT3

EX-1100

EtherCAT adapter

EX-4014

Analog input module

— | | | —

EX-5014

Analog output module

Ethernet cable A number of

3. Install the XML description file
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Install the XML description file into TwinCAT3, as shown in figure 5-1-10.The example
default folder is

(C:\TwinCAT \\ Config \ Io \ EtherCAT 3.1)

Z;i_iputérﬂyﬂemqﬂ::u TwinCAT » 3.1 » Config » lo » EtherCAT

A

£ Mame Altering Date Type Sizre
) BECKNON ETRErLA | Evaboara FOTETFEEE T XML Document i R
|2 Beckhoff EtherCAT Tarminals 201524 13:57 AWML Dosument 53 KB
= Beckhoff FE1XOL 2T 524 13:26 XML Document 49 KB
% Beckholt FCooo 20015/2/4 13:57 #ML Document 21 KB
=7 Beckhoff FM 3o 208629 1605 AML Document 357 KB
|2 Beckheff ILoos-B110 2015/2/4 1357 ¥ML Document 8 KB

e [==] EK—HDD-_".I'LE-.'I 20290 19135 *ML Document 238 KB

Figure 5-1-10 Installing the XML description file
4. New project and equipment configuration

Open TwinCAT3 software and choose "File" > New > Project from the menu bar, as shown
in Figure 5-1-11. In the window of new Project, select "TwinCAT Projects", as shown in Figure

5-1-12.
File (F} Edit{E} View (V) Project (P) Debug (D) TwinCAT  TwinSAFE  PLC Team (M)

Mew (M) i3 Project(P)  Cirl+Shifts N
Open (O] ‘3 Fite (F} Cirl+ M

Sorey . e
Homepages =

Figure 5-1-11 New project

New Project ?
b Latest S mg Basis: |Def"a\1H Value -| T Search(Crl+E) o
4 Installed [ ; ] : : T .
TwinCAT XAE Proje... TwinCAT Projects Lypec TWnEAT Brojecis
b TwinCAT Measurement TwinCAT MAE System Manager
TwinCAT Projects Configuration
TwinCAT PLC

TeXaeShell Sclution

The informetion you request is unavailabie.
Open Visual Studio mstilstion program.

Name [TwinCAT Projecti |
Location |C:\U5Brs\ABC\Documents\TcheSheII - | [ Bmwse (B) |
Solution Name (M):  TWinCAT Project] Cieate catalog (D) for seluion.
l:‘ Add to the sowrce code management (17},
e Cofirm ||  Camcel |

Figure 5-1-12 Selecting TwinCAT Project
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Scan the 10 connected to the programming computer into the project. Click "[/O" >
"Devices" > "Scan" in the project tree, as shown in Figure 5-1-13. The hardware configuration
displayed in the Scan is shown in Figure 5-1-14.

fa] Solution “TwinCat Project2”(1 Project)
4 o TwinCAT Project2
b @l sYsTEM
=] MOTION
&l ric
| SAFETY
C++

&l anaLvTics

4 3 1/0 ‘.

13 Add new project (W)... ins
a0 Add existing project (G)...  Shift+Alt+A
Add New Folder...

Export EAP Canfig File

e. g Scanh

Paste (P) Crl £V

"y I Ry LpAY
Fasee WIKh LINKs

Figure 5-1-13 Scanning I/O devices
4 F 0

4 L Devices
4 & Device 3 (EtherCAT)

+H
e Image

2 Image-info

2 SyncUnits

L) Inputs

B Outputs

& InfoData

& Box 1 (EX-1100)

b @ Module 1 (EX-4014)
b @ Module 2 (EX-5014)
b E WcState

b & InfoData
g W P

A ¥ ¥ ¥V ¥

Figure 5-1-14 Hardware configuration

5. IO monitoring and forced output

In the project tree, choose I/O > Devices > Device3 (EtherCAT) > Box1 (EX-1100) >
Mobule2 (EX-5014) > Channels Data. Double-click Channel 0. Choose Online > Write and force
the value to 1000, as shown in Figure 5-1-15. Figure 5-1-16 shows the monitoring result.
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o @B -8k

@] Saolution “TwinCAT Project2” (1 Project)
4 ol TWinCAT Project2
b @l sYsTEM

4 ¥ Device 3 (EtherCAT)
'2- Image
an Image-info
b2 Syrclinits
b L inputs [§
b Qutputs
b & infoData
4 ¥ Box 1 (EX-1100)
4 @ Module 1 (EX-4014)
b L Channels Data
4 @ Module 2 (EX-5014)
b 3 Alarm Data

B Channels Data
e B Channel 0
B Channel 1

& Channel 2
B Channel 3

Search Solution Resource Mahager '[Ctrl +7)

Variable Flags Online
P
Value: o
NewVelue: [t Relosse o
Comment: |

| 2 B B S
.S |
L | UL ] B S B B S
| Boot ] 1 [ HexEdt. | o
[ Binsy |83 [ EEE |
Bises (1 08 @18 O O8O

Figure 5-1-15 Forcing write values

Value:

Comment:

Variable Flags

New Value:

Cnline

TwinCAT Project2 + X

|1000

Release

10'00.[

Figure 5-1-16 Monitoring results
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5.1.3 Connection and Configuration of CODESYS and EX-1100

1. Communication connection diagram, as shown in Figure 5-1-17.

Programming computer
Codesys v3.5

EtherCAT. ™

‘Adapter

EX-4014 | EX-5014
EX-1100

Figure 5-1-17 Communication connection diagram

2. The hardware configuration is shown in Table 5-1-3

Table 5-1-3 Hardware configuration table

Hardware Quantity Note
Computer programming 1 Install the Codesys V3.5
EX-1100 1 EtherCAT adapter
EX-4014 1 Analog input module
EX-5014 1 Analog output module
Ethernet cable A number of

3. Install the XML description file

Open CODESYS V3.5 and choose Tools > Device Repository from the menu bar, as shown

in Figure 5-1-18.
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% Device Memory Library

Tool [Window Help

Autol ’ :
" Location(L)  system Repository

Version Description

w

i Supplier: <Al Suppliers>

@ Package Manager... {(i:\,angmrEData\C.dD.E.YS\bevi'ce.s.}
U Library...
[j‘i Deice Memo Description of Installed Device (v)
] Visual Element Library :.";‘;';"-E"M"'é' Siring for Full-text Search
'ﬂ Wisual Style Library... . .Name Supplier
ﬂ Authorized Memoary Library... + 7] Other Options
ﬂ Authorized Manager.. i 3 HMI Device
+ @pc
Script g + & SoftMotion Driver
i, + @ canhus
Opfion....
Export/import Option
Device Reader...

Edit Location

Install 1)...
Unload (L)

Expart (E)

Details (D).

Figure 5-1-18 Installing the XML device description file

4. New project and equipment configuration

Open CODESYS V3.5 software and choose "New Project" > "Project" > "Standard Project",

as shown in Figure 5-1-19.

=] New Project
(@ Upen Project Fite
([ Open Project from PLG...

=] New Project
Category (C): Template {T):
. il Libraries - e
{2 Projects ®

(2
8 A

Standard
project w...

| Empty project  HMI project

@

Standard
project

A project containing one device, one application, and an empty implementation for PLC_PRG

Name (N): |Untitied1

Location (L): |m

e

4 T

saw |
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Figure 5-1-20 New construction project

In the standard engineering window, select CODESY'S SoftMotion Win V3 for device and
Structured Text (ST) for PLC_PRG programming language, as shown in Figure 5-1-21.

standard Project

J A new project will be created. The wizard will create the following objects in the project;

-A programmable device dascribed as follows
-A program PLC_PRG that uses the language specified as follows
-A cycle task that uses FLC_PRG - Incorporating the latest standard library that is
installed in the current stage
[

o Device(D) CODESYS SoftMotion Win V3 (35 - Smart Software Solutions GmbH) “

e PLC_PRGIn  Structural Text (ST v

Confirm Cancel
(3 Jemm

Figure 5-1-21 Selecting device and programming language
Note: Softmotion can bring driver and 1/0, Control can only bring I/0 and can not bring driver.

In the Device tree, choose Device (CODESYS SoftMotion Win V3) > Add Device, as shown
in Figure 5-1-22. In the Device adding window, choose FieldBus > EtherCAT > EtherCAT Master,
as shown in Figure 5-1-23.

= unsteds -
6 1] Device (CODESYS SoftMotion Win V3) |
— Coud

By Copy

!_ |, Paste

| ¥ Delete

I Remodel 2

i 3 Attribute. .

|5 Add Object b

| —%  Add Folder..

I Updata Device... t?

|[]" Edit Object
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Figure 5-1-22 Adding devices

| Character String for Full-iext Search | Supplier <Al Suppliers> ~
Name Supplier Version A
= [f Canbus o
+ AN CANbus
= w‘jEﬁ'lercat
- % Master Station
Eﬂ EtherCAT Master 35 - Smart Software Solutions GmbH 3.5.16.0
Ei] EtherCAT Master SoftMotion 35 - Smart Software Solutions GmbH 3.5.16.0
+ — EthernetlP
+ Bl Modbus W
< >
Group by category |:| Show all versiéns .( only for expert). D Show t.hr.-,1 outﬁated vefsbns.

Name: EtherCAT Master

Supplier: 35-Smart Software Solutions GmbH
Group: Master Station

Version: 3.5.16.0

Number of Modules:

~

=

The selected device will be added as the final sub-device.
Device
# (When this window pops up, you can select another target node in the navigator. )

e e

Figure 5-1-23 Selecting the EtherCAT bus

To assign a network port to EtherCAT Master, double-click "EtherCAT Master" >
"EtherCAT NIC Settings" > "Browse" in the device tree, as shown in Figure 5-1-24.

Device > X% [ EtherCAT Master x
= [ Lhetiedl T
= (3 Device (CODESYS SoftMotion Win V3 | feneenl %] iy Configured h Station EtherCAT. —
= @)l PLC Logic | i » i .
S b | Synehremizs UnitAssianment | EtherCAT NIC Setting
m Library Manager | Log Target Address (MAC)  fr.fFrFF-FFFFFF [+l Broadcast Enable redundant.

{B] Pic_rre PRS)
= E Task Configuration
£ EtherCAT Task (IEC-Tasks)
= 5 ManTask (TEC-Tasks) I
& sic_ems
[ EtherCAT Master (EtherCAT Master)
& Softhotion General Axis Pool |

| EtherCATIO Mapping

EtherCATIEC Object

Source Address (MAC) [00-00-00-000000 | | Browse...

Metwork Mame

® Select netwark by MAC. () Selact network by mame.

2 Distributive Clock. Options
Information Cycle 000 1 [
Synchronize Deviation 20 24 %

[[] Synchrenize Window Monitoring

Synchronize Window 1 e

Figure 5-1-24 Assigning network ports

Tip: Before assigning network ports, you need to download the project to the controller

Scan the actual hardware configuration into the project, right click "EtherCAT Master" >

"Scan Device", and you can see the actual hardware configuration in the scanning window, as

shown in Figure 5-1-25.
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Scan Device

L e R
| Device Name  Device Type Alias Address
=- BX 1100 EX-1100 EtherfAT Adapter a

EX_4ni4 hnslogInpat, ¥oltage (D-10¥/0-5¥}, 4Channels, 1Z2Eit (0)
EX_Gii4 knalogOutput, Yol tage{0~10¥/0-5Y), 4 Channel=, 12Bi ¢ (D)

Assign Address [[] Show Enginesring Cifferences
ScanDevice  Install Missing Description File-- Copy All Device into tha Project

Figure 5-1-25 Scanning equipment

5. The program is downloaded, run and monitored. The monitoring results are shown in Figure
5-1-26.

= [ bintited’! -
[ - (i) Device [Connected] (CODESYS SoftMotion Win V3)
= Bl FLC Logic

= £ Application [Operating]
m Library Manager
(B] PLC_PRG (PRG)
= (24 Task Configuration
3¢5 EtherCAT_Task (TEC-Tasks)
= gk MainTask (IEC-Tasks)
& PLC_PRG
= i [1] EtherCAT Master (EtherCAT Master)
= T EX_1100 (EX-1100 EtherCAT Adapter)
8 Ex_2014 (Analog Input, Voltage(D-10v/0-
:H BX_5014 (Analog Output, Yoitage!D-10v/

Figure 5-1-26 Monitoring results

5.1.4 Connection and Configuration between Sysmac Studio and EX-1100

1. Communication connection diagram, as shown in Figure 5-1-27.

Email:contact@welllinkio.com 9 3



LY ¥ |

j————— - — = —
EX Series Card I/O el VY E el

Programming computer
OMRON
NJ301-1100 Sysmac Studio
EtherCAT
Adapter
EX-4014 | EX-5014
EX-1100

Figure 5-1-27 Communication connection diagram
2. Table 5-1-4 shows the hardware configuration

Table 5-1-4 Hardware configuration table

Hardware Quantity Note
Computer programming 1 Sysmac Studio
The controller 1 NJIN301-1100
EX-1100 1 EtherCAT adapter
EX210H | Digital quantity input
module
EX.3108 | Digital measuring heat
output module
EX-4014 1 Analog input module
EX-5014 1 Analog output module
Ethernet cable A number of

3. Install the XML description file

Install the XML description file into Sysmac Studio, as shown in Figure 5-1-28. Example
Default folder
C:\ProgramFiles(x86)\OMRON\SysmacStudio\IODeviceProfiles\EsiFiles\UserEsiFiles)

b Local Disk(C) » Program Files (x86) » OMRON » Sysmac Studic » [ODeviceProfiles » EsiFiles » UserEsifiles

Print  Imprint New Folder
0

Name : Maodification Date Type Mamory Siza
= EC-HHO0-CONMN_V1.1.1.xml 2018/8/2 18:50 XML Document 19 KB
) EX-1100 ForTwinCAT-V1.0.4.xml 2018/8/28 20n19 XML Document 109 K8

Figure 5-1-28 Installing the XML description file

4. New project and equipment configuration
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Open Sysmac Studio, select New Project, and configure the device model and version
number, as shown in Figure 5-1-29.

]

3 Project Properiics
Project Name New Project
pen Project]
Author w1
Import(l).

Expori(E) Note
Online

4 Link to Device (C) i Standard Project
Version Control

zrsion Conlrol Browser (V)

N Scioct Dovico | 2

Tyoe Controller
License (L) Controller N30

Device [140

3 Create(C)

Figure 5-1-29 New construction project

Add the adapter, double-click EtherCAT in the multi-view browser, select Well-Link IO in
the toolbox, and select EX-1100 Rev at the bottom of the toolbox, as shown in Figure 5-1-30.

|t a8 @

Muli-view Browser

= Toolbox

I Frojoct Name Vale |

Master Device
Produce Name: Master Device
Mumbar of Blava Dovies 0
Comtroller Setting PDO Commenication Cpels 512')1 Micresaconds
Motion Control Satting e Ly ey Tanee it Sering Eritar Kay Words
Reference Cluch

£ Data Track Satting
v
¥ @ rous
¥ Program

LFunction Compile
Functinn Block S LUEAUE NS
|

1 Instructian 1 Program | Location

Figure 5-1-30 Adding an adapter

In the EtherCAT view, click ex-1100 and choose edit Module Configuration, as shown in

Figure 5-1-31. I/O configuration is performed according to the actual I/O hardware configuration,
as shown in Figure 5-1-32.
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9
0
1
12

13 EX Senak IC

14 EX Seniaks IC
15 EX Serials IC
16 EX Seriaks IC

Compile

[

Instruction

Noda Addrass

Valid/Invalid Serting  [Valid
Serial Port Number  0x00000000
PDO Mapping Setting -
Distribution Clock Valich--

Shift Time Setting
Reference Clock

Yes

Initialization Parameter Setting
Backup Parameter Satting

Module Configuratior & 1",
onfiguratior Edit Module
Configuration

r Drevice Name

Set Master Device Name

Figure 5-1-31 Edit module configuration

Module

Product Name
Connected Location

PDO Mapping 5etting 46 b1 Mapping
Setting

 Device Name

Program | Location

Figure 5-1-32 I/O configuration

| Enter Key Words

ModekEX-2108
Product Name:Digitall
Suppliers: DEC AUTORAA

Click the online icon, right-click on the icon of the master device, and select Write slave
device node address (well-link EtherCAT slave device default node is 0, so the node number must
be set), as shown in Figure 5-1-33.
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Copy (C]
Paste 1)
Delete (0]

cancel L)
Aiesal (R)

WK In S3VE 8410 NOdE AATeSs (W)
Compare s recrge wilh ksl etk configmion
otan Save Dence Senal Port Number (N}

Cancel A1 S=mng (L)
Sow Diagnusis/5lstisical Informaion (G}

Communication Cycle 2

Transmit Delzy Time

tart Wait Time 4
POO Commisication Timeout Teat Timea?
sl Mulod
Sanial Pori Nurmier Tesi Method

Figure 5-1-33 Node address writing

Note: After the node address is written, the device needs to be restarted for the node address to take

effect.

After the device is restarted, download the program to the controller. Choose Controller >
Transferring > Transfer to Controller (T) from the menu bar, as shown in Figure 5-32. Then
download the program, as shown in Figure 5-1-34.

Synchronize [¥) CrlaM

Communication Settng {C)...

Change Dewice (V)

Online (O)

Offline {F) Crl+Shift+ W

tho Contale (.. Ctel+T

Mode (M) ' »  Transmit froen Controlier (F)...Crl+ Shift

Monitor [N)

Stop Monitoring (M)

Set/Reset (3] »
Forced Refresh (F) »
MC Trial Operation (U) >
MC Monitoring Table (T)...

CNC Coordinate System Monitoring List (Z)w
SD Memory Card (D).

Controller Clock [K]...

Release Accese Permission (C)

Update CPL! Unit Name (P}

Security (E) »
Elear AN Content (L)...

Resei Controller (R). ..
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Project Name

| Dedcetam:
Wodkl”
FProduct Name
___Humber of Save Derdce

Transmit [to Controller]

[‘} -Configuration and Satting
EtherCAT, CPU/Expansion

Task Satting
-Program
POU, Cata, Library

[ Options
o not transmit P

i Nt transmit the it
I saries specia unk pagms

™ units).

-Operate the setting and MX anit sppication data i
Please do not transmit EtherNet/I? cannection setting (kuilt in portz an

#|¥DO Communication Cycla

The Tollowing dara will ba ransmitted.

Rack, 170 Mapping, Controller Setti
< IPRDM T i O Commurication Timeout TestTimes 2

fersion TestMethod

Motion Control Sextion.Cam Ibhaal Data Sntting, Event Setting
izl Port Number Test Method

Downloading

ansmitted,
trassfomad| .
s )| Device Name _

he terminaldevice unit. || Set Maser Device Name

Goicute €1 Dose gy ||
!

Figure 5-1-35 Performing the download

5.2 Connection between EX-1110 and PLC

5.2.1 Connection and Configuration between TIA Portal and EX-1110

1. Communication connection diagram, as shown in Figure 5-2-1.

57-1212C

FoGo8

Value

Master Device
Master Device

1
2000
Nox
1000 Meter
sult-Wiskering Operation
Second
Times

Microsaconds '

30

SetValue<-Actual Device
NoCheck

Programming computer

TIA Protal V16

Adapter
EX-1110

EX-4014 | EX-5014

Figure 5-2-1 Communication connection diagram

2. Table 5-2-1 shows the hardware configuration
Table 5-2-1 Hardware configuration table

Hardware

Quantity

Note
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Computer programming 1 Install TIA Portal V16
The controller 1 S7-1212C
EX-1110 1 PROFINET adapter
EX-4014 1 Analog input module
EX-5014 1 Analog output module
Ethernet cable A number of

3. Install the GSD file

Open TIA Portal V16 and choose Options > Support Device Description File (GSD) from the

menu bar, as shown in Figure 5-2-2.

T setis)
Support Packa

(1] Global Library

Teamcenter

Windoe W)

Help (HI

ge(F

Maragemernt General Station Descril P |
StartupfAutomation License Manager
# Show Referznce Teat (W)

(G

Figure 5-2-2 Installing GSD files

4. New project and equipment configuration

Open TIA Portal V16, select a new project and configure it, as shown in Figure 5-2-3.
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Device Name:
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« @ Controller £
w [ SIMATIC 571200
~ Wy

» [l CPU 1211C ACIDCIRlY

» [l CFU 1211C DEIDCIDC

» (il CPU 1211C DOUDCRY

» [l €PU 1212C ACIDCRly

w [l CPU 1212C DLDCIDC
Il 6E57 212-1AD30-DK80
W ses7 212-14E31-0%ED
I ses7 212-1 AE40-0xB0

» [l CPU 1212C DOIDCRY

b [ CPU 1214C ACIDCIRly

» [ cPu 1214C DUDCIDC

» [l CPU 1214C DEIDCIRY

» [l CPU 1215C ATDCRYY

+ [l €Pu 1215€ DODCIDC

» "Il CPU 1215C DCIDCIRYy

¥ [ CPU 1217C DODCIDC

» [ cPU 1212FC DUDCIDC

» [l CPU 1212FC DC/DCRY

» ([l CPU 1214FC DC/DCIOC

» (@ CPU 1214FC DCDCRlY

» [l CPU 1215EC DODCIDC

» [ CPU 1215FC DCIDCRly

» [ cPU SIPLUS

a L_'-.t#ﬁ‘nml.!m S

Controtier

o

@ Conhigured Network

: =T
# Help

59 Open D Vi

Device

CPU 1212C DOIDOIDC
PO Number:  [6e57 212-14E31-0%80 |
Version: (V3.0 =]
Note:

50 KB Work Memory: 24VDC Power Source:
Onboard DiSx 24V0C Leakage/Source
Type DQBx24VDC and Al2: 4 Onboard
high-epeed counter (digital signal board
expansion can be used) and 4-channel pulse
output; Signal Board Expansion Onboard 10
3 communication modules for senal
communication; and 2 signal modules for [0
expansion; PROFINET intarface usad for
programming and communication between
HWM and PLC.

(3

Figure 5-2-3 New construction project

To configure the device, expand the hardware directory in the network view and select the
adapter, as shown in Figure 5-2-4. Double-click the adapter to enter the CONFIGURATION I/O

module in the device view, as shown in Figure 5-2-5.

|;Topoq¢‘i Matwork View | [If DuvicaView | | Cption
T T : i e
QIR S == TR 2 T Metwork Ovsrvies] Conmectian] g
Al e ~ | Gatag
» 57412005000 1 | <liearchs
PCa Ficie [ Fiter Canfigaration File <Falt-
cPUT212C L Tl G
b HAl
+ [ PC Systom

Figure 5-2-4 Configuring devices
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Figure 5-2-5 CONFIGURED I/O module

To assign controllers to I/OS in the network view, click Unassigned in the I/O module and
select PLC 1.PROFINET interface 1, as shown in Figure 5-2-6.

PLC_T DEC
CPU 1212C EX-1110

mmct 10 controller

.F‘r&hﬂ“ﬁ"ﬁ‘ﬁ.‘.m‘?@‘%—‘_

Figure 5-2-6 Assigning IO controllers

Set the IP address of the I/O module. In the device view, double-click the module to go to the
properties view, as shown in Figure 5-2-7.

Email:contact@welllinkio.com 1 0 1



=T =)
EX Series Card I/O (W ] - -

Figure 5-2-7 Assigning IP addresses

Assign a device name to a remote I/O module. Right-click the module and choose Assign
Device Name, as shown in Figure 5-2-8. Select the interface type, update the list, and assign the
device name, as shown in Figure 5-2-9.

¥ Citine [F| Cirialt
g'ﬁﬂmﬂﬂwﬂ 0 CrlaD

o m:ummnmapwnﬁ
ﬂ‘mﬁam M1
P Cingrefermnced InfonraBbWT-F 1 |

_Mpulakey | CHME
D Bt Label().
8 Progarty MrsEnier
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Figure 5-2-8 Assigning device names Figure 5-2-9 Writing device names

5. Program download and equipment monitoring

Select all devices in the network view and download, as shown in Figure 5-2-10. After
downloading the program, start CPU operation and switch to online monitoring for normal

communication, as shown in Figure 5-2-11.

<Rl B/ B B & online @Forfine g MIE X || [

Program 1 > Device and Network

giNetwork 1§ Connection [l comnection|~) 20 53 W [l @ ¢
PLC1 DEC I
o CPU 1212 EX-1110
PEC_1

Downioad Preview
e Chack before Download

Status ¢ | Target Message Action
I T Ready for Download. Loading “PLC 1"
I * Protect Protect system to prevent unauthorized access

Davice connectad to corporate network or directly connactad
1o the internat must be properly protectad to pravent
unauthorized access, e.g. firewall or network segment. For

b more information about industrial safety, pleasevisit:
hitp:/ fwww siemens.comfindustrialsecurity
& » Stop Module Module is stopped after downloading to device. All Stopped
Q » Device Configuration Delete and Replace System Data in the Target Download to Device

Figure 5-2-10 Program download
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Figure 5-2-11 Device monitoring

5.2.2 Connection and Configuration between Step7 smart devices and EX-1110

1. Communication connection diagram, as shown in Figure 5-2-12.

Programming computer

STEP 7-MicroWIN
SMART

CPU ST40
(pDc/pc/oe)

T

Adapter
EX-1110

EX-4014 | EX-5014

Figure 5-2-12 Communication connection diagram

2. Table 5-2-2 shows the hardware configuration

Table 5-2-2 Hardware configuration table

Hardware Quantity Note
Computer programming | Install STEP7 - MicroWIN
SMART
The controller 1 CPU ST40(DC/DC/DC)
EX-1110 1 PROFINET adapter
EX-4014 1 Analog input module
EX-5014 1 Analog output module
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Ethernet cable A number of

3. Install the GSD file

Open Step7-Microwin SMART, and choose GSDML Management from the menu bar, as
shown in Figure 5-2-13.

] Create | -

‘.;;m pil S

b=l GSDML
"aqe Starage Manege
i LI T

,f-:' * | GSDML Manage x
Brief Introduction

I Pou

“GSOML Manager” can instal and delate GEDML file for FROFINET.

Imported GSDML File

GSOMLV2 3DECEX1110 ¥1,1.4. 2020091 6 vl 20201113 15:31.40

i I "_‘

Imported GSDML File

C: |JsersIWTD\Deskiop), e Browse 1 Delete

9 Confirm

Figure 5-2-13 Installing GSD files
4. Assign the device name

On the menu bar, choose "Tools" > "Find PROFINET Device", select the network adapter
connected to the module in the window and find the device, select the module in the network and
edit its device name, as shown in Figure 5-2-14.

Note:

(O When you select a NIC, two options are displayed for the same NIC, as shown in the following
figure. Select the NIC without Auto.

Fiealtek PCIe GBE Family Controller. TCPIP. 1
Realtek PCIe GBE Family Controller, TCPIP. Auto. 1

(2) After the device name is assigned, note that the device name must be the same as the assigned
name when configuring the IO module; otherwise, PLC cannot communicate with the IO module
normally.
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Station name [Chinese, ASCI| Characters a
and - . Cannot start with .
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Iciew.

Converted Name: dec

Search Device o

Figure 5-2-14 Assigning device names

5. New project and equipment configuration

5 Pressthe ‘Edit” button to change the name of the selected
unication Interface device. Press the  "Flashing Indicator” button to turn the
Realtek PCle GBE Family Controlier TCPTP. 1 ;I device LED continuous flashing for visual inspection of
5 connected devices:
| ] PROFINET Device Lorem lpsum
= oEC IMABM:QI:UIE:E':I Flashing Indicator I
B 0.0.0.0 {dec)

g A g
r-m

0=

Cancel '

On the menu bar, choose Tools > PROFINET, select the PLC role as the controller, as shown
in Figure 5-2-15, add the adapter, assign the device name (the same as the device name assigned
in Step 4 above) and IP address, as shown in Figure 5-2-16, add the 10 module, as shown in

Figure 5-2-17, and select Generate.
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Help
N

ext DisplayGet/Put Data Log PROFINET

17 PROFINET Matwark
""" [ Controller{CPUST4D_plc200smart) Brief Introduction

The wizard allows you to configure PROFINET network step by step. Information on
PROFINET configuration is produced and stored in the project and can be

PLC Role

Select PLC Role
Iv Controller

‘I_ Smart Device

™ PROFINET interface parameters are assigned by the upper coniroiler

Figure 5-2-15 Selecting PLC roles

PROFINET Configuration Guide

ROFNET Network | ple et Catalog
! Centroller{CPU ST40_ple200smart) m oy £1-PLC §7-200 SMART
= [ EX-1110V10,00.00-dec EEEEI 192166.21 4 CPU SR
I ex-11100) -'_ g] # CRU SR
[ Completa = R SR
- CPU SRE0
decfEA1110v10.00.00) & CPUSTI0
l I - CPUSTH
s & CPU ST
' 5 CPU STe0
- FROFINET -0
B0
=-DEC
B WELLLINGO
EX-1130%10.00.00
Thedevice table lists all devices currently configured fer this PROFINET network.
Devices can be added from the device content treeon the right.
Device List
|Device Number | Type DeviceName | [P Setup IP Addrass Il
1 EX- 1110V 10.00.00 dex User Setting 192.168,2.55
.; PONo.  oroias
; Version
g |Gs0ML42,30ECEX-1110_v1 1. 420200916 amd
8 Instruction
GEDMLY2.3DECEX-1110_v1.1.4-
= 21 202000.xm
Add | Del-?[d Prafilet Adaptar
Back Next Generat: Cancel
< > | _I J ..__I

Figure 5-2-16 Adding an adapter
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PROFINET Corfiguration Guide

PROFINET Metwark

£ [ &)X-1110v10.00.00-dec.dav ]
T p-110000)
141
EX_5014(2)
Complete

B4 4014
' 5014

-
il T
é-_di_-
M [
i
i
ol T -
T
P e
daw -
TR
T
e
T IE
T e
T
T e
T e
2l T
<

Delate |

¥ comrmiencru sTag piencemany| CHICK “Add” button to add a module to the device.

' Update Tme (ms)  [%00 =] Data Maintain|3 -

w

P B
©

-
w

Generate Cancel

Figure 5-2-17 Adding I/O modules

6. Program download

Choose "PLC" > "Download" in the menu bar, and select "Find CPU" in the communication
window, select the PLC that needs to download the program, and download the program.

Note: For PROFINET communication using STEP 7-Microwin SMART configuration 200 SMART, the
CPU firmware version of PLC must be >V2.4. For firmware = V2.3, you can directly upgrade the

firmware online. For firmware < 2.3, you must update the firmware with a memory card in the CPU.

5.2.3 Connection and Configuration between Step7 an Ex-1110

1. Communication connection diagram, as shown in Figure 5-2-18.

315-2
PN/DP

a0GGE

Programming computer

Step7 V5.6

Adapter

EX-5014
EX-1110
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Figure 5-2-18 Communication connection diagram
2. Table 5-2-3 shows the hardware configuration

Table 5-2-3 Hardware configuration table

Hardware Quantity Note
Computer programming 1 Install Step7 V5.6
The controller 1 315-2 PN/DP
EX-1110 1 PROFINET adapter
EX-4014 1 Analog input module
EX-5014 1 Analog output module
Ethernet cable A number of

3. Install the GSD file

After the new project is created, click "SIMATIC300", double click "Hardware", in the HW
Config window, choose "Options" > "Install GSD file" in the menu bar, as shown in Figure
5-2-19.

File (F) Edit{E) Insert{l) PLC View (V) Option (O) Window (W) Help (H)

D@27 4 @ | se|[o % 2[5 5 @ | & |[<NoFiterng> Y7 (e mEMNe|

'l
= PROFINET GF <Hardware>
[l sDwTIc 300(1)
L

% HW Config - SIMATIC 300(1)
Station(S) Edit(E) Insert(l) PLC Q Option (0) Window (W) Help (H)

D8 8 & e Customize (Z)... Cirl+Al+E

B

B SIMATIC 300(1) (Configuration) - PR

Ctrl+Alt+T
Report System Error (R)..

Edit catalog configuration file (E)

Update Catalog (U)

Install Updated HW
o Install GSD File...

Search in service and support (F}..

Create the GSD file used for Device 1 (C)..

Figure 5-2-19 Installing GSD files
3. New project and equipment configuration

Open SIMATIC Manager, choose New Project from the menu bar, name the project, and
select a path to save the project, as shown in Figure 5-2-20.
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ATIC Manager
) PLC  View (V) Opfion {0} Window (W) Help(H)

ARl

Mew Project

User Project | Library | Multiple Project|
Name| Storage Path

I~ Add to current multiple project (A)
Name (M} Type (T)

=00 E—

[~ F Library (F)

Storage Location (Path) (S):

{D:\StepT VB 6\sTproj a Browse (B)... |
covs |t |

Figure 5-2-20 New construction project

Add 300 sites to the project, as shown in Figure 5-2-21.Click the newly added site 300 and
select "Hardware" to enter the HW Config configuration interface, as shown in Figure
5-2-22.Add RACK Reil for RACK 300, as shown in Figure 5-2-23.To add a CPU module, click
HW Config, select CPU315-2 PN/DP VERSION V2.6 of CPU-300 in the right pane, and drag the
CPU module to slot 2 of the rack, as shown in Figure 5-2-24.In the Ethernet interface properties
interface, you can use other IP addresses as required, here use the default IP address and subnet
mask, and select the New button, create a new subnet Ethernet (1) click OK, as shown in Figure
5-2-25.
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Cut Crl+X
Copy Crl4C
FPaste Ctrl+V

Drel

9. Insert New Object > smmlcms;anm
PLC 6 TIC 300 Station

SIMATIC H Station [:g'
SIMATIC PC Station

Other Station
SIMATIC S5

PG/PC

Rename

Object Property Alt+Return

MP|

PROFIBUS
Industrial Ethernet
PTP

Fund Canbus

Figure 5-2-21 Adding 300 sites

ST Program h

Bporu s #Step? prof\Cou 315

CPU 3i6 Hardware
[l SMATIC 300(1)

"% LW Config - SIMATIC 300(1)
Station (3) Edit (E) Insert (1) View (V) Option (O) Window (W) Help (H)

D28 §(& @ doea D9 N2

By SMVATIC 20001) (Configuration) — CPU 315

Figure 5-2-22 The HW Config page is displayed

Email:contact@welllinkio.com

111



j————— - — =
EX Series Card I/O d = e S

 Station (S) Edit(E) Insert () PLC View(V) Option (O) Window (W) Help (H)

DB & e da DD 8N

Q= — ——— Conurtion s (7 S |

[ -5~ PROFIBUS TP

48 PROPIBUS-—PA
+- 8¢ PROFINET 10
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2R R
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@] m-a00
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| ¢ mTg w00
— ) ([l STOATIC 400
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Siot | [} Module . |PONumber . [Fix [wPleddess| T @ [Note i S R Soanidem

wlon ~le|mfamlelraf—

=8

<

n.mm».:|

Figure 5-2-23 Adding rack Reil

Search [F)| M i
Gonfiguration Fike (°) [Sandard ~

=l SIMATIC 300 -
L mcr

| @ cr-300

| = cru=3m0

; -] cPU 312

(] cPY 312 IFM
®42] CPV 3120

#2] CPY 313

{2 CPU 3130

] CPU 313C-2 DP
#_) CPU 31302 PP
&) CPU 314

4.0 PV 314 IFR

& (] CPU 314C-2 DI
#20 CFV 31402 FB/IP

m o) B2 CPU 31402 FiP

i : I -] CPU 315
Slet | [§ Modul ... | PONumber .., .. | MPl Address) I. .. ... | Note i 3
[]" ﬂ ule: umber Fix g & (] CPU 3152 1P

q”I

e R R R

—-[=

=140 CRU 3152 PN/DP
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z
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Figure 5-2-24 Adding a CPU module to the rack
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Figure 5-2-25 Adding an Ethernet subnet

On Ethernet (1), configure the I/O device station. On the right, select EX-1110 and drag it

under the Ethernet (1) subnet, as shown in Figure 5-2-26.

[} i 'ﬂk
CP¥ 315-2 FE/DF
MPLF
NI
Fort i

Ethernat(1): FPROFINET-I0-Systen (100)

- Ofxi

Find (F) Ik__'l'{ﬂt}'

Profilz (P) Standard =l
FRAFIELS DF
PROFIBUS-FA

@ 382 proFINET I0
{20 &dditional Field Derices

B3 10
{Z] WELL-LIKE-L/0
| g EX-1110
= Ay
B
B 1A

[ /2] Tdent Systens
[ 2] Fetwark Componsnts
{10 Senzors
) Switehing dewices
# il smuaTIc 300
=il smuarIc 400
il SIMATIC PC Based Comtrol 3007400
# -8B SIATIC FC Statien

02-01-05 ~ g
IEC =
Frofifet Adapher

GSIML~Y2_ 3-DEC-EX-1110_v1. 1.4~ a

Figure 5-2-26 Adding IO to an Ethernet (1) subnet
Add an I/O module, expand the right EX-1110, and drag the EX-4014 and EX-5014 to the

lower slot on the left, as shown in Figure 5-2-27.
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Figure 5-2-27 Adding an I/O module

To change the IP address of the I/O device station, double-click the DEC module in the
subnet and choose Ethernet in the Properties window. You can change the IP address in the
Ethernet properties window, as shown in Figure 5-2-28.

| attrioute - DEC

| 1 i s
| Feguiar] tentncation {share [vise | - e st
Short Cescrpton  DEC =rere L
Profitet Adapter
| aix
PO No Fimware  02.01-05 / V100 b ———— |Find (F)| #tny
- |
Senes: WELL-UINKH/O Profils (P)| Btendard” ]/ | :
Property - Ethemst Interface x|l
Davice Mame: (G [DEC Fegelar Paameters|
GBSO File: GSOML-V2.3-DEC-EX-1110,v1.1.4-2020091 6axrnl

Alter Version No, [A:._.J

r-————-— Gateway
Hodee in PROFINET 10 System s, taristsl  Fouter Unused |T)

Subnist Mast || !
Device No (E) 1 =] [ProFINET 10 Syztem 100) © Rauter Used (U)

hogess ([

IP Address: 152158.0.2 o Ethemet{T}..

Subnel (3)
¥ Assign 1D Addrese through 10 Confrolier — Non-networked — Create

Nore (i)
[ | Garfirm E, cacel | wep |
| confitm |o Cancel | Helo

Figure 5-2-28 Changing the MODULE IP address

Set the device name for the I/O module, select the subnet icon, choose PLC on the menu bar,
Ethernet > Assign Device Name, as shown in Figure 5-2-29. In the Assign Device name window,
select the name to assign, and press Ok.
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Figure 5-2-29 Assigning device names

To check whether the name is assigned successfully, select the subnet icon, choose PLC on
the menu bar, and Ethernet > Verify Device Name, as shown in Figure 5-2-30.
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Figure 5-2-30 Verifying the device name

5.2.4 Connection and configuration between CODESYS and EX-1110

1. Communication connection diagram, as shown in Figure 5-2-31.
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Programming computer

Codesys V3.5

T

Adapter

EX-1110

EX-4014

EX-5014

Figure 5-2-31 Communication connection diagram.

2. Table 5-2-4 shows the hardware configuration

Table 5-2-4 Hardware configuration table

Hardware Quantity Note
Computer programming 1 Install the Codesys V3.5
EX-1110 1 PROFINET adapter
EX-4014 1 Analog input module
EX-5014 1 Analog output module
Ethernet cable A number of

2. Install the GSD file

Open CODESYS V3.5 and choose Tools > Device Repository from the menu bar, as shown

in Figure 5-2-32.
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Figure 5-2-32 Installing GSD files

4. New project and equipment configuration

Open CODESYS V3.5 software and choose "New Project" > "Project" > "Standard Project",

as shown in Figure 5-2-33.

=] New Project
(= Open Project File
[ Open Project from PLC...

=] New Project
Category (C): Template (T): Q
| L3 Libranes = N %
2 o » @ E
| Empty project  HMIproject  Standard
project
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4 T

Tl
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Figure 5-2-33 New construction project

In the standard engineering window, select CODESY'S SoftMotion Win V3 for device and
Structured Text (ST) for PLC_PRG programming language, as shown in Figure 5-2-34.

o

Standard Proj

j A new project will be created. The wizard will create the following chjects in the project:

-A programmable device described as follows
-A program PLC_PRG that uses the language specified as follows
-A cycle task that uses FLC_PRG - Incorporating the latest standard library that is
installed in the current stage
s

o Device(D)  CODESYS SoftMotion Win V3 (35 - Smart Software Solutions GmbH) ~

e PLC PRGIn  Structural Text (ST) v

Confirm Cancel
(3 Jezm

Figure 5-2-34 Selecting device and programming language

Choose Device (CODESYS SoftMotion Win V3) > Add Device in the Device tree to add the
Ethernet adapter and PROFINET IO master station, as shown in Figure 5-2-35 and 5-2-36.

Tip: PROFINET IO configuration in the original Codesys software, if an error is reported that the
library is lost, the user needs to manually double click the library manager and choose to download
the lost library in the library manager window. This process requires the computer to connect to the
network.In addition, pay attention to the IP address and network segment of the network port
connected to the I/O device. Otherwise, the IP address of the I/O device may be in different network
segments.
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gl Lhiitied? -
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= £ Application (® Additional Device (8)  Inser Deviee (1) Pull-oul Device (F) C) Update Device {U)
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B s Chararier Strng for Full-ter Sear Supplier | <Al Suppliars> v
= &8 Task Assignment Hame Supplier ¥Yemim; | [Deiplion
= 8 MainTask (IEC Tasks) = (@ cANbus
@] PLC_PRG + o CANbus
‘& SoftMotion General Axis Pool + oF Sthercat
+ - <= Cthemet?
+ N8 Modbus
+ B profbus

= & Profinet 10
+ T Frofinet |0 Master Station

+ 55 Profinet 10 Device

= Ethemnel Adapler
i‘i Ethernet 35 - Smart Software Solubons GmbH 3.5.160 Ethernet Link,

E [aal}
+ W@ Fthernet Adaptar
+ (&} Aulomatic Return i Criginal Poirt & Create

Figure 5-2-35 Adding an Ethernet adapter
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= [ Task Assignment Name Supplier Version  Descripton
= 5 MainTask (TECTasks) | = (@ cANbus
& Acme +  Ethernstlp
4] Ethernet (Ethernet) + e Mochus
2 SoftMotion General fxs Pool = E profinet 10
7 Profinel 10 Master Station
[ [r-controler | 5 - Smart Softwere Solutons GmbH  3.5.16.0  Profinet 10 Contcller
“ Profinet 10 Device

Figure 5-2-36 Adding PROFINET IO master station

Double-click Ethernet in the device tree to assign Ethernet ports and set IP parameters for the
PROFINET IO master station, as shown in Figure 5-2-37 and 5-2-38.

& oi_controler CommCyde
& Profinet_IOTask (IECTasks)
_ﬂ Ethernet (Ethermst)
{H Pn_Controter (PH-Cantraler)
" SoftMotion Gereval Asis Pool

Bealtek FCTo (GBE Famil
Ethernet: 1 Eealtak FCTa GBE Family Controller

Wirnre Betvark Adapter Winet] Wheare Virtusl Bthernet Adapter for WMnetl

Dewce > B X rthemet x|
=3 Lnewed? -
= ) Device [Linked] (CODESYS ScMaion Wava) | | Cenera Network interface | Ethamet [ e
TRt iy IP Address 169 . 254 , 173, 9
= £} Application ST
”LtbraryManager Slatus Subnet Masx 255 . 355, 0 o0 |
B Acrrs era) 1 . y DefaultGaleway | 0 . 0 . 0 , 0
= [@Task Assi | Ethernat Dovies VO Mapging | -
s Ll Netwcrk Adaptar X
= ¢ MainTask (IECTasks)
& pcme inferface
= £ Profirct_CommuricatianTask (IEC-T; Hame Descrption IP Address -~

168, 2 3 98

192 168 1 241
192165171

Wirars Fetvork Adapter Winetl Whware Virtusl Ethernet Adapter for Vinetd

192 165 441

WLAK Intel (E) Jual Band Wireless—AC 3165 192, 168.6.3 b
P hddross 8 4 173 98 |
Subret Mask W 265 0 0
DefaultGatewzy  © . 0 . 0 . 0 |
MAC Address  [cBISBIT6.CEBI6S |
9 i

Figure 5-2-37 Ethernet distribution network ports

Device ~ # X || 7] en_controller x
= 3 Unstied? |=
= {{ oevice (CODESYS SoftMation Win V3) General Station Name |_ncntrna::
= 2 PLC Logic ; !
= € Appleation S Default 8lave Device IP Parameters
D Library Manager I Tapology First IF Address
[§) PLC_PRG (PRG) I Final I Address 150 , 254 . 0 .
- . Media Redundancy —— —
ﬁz;;“'“’gnma"! Subret Mask [2s5 . 285 . 0
= 8 MainTask (IEC-Tasks . —
= -9_'|mch :; ) I PNIOUO Mapping Defauti Gateway | 0 . 0 . 0
= &8 erofinet_CommunicationTask (IEC-Task{| | PNIOIEC Chject ;
& & en Emt':C Cﬂ(ﬂ l b ID Bupplier/Consumer 1D
G e e m:‘::ﬂ} ! (i [ Application Stop->Afternative Value
-
L [ Add to IP Mapping
E_mermcrma-net} I St
[ Pu_Contraller (PN-Controller) Port Data
SoftMotion General Axis Pool l Information

Figure 5-2-38 Setting the PROFINET IO master IP address
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Download the program to the controller and start running, and then log out.Right-click
PN _Controller and choose Scan Devices. In the device window, select the module and assign the
device name and IP address, as shown in Figure 5-2-39.Copy the device into the project, as

shown in Figure 5-2-40.

Scan Device

Sean Device

| Station Mame |deniification Numiber MAC Address P Address
e daBS Pro daat—TD + Erver: Avalid IR is OB
xS, Froduet-TD o requested! ™ m.m.ﬁl.e

Subnet Mask Gat

--= Reset Flashing LED Settng Mame and IP [ 5hew snly nemamed seations [ SPow Project Diference

ing 1P <

; DEC {(0u0001)
wandor:  {OeS457 )
£ walid IP needs to obtain the [denthirl

Scan Device Install the lost description file... Copy to Project Cloze

Figure 5-2-39 Assigning names and IP addresses

Scan Device

Scan Device
Dievice Mame  Device Ty:-e Stafion Name Hﬁg:éﬁahun MAC Address I Address  Subnet Mask  Gateway
dee El dag 15800000001 T4:A0:00:01:06: 20 169.264.0.2 255,265, 0.0
des, 1 IX_401 15300000007
dee 7 BX_ 5014 15300000000
|8 Setting IF =--  -.» Reset Flashing LED Setting Name and IF []5hew only uwsmamed stations [ Show Project Difference

Sean Device e Copyall devicas to the project Close

Figure 5-2-40 Copying equipment into project

5. Program download and equipment monitoring
Download the project to the controller and start the operation and monitoring, as shown in

Figure 5-2-41.
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= 8l 5o Lagie ) S | Station Status [OK
= © Asplcation [Operaing] [
M) Library Manager 105
(] pic_prs RG) IP Parameters
= (& Task Configuration Leg IP Addracs 6% . 254 . 0 3
= 8 ManTask (IEC-Tasks) PHNIG 110 Magging Subnet Mask 25 .35 .0 .0
&) c_prc : —
: Default Gateway © .« 0 1] 0
= & profinet_CommunicationTask (IEC Tasks] | | PNID IEC Object
&) PN_Controller. CommCyde Communication
¢ profinet_I0Task [IEC-Tasks) Pl Transmit Clock {ms) | : Watchdog (ms) T
_ 3 ;ﬁp::‘:‘::ﬂw 5 | il Reduction Ratio |4 VLAN D 0E
= G dec x-1110) - Stage i
G ectfmx_s019)
S @ cec_2Ex_s014) RT Class AT Class ©
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Figure 5-2-41 Program download and monitoring
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5.3 Connection between Ex-1010 and PLC

Note: ¢X-One and EX-1010 have manual and automatic communication configurations. Please refer to
details 4 and 5 in 5.3.1 for details.

5.3.1 Connection and Configuration between CX-One and EX-1010

1. Communication connection diagram, as shown in FIG. 5-3-1.

OMRON Programming computer
CJ2M/CJIW- )
DR2ZM Sysmac Studio

DeviceNet->>

Adapter

EX-310H | EX-200H

EX-1010

Figure 5-3-1 Communication connection diagram

Note: The power interface above the DeviceNet adapter needs to be separately connected to DC24V
power supply. Terminal resistors (121 ®) need to be added to the two terminals in the network, as shown

in Figure 5-3-2.

DeviceNET DeviceNET DeviceNET DeviceNET
Master station Slave station#1 Slave station#2 Slave station#n
1 ‘ | |' 1
= ! CANH ¢ SE—
of'| termination ‘ terminationi:‘i 5
55_‘_| - resistor bl cANL resistor |}
Figure 5-3-2 Terminal resistance wiring
2. Hardware configuration is shown in Table 5-3-1
Table 5-3-1 Hardware configuration table
Hardware Quantity Note
Computer programming 1 CX-one
Cl2mMm/
The controller 1
CJIW-DR2M
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EX-1010 1 DeviceNet adapter
EX.200H 1 Digital quantity input
module
EX-310H 1 Digital output module
Devi
echeNet . A number of
communications line

3. Install the EDS file

Open cX-Integrator configuration software, and choose Tools > DeviceNet Tools > Edit
Configuration File > Vendor ID/ Device Type Table from the menu bar, as shown in Figure 5-3-2.

g, New Project - CX - Intergrator - [System Overview]
| File (F) Edit (E) View (V) Network (NQ Tool (T) Window (W) Help (H)
DEH SR 2R o M& Enable Data Link (D) j
- - Enable Router List (R) :
A s rah BB
T NT LINK Tool (T) k
DeviceNet Tool (N) r
[z | Controller Link Tool (L) *
Ethernet Tool (H) 4
gha 1 i
_ﬁ' Now Project PLG Node Respand Test (S)
CPS File (C) o
e EDS3 File (E) d 3
3 Update DTM Catalog  Create (C)
Option 1 Delete (D)
(%= Save (8)...
38 Search (F)

Figure 5-3-2 Installing the EDS file
4. Equipment configuration (automatic scanning)

Open CX-Integrator configuration software, choose "Network" > "Communication Settings"
from the menu bar, and select THE PLC model as "CJ2M (CPU model: CPU31)", as shown in
Figure 5-3-3.
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Change PLC ? l Device Type Setting [CJ2M] b4
Device Name o I
|RelayDievi BB |
- Device :
|cTen e Set (E)...
- Network Type |
Controller Link . Set (E)...
Cont : 2 -—L}—l ~ Total Program Area-
i.Note | |5< [Step] j [~ Read-only
- Extended Memory
32KW [1 Banks] ~| " Readonly
CGonfirm GCancel | Help (H) | | - File Memary
! |Nene~ _| ™ Read-only
-~ Timer{Clock -
[% Installed
Default (D) |
o Confirm [ Cancel | Help (H) |

Figure 5-3-3 Configuring the CPU

Automatic scanning, click "Online Work button", double-click DeviceNet[CJ1W-DRM21]
network (-), node (1), unit (0), and set the network name, confirm transmission, as shown in

Figure 5-3-4.Double-click ex-102 to see if OMron PLC scans to ex-1020 slave station and 10
module.

S —

Pl [F] BB View (V) st [1] Metwors (W) Comsensnt (0] Taol () Wiedee (W) Hep (41
Dwd 82 e LY o ]

s A dde=BAsRBFTLAR

-3

L T

 Platurh Gty aeet Pawreste-s of Each Covperars

Tearmri % for Saeh compOnGn: 5 tade
oes ey ui! i e Tgepemed b s P i of
Link anel SYSMAL LRBCL

[

Figure 5-3-4 Automatic scanning

Right-click to scan the EX-1010 icon, choose Properties, choose 1/0 Info > Edit, and

configure the number of input/output bytes for the adapter according to the input/output bytes size,
as shown in Figure 5-3-5.
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Eot
CITW-DRMIT

EJ'!-'-EOE

EX-1010 Atinibute

5 I I e IO Information

The VO data of this device cannct be assigned

to other device.

Connection | Chutfin | Size

@ Poll Cut 2bytes
In 2bytes
Bit-Stre.. Out obytes
In Obytes
o | Edit 110 Size
]
Cyclic | -Default:
: Bit Strobe
| & Pol P_E,qisﬁ_ oS © Cyde
-Palli
1 DOutput e bytes
dit (E] | Bit Strobe Pulse
Output [ bytes Output |° Lytes
03
Output |7 bytes Cutput |0 bytes
Cycle !
| output. o bytes
e Confirm | Cancel |

Figure 5-3-5 Edit the input and output bytes

5. Equipment configuration (manual configuration)

"New Project" on the right, select "Plug in Network" and "DeviceNet", as shown in Figure

5-3-6.
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1
|

Open {O)
tnsert N 1)

Delete {D)

Transmil [From PC o MetwarklT)
Transmit [From Network io PCHT)
Compare (C)

Link (T)

Rermame Network (R)
Revise Metwork Address (&)
Copy ()

FPasbe (F)

Parameters (F) ]

I-Wizard - Network/Component Setting

Nef.mrq

Mame

Mote

CompoMat
CompoWayF
ControflerLink

Beviceldat
Ethernet
MTLink
Sysmaclink

Fieldbus Network (ComgoMed)
Serial Lnk (Suitable Component:
PLC Standard Metwork (CLE)
Fieldbus Metwerk {DeviceMet}
Ethemet {FINS)

Sarfal Link {Suitabie Dlspiay: NT Link)
PLC Standard Network (SLEK)

Cancel Help

Back orabext{h&} | Comipiete

Figure 5-3-6 inserting into the network

Add the DeviveNet communication module CJ1W-DRM21 and then add the 1O device.
Right-click the network icon and choose Insert Component. In the wizard window, select
EX-1010, as shown in Figure 5-3-7.

Wizard - Metwork/Component Setting

Component I

[«

Component Type

Conmunications Ade. .~
i
I M Corpeoration
[= {23 DeviceType
ol BT

= T I

A

l
EIS (Devi cellet) I

Back [ Mext te Complete | Cancel J

Help J

Figure 5-3-7 Insert ex-1010

On the network, double-click EX-1010, and add the I/O module (for example, EX-310H and
EX-200H) in the edit device parameter window that is displayed, as shown in Figure 5-3-8.
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Edit Device Parametors

Parameter Ea'nupE:E All Parameters li
| [Faranater Hune | Valua | &
o0l Slet 1 EX-310H(15 Digital Oubpuat..
ooz Slet 2 iﬂ—mni{w Digital Input. 17
0003 Sl 3 a Eud- Teion 1}
EI‘ﬂtEﬁ g Digital (meput,
B Slot A FX-300815 Digital Dutpat, £
000% Slot B u-:ammm Digital Dutput,
0008 Slot & E_EEI?H[F I':‘fl- n% Dutwﬁ.l
=4014l4 Analog Inpat,
0007 Slet 7 EX-4114(4 Analog Input, =IC
0o0E Slot 8 EX—d0E4 (4 i.n-ulc-; Inpu‘l:. 61
| H-Elp i
Modules tvpe of slot 2 | Defauit: ¥o Module

Uptoad (L) I Eroveniozd :'D:l Compare (5]

Rezsai (R} | I

Confirm | Cancer ||

Crefault Setting |

Figure 5-3-8 Adding an 10 module

Right-click EX-1010 on the network and choose Properties. In the EX-1010 properties
window, choose I/O Info > Edit, as shown in Figure 5-3-9.

-l =l

= a Mew Project
= g DeviceNet
2% Metwork 1(DaviceNat)

| 4l Load (O
Reset (R) & Load (0}
| %l Save (&)

B Maintenance Information |:-M_|. Utaad {1}
Registered o Another Componeat. Download .jD}
Export (E) * Gaompare ()

3 Cut(T}

B copy (C) Ctel+C

B Paste (F) ;

Delete (D)
Alter Mode Address (A)
Alter Component Note (O}

o 10 Nate{C)
Enable Special Tool (A] *

B adrribute (P)

Figure 5-3-9 Edit the size of input and output bytes

6. Download configuration information

Right-click the CJ1W-DR2m icon and choose Parameters > Edit, as shown in Figure 5-3-10.
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= a Mew F'lro;iec*t
D |

] i Wizard (W)

Blleste |

=/, Monitoring (M)
n

| 4l Load (O
Reset (R) & Load (0}
&l save (&)
B Maintenance Information (M] :
g Upload (L)
Registered o Another Componeat. Download .jD}
Export (E) * Gaompare ()
3 Cut(T}
B3 Copy (G} Ctel+C
B Paste (F) ;
Delete (D)
Alter Mode Address (A}
Alter Component Note (O}
aw 10 Noie{C)
Enable Special Tool (&) *
& adtribute (P)

Figure 5-3-10 Opening parameter editing

In the edit device parameter window, select "Register button" to register the slave device, as
shown in Figure 5-3-11.After successful registration, you can see the PLC internal address
corresponding to the input and output of the slave I/O module. Finally, click the "Download"
button to download the configuration information to PLC, as shown in Figure 5-3-12.After
downloading, you can observe that the NET RUN indicator on the adapter lights up and the SYS

indicator flashes once per second.

Edit Device Parameters

Unregistered Device List

Gmm'l .}'\0 Assifnrmntl Fo A?iunmm!mpmmn Message

Siave St
ime Timer Funetion

] Product Name

l Out Saz,e—[ in Size

)2 EX-1010

 Regiztered Device Lis

0. -

Automatic Assignment of
P Baistered Dt

# | Product Name

| Out Size | Cutch | insize | inch

e

Uplcad (L) ‘ Download

Advancad Setting (A)...

Reg'rstetedj'l}rwegis&eredl

() | Cormpare (T}
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Figure 5-3-11 Slave device registration

T B e e o el T

0% |
2| .
o= Communcation Cycie Time | Message Timer  [Slave Station Function-
= B8 New Proec General | e sy (Cutput) | WD Assigament (nput)
o Davicallat I _ A
% Natwork1_ Unt_t{DaviosNat): Network(| I uw
[ Frodust Neme |.0ut Size | In Size |
E_ ¥ | R
o - ‘Regstered Device
“ 3 Frod | Out Siza I i
knmtl{-cmw J £ Sy (@0 E-1010 1 Dyte 32000 1 Brte  3MO0. .
= ®| Onine USB [CJZM-CPU11] Natwork (). Nods (D)
Bl 5 Taipot ISR [CI2ALCPLI 1] Naturark (D), Nods .:ru
" 3% CPU Part Netwark (-}, Hode (-], Unit () -
2% Ethernet Network {-), Mode (2), Uni: (2] B
3% Devioehet Network (-}, Made (1}, Unit{1) i mmm"‘liﬂl St i w
Uplcad 1} [oowricsa 0] | comesre (
nﬁ- L
_Gonim_| _ Cane |

Waming: Two: or more Communication units are sel. Please
setthe Router List o the targat PLC.

Figure 5-3-12 Download configuration
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5.4 Connection and configuration between Codesys and EX-1130

5.5 Connection between EX-1040 and PLC

5.5.1 Connection and Configuration between GX-WORKS2 and EX-1040

1. Communication connection diagram, as shown in Figure 5-5-1.

Programming computer

PLC

GX-Works2
CCLink
Adapter
EX-2008 | EX-3008
EX-1040

Figure 5-5-1 Communication connection diagram

Note: Add terminal resistors (110 ®) to the two terminals in the network, as shown in Figure 5-5-2 below.

CC-Llnk CC-Link CC-lnk CC-link
Master station Slave station#1 Slave station#2 Slave station#n
e | ] [’.{‘ ’ " ‘
5| termination [ termination [ .
21 resistor DB resistor | |2

Figure 5-5-2 Terminal resistance cable connection
2. Table 5-5-1 shows the hardware configuration

Table 5-5-1 Hardware configuration table

Hardware Quantity Note
Computer programming 1 Install the GX Works?2. -
PLC 1 Supports CC-link
EX-1040 1 CC - Link adapters
EX.2008 | Digital quantity input
module
EX-3008 1 Digital output module
CC - Link c.ommunlcatlon A number of
lines
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3. New project and communication parameter configuration

Open gX-WorkS2 software, select the actual site CPU model, and then choose Parameter >
Network Parameter > CC-Link in the left navigation bar of the project. In the CC-Link parameter
setting window, set the PARAMETERS of CC-Link slave station, as shown in Figure 5-5-3. As
shown in Figure 5-5-4.

&ﬁl\l‘t}}f&u esslin.the-remateil0imodule -

Figure 5-5-4 CC-link parameter Settings

Configure slave information. On the CC-link parameter setting screen, select Station
Information to set parameters such as the station type, as shown in Figure 5-5-5.
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CC-Link Station Information Medulz 1 X
_if1 | Remote I.fO S‘laimn = | 1X Setfing - 32 spot. 'iféosehingv = === I - =
Mo setting. Mo zeting.
Remoie 10 Stabon
Remaote Deviee Station | Cocupy 2 s
Inteliigent Device Station | ity
e

Station type intelligent device station includes local station and standby master station.

Defautt | Check |  Setting Complete| Cancel |

Figure 5-5-5 Configuring slave parameters

For details on the slave station parameters, see 2.1.6 CC-Link Adapter. The setting rules of ex-1040 as
the remote device station are as follows:

The station information of THE CC-Link adapter EX-1040 in the Mitsubishi GX-Works software is
the remote device station, one station is 32 points, which can be set according to the specific 10 points
connected by the user after the EX-1040. The maximum number of logical stations can be set, and a single
logical station contains 32 points. A maximum of 4 x (32DI+32DO+4 ai +4 ao) can be connected.

The CC-Link remote 10 adapter supports two logical station Settings, based on the first and last
five bits of baud rate dip. The first five digits of the DIP switch correspond to the layer 5 communication
rate, which is a fixed four logical stations. The number cannot be changed by default. When the dip switch
is set to the last five digits, the number of logical stations can be changed as required. The communication
rate of the first five digits remains the same. You can flexibly configure the logical stations as required. A
set of 16-point digital inputs and outputs is a logical station, and a set of 4-channel analog inputs is a
logical station.

For example, if the PLC is connected to five groups of EX-1040, and one group of EX-1040 is
connected to the other two groups of EX-200H, EX300H, EX-4414, and EX-5414, the communication rate
should be based on the master station. For details, see Table 5-5-6.

Table 5-5-6 communication parameter Settings

CC-link Dip switch corresponds to the station id

Fixed logic Dial the Dial the Dial the Dial the Dial the code:
Rate distance
station code: 0 code: 1 code: 2 code: 3 4
corresponding to
Variable logic Dial the Dial the Dial the Dial the Dial the code:
dip station number
station code: 5 code: 6 code: 7 code: 8 9
CC-link Communication rate and 156kbps 625kbps 2.5 Mbps SMbps 10Mbps
transmission distance 1200m 600m 200m 150m 100m
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Based on ex-200H, EX300H, EX-4414, and EX-5414, the I/O module has a set of 32-point I/O inputs
and outputs. One set of 4-channel analog inputs and the other set of 4-channel analog outputs. The
maximum number of logical stations is 1 logical station. Specifically, the number of the first group is 1,

the second group is 2, the third group is 3, and so on.
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5.6 Connection between EX-1030 and PLC

Figure 5-6-1 shows the process for restoring the Modbus RTU module to factory Settings and setting

parameters.

Power off
All Dials Set to 0

>

Restart Power
Waiting to Restore
Factory Settings

Power off
Configuration parameters

’ (address,
rate)

Y

Restart to take effect

Figure 5-6-1 Process for restoring factory Settings

Note: the module is restored to factory Settings, only the parameters set by the user are cleared, such as

watchdog activation, watchdog time, etc.

Module address The IP addresses of the input and output channels are related to the positions of modules.
The Modbus RTU function codes used by modules remain unchanged. Figure 5-6-2 shows an example.

EX-1030 EX-2008 EX-200H EX-3008 EX-300H EX-4014 EX-5014 EX-4654
( awme ) | (8DI) (16D1) (800) | (16D0) (4A1) (4A0) (47C)
Funcuon code Q02 Funcuon codeiQx 02 Function code Function code Function code ) (e ()4 Function code Function code (I}
Address '0-7  |adaress 8-23 | Ox01/05/0F | Ox01/05/0F | adaress :0-3 0x03/06/10 | Address: :4-7
Address  *-(]-7 Address  -8-73 Address  -()-3
EX-1030 EX-200H EX-2008 EX-300H EX-3008 EX-4014 EX-5014 EX-4654
(IEAC 28) (16Dl) (8DI) (16DO) (8DO) (4Al) (4A0) (4TC)
Adapter

'Y v v v v v

| Address

:0-15

Function code 0x02 Funumn code 10X02

Address '+ 16-23

Function code

0x01/05/0F
Address -0-15

Function code

0x01/05/0F
Address # 16-2 2

Functlon COdeFGXD‘q-
:0-3

Address

Function code

0x03/06/10

Address  +()-3

Funcuon

0x04
4.7

Address

Figure 5-6-2 Module address allocation

5.6.1 Connection and Configuration between Modbus Poll software and EX-1030

1. Communication connection diagram, as shown in Figure 5-6-3.

Communication parameters in the case: baud rate 9600bps, data bit 8, stop bit 1, no check;The slave

address is 1.
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Computer installation

Modbus
Poll

:*‘lodbus

Adap ter

EX-1030

EX-4014 | EX-5014

EX-2008 | EX-3008

Figure 5-6-3 Communication connection diagram

2. Table 5-6-1 shows the hardware configuration

Table 5-6-1 Hardware configuration table

hardware Quantity note

Computer programming 1 Install the Modbus Poll
EX-1030 1 Modbus RTU adapter
EX-2008 1 Digital quantity input module
EX-3008 1 Digital output module
EX-4014 1 Analog input module
EX-5014 1 Analog output module

USB to 485 serial port 1

3. Set the ex-1030 communication parameters as shown in Table 5-6-2

Table 5-6-2 Communications parameter Settings

The name of the

Set the value

note

The communications rate dip

Communication rate 9600bps Lo
switch is set to 5
Data bits 8 The default value
Parity bit There is no The default is
Stop bit 1 The default value
Address DIP switch x 1 Set
From the station address 1 this parameter to 1

Address DIP switch x 10 is
setto 0

4. Dip switch, as shown in Figure 5-6-4. Table 5-6-3 lists the dip switch parameters.
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Table 5-6-3 Dip switch parameters

Baud Rate

Dial setting
x10

o *Dial setting x1

Communicati

on rate setting

1

Figure 5-6-4 DIP switch

Communication rate

Dip switch value

Baud rate value

note

0 -

1 115200
2 57600
3 38400
4 19200
5 9600

6 4800

7 2400

8 1200

9

For the Modbus RTU address, calculate the formula (N1 x 1 DIP switch, n2 x 10 DIP switch) :

Address = N1 x 1+ N2 x 10.

5. Table 5-6-4 lists the Modbus RTU function codes supported by the EX-1030 adapter

Table 5-6-4 Modbus RTU function codes

Function function . .
Functional meaning note
code
Read . For example, the
0x01 Read digital output
EX-3XXX module
0x02 Read Read digital quantity For example, the ex-2XXX
X
input module
Read For example, the
0x03 Read analog output
EX-5XXX module
Read i For example, the
0x04 Read analog input
EX-4XXX module
0x05 Write Write a single numeric For example, the
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quantity EX-3XXX module
0x06 Write Write a single analog For example, the
quantity EX-5XXX module
0xOF Write Write multiple numeric For example, the
quantities EX-3XXX module
0x10 Write Write multiple analog For example, the
quantities EX-5XXX module

Modbus Poll configuration and communication

Create a File Read ex-4014 module channel, select "New" from "File" in the menu bar, right click the
blank channel, and choose "Read/ Write Definition", as shown in Figure 5-6-5.

J i jas I 00000

o

1 E Read/write Definition.. F8
2 a Cut Ctri+X
B ' 0 Copy Cri+C
: [ 0 Paste Ctri+V
; 0 Select All Ctri+A
; a Foreground Color Ctrl+F
? | a Background Coler Cir+B
E | a Font

9 o

Figure 5-6-5 Channel configuration

The configuration parameters read the ex-4014 module data, including the slave address, function
code, start address, and read address length (in the case of ex-1030, the address is set to 1), as shown in
Figure 5-6-6.

Read/Write Definition >
Slave ID:
Functior: | 04 Read Ingut Feqisters [3x] ol Cancel
Address: l:l

Appl
Guantity: i
Sean Fate: | 1000 s
Readwrite Enabled Readtadite Once
iew
Rows : .
Hide Aliaz Colurmns
®10 20 O50 O100 -
[ &ddress in Cel
Digplay: | Sig_nec_l ~ | [JPLC Addresses [Base 1)

Figure 5-6-6 Configuration parameters

New file Configuration parameters Read the data of the EX-5014 module, including the slave address,
function code, start address, and read address length (in the case of ex-1030, the address is set to 1), as
shown in Figure 5-6-7.
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S e bd T =I_I_

Read/Write Definition )L}
Slave D
Function; | 03 Fead Holding Registers [4x] ~ T Fancal
Address: l:l

Apply
Guantity:
San Fate: 1000 ms
BeadAwrite Enabled Headffie Brce
Wiew
Rows

[J Hide liaz Columnz
[ &ddress in Cell
Diizplay: Sig_ned w | []PLC Addresses [Baze 1)

@10 O2 OF10 O100

Figure 5-6-7 Configuration parameters

New file Configuration parameters Read the data of ex-2008 module, including the slave address,
function code, start address, and read address length (in the case of EX-1030, the address is set to 1), as

shown in Figure 5-6-8.

Read/Write Definition x
Slave D o]
Function; | 02 Fead Discrete Inputs [11] v_: Fancal
Address: l:l

Apply
Guantity:
Szan Fate: 1000 ms
BeadAwrite Enabled Headffie Brce
Wiew
Rows

[J Hide liaz Columnz
[ &ddress in Cell
Diizplay: Sig_ned w | []PLC Addresses [Baze 1)

@10 O2 OF10 O100

Figure 5-6-8 Configuration parameters

New file Configuration parameters Read the data of the EX-3008 module, including the slave address,
function code, start address, and read address length (in the case of ex-1030, the address is set to 1), as

shown in Figure 5-6-9.

Read/Write Definition x
SivelD:
Function; | 01 Fead CDHS [0] V.: T Fancal
Address: l:l

Apply
Guantity:
San Fate: 1000 ms
BeadAwrite Enabled Headffie Brce
Wiew
Rows : :
Hide Alias Col
@10 Ox Os1 O 10 [J Hide &lias Colurins
[ &ddress in Cell
Diizplay: Sig_ned w | []PLC Addresses [Baze 1)

Figure 5-6-9 Configuration parameters
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Create a file to write data to EX-5014. The parameters include the slave address, function code, start
address, and read address length (in the case of EX-1030, the address is set to 1), as shown in Figure
5-6-10.

s

Slave ID: T
Function: | 18%Wiite Multiple Registers | Cancel
Address: l:l

Apply
Guantity:
Sean Fate: | 1000
FRieadwiite: Enabled Featidite Droe

iew
Rows

[T Hide tilias Columns
@10 O Os0 Cion
[ &ddress in Cel

Diizplay: Sig_ned V._ [CIPLE Addresses [Base 1)

Figure 5-6-10 Configuration parameters

Create a file to write data to ex-2008. The parameters include the slave address, function code, start
address, and read address length (in the case of EX-1030, the address is set to 1), as shown in Figure
5-6-11.

Read/Write Definition >
Slave ID:
Function: | 15 %ite Multlple Cails ol T Cancel
Address: l:l

Appl
Guantity: i
Sean Fate: | 1000 s
Readwrite Enabled Read/adie Brce
iew
Rows : .
Hide Aliaz Colurmns
®10 20 O50 O100 -
[ &ddress in Cel
Diizplay: Sig_ned ~ | [JPLC Addresses [Base 1)

Figure 5-6-11 Setting parameters

Connect to ex-1030 through the USB-485 serial port module. Set parameters in the Modbus Poll
software. Select Connect from the menu bar to set communication parameters, as shown in Figure 5-6-12.
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Connection Setup *
Caonnectian

(®) Serial Port (O TCRARP
Cancel |
Part 2 w | Mode
@RTU  (Oasl

SE00 Baud
Rezponze Timeout

|8Databit= >~ 100 |[ms]

|Mone Party  ~ | Delay Between Palls

'.‘I Stop Bit 5| [rs] Advanced... .

Femote Server
IP &ddress Fart Connect Timeout

0.0.0:0 502 3000 [ms]

Figure 5-6-12 Communication parameter configuration

7. After the communication connection is completed, monitor the module status and write values to the
DO/AOQO channel.

5.6.2 Connection and Configuration between Codesys and EX-1030
1. Communication connection diagram, as shown in Figure 5-6-15.

Communication parameters in the case: baud rate 115200bps, data bit 8, stop bit 1, no check;The slave

address is 5.

Programming computer

Controller

Codesys SP16

#ﬁcdbus

Adapter

EX-200H | EX-300H | EX-4014 | EX-5014
EX-1030

Figure 5-6-15 Communication connection diagram
2. Table 5-6-5 shows the hardware configuration

Table 5-6-5 Hardware configuration table

hardware Quantity note
Computer programming 1 Install the Codesys SP16
The controller 1
EX-1030 1 Modbus RTU adapter
EX-2008 1 Digital quantity input module
EX-3008 1 Digital output module
EX-4014 1 Analog input module
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EX-5014

1 Analog output module

3. New project and equipment configuration

Open Codesys programming software and configure communication, as shown in Figure 5-6-16.
Double-click "Modbus COM" to configure communication port and communication parameters, as shown

in Figure 5-6-17. Configure the master station protocol and corresponding timeout parameters, as shown in
Figure 5-6-18. The address corresponding to the slave channel is shown in Figure 5-6-21.

= Lindiledl

= 8l PLC Logic
= ) Apphcation

[B] pLc_prc (PrE)

= [ Device (CODESYS SoftHation Win ¥3)

i) Lisrary Manager

= ﬁ Tasgk Configuration
= 8 ManTask (IEC Tasks)

&) pic rRe
=[] Modbus_COM (Modbus COM)
= [§] modbus_Master COM_Port (Madbus Master, COM Pert]
[ Modbus_Stave COM_Pert (Modbus Slave, COM Bort)
s SoftMotion Ganeral Asis Poal

Figure 5-6-16 Configuration communication

Device * & X 5 Modbus_COM X
= Untted i )
; . — -Bus jec: Serial Port Configuration
= [ Device (CODESYS SofMotsn Win V3) RS Sus e Bedl 9
=4 ogic s
@ pLe L Cenersl COM Port 3
= £} Apphication 4 Baud Rate 115200 ™
g E:T:Rri I\;:;ager | SerialPort Parameters Parity Check =
=1 ask Configuration i | |
B o Gt | Status Data Bit O |
- if Tasks) | i | |
& Mm T l Information Stop Bit i J
&) pc_prs |
] Modbus COM Madbus COM)
= () Modbus_Master COM_Part (Modbus Master, OO
) Modbus_Siave COM_Port Modbus Siave,
"% SoftMotion Genaral Aus Pool

Figure 5-6-17 Configuring ports and communication parameters

Délea = 8 X | Modbus_Master_COM_Part X
= G Liseedt d
= E Devce (CODESYS Saftsiabon Win V] General Modbue RTUMASEL "nnnus
= il FLC Logic SR Mode @ e ':"’S::'“’e
=8 trrhci Response Timeout (ms) 1000
i 1 erary Manage: | Machun Oeners Gt Mocker |EC Coiest s
B) pc_pac pec) | i Time batwean Framas (ms | 10
= @ Task Configuration | i Hlautomatic ommunicotan
S wacl - ) | Information
&) e mc
(5 Hod.s,COM Madbus COM)
= |5 modtus_Mesier_COM_Port (Mndts Master, COM Por )
] Modous_Siave_00M_Part (Modbus Save, COMAor()
& Softaten Generol A Fodl

Figure 5-6-18 Configuring the master protocol and related timeout parameters

= [ Device [CODESYS Sefthction vae V2
=l PLC Logic
= 0 Application
i Library Managar
(B 2emspeg)
= (& Tesk Configuration
= g Marmask fIEC Tasks)
) e pne
= [0 Modbus_COM (Meckes COM)
Modtus_Mastar 0N _Part (Mockus Master, COMPait)
{3 Modbus_save COM_Fort (Modbus Seve, COMPort]
Softhobon General Asis Foal
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Figure 5-6-19 Setting the slave address

@ Modbus_Slave_coM_port x

Generst Name  Access Type Intriguer Fead Offs=t Length Error Handling Wrie Offset Length | Note
= | ]
: « Slave Staticn Charnel 0 EX-200H Read Ducrete tnpute (Function Code 02)  Cydie, 5100ms 160000 & Keep last value
1 EX-300H \Write Multiple Colls (Function Code 15)  Cycle, t#100ms 1520000 kS
Modbus Stave Inéializafion I EN-901%  Read InputRegistersiFunclion Code 04) Gycle, t9100ms = 1620000 4 Keep last value
| 3 EX-5012  \rite Multiple Regaters(Function Code 16)Cycle, £#100ms 16E0000 4
Wiodlus Generic Serial Master 110 Magping
I Modhus Gensfic Serial Master IEC Ohject

Figure 5-6-20 Adding a slave channel

| 3 Modbus_Slave_con_rort x

I
[ General Find Filter Show All » o Agd FB fo 10 channel... . Turm o L
Modbus Slave Station Channe.l “Variable Mapping Channel Address Type Unit Crescription
= EX-200H %80 ARRAY [0..0] OF BYTE Read Disorete Inputs
Modbus Slave Inifialization Gk ] EX-200410] S4IB0 BYTE Read Discrete Inputs
' | = EX-300H 5080 ARRAY [0..0} OF SYTE Wirite Multiple Colls
Modous Genare Serlal Master HO Mapping &
+ "a EX-300H[0] 080 BYTE Wirite Multiple Cois
| .mmmaMlﬁcm || 5 % Ex-4014 *IW1 ARRAT [0..3} OF WORD Read Input Regsters
%= % Ex-4014{0] %HIW1 WORD 00000
Status + g EX-40141] SLIW2 WORD 030001
. 5y Ex-4014[7] HIW3 WORD 030002
Gt atigrs . ] Ex-901413] wIvG WORD G003
| ="y EX-5014 /W1 ARRAY [0..3] OF WORD Wirite Multiple Regters
i ] EX-50240] %MWL WORD 00000
+ "y Ex-5014[1] wowz WORD 00T
& EX-5014(2] %Wz WORD 00002
=" EX-5014{3] %O WORD 00003

Figure 5-6-21 Address corresponding to the slave channel

The program was programmed to define four variables and associate them with the actual physical
address, as shown in Figure 5-6-22.

(5] PLc_PRG x|

PROGRAM PLC PRG

VAR

- EX_200H:BYTE;

4 EK_BUDH:BYTE:=E5E;

S EX_4014_1:WORD;
EX_5014 1:WORD:=2000;
7 END_VAR

= |

R s

i EX 200H:=%IB0(; /read the first & input channel vajues of ex-200h module

: %QEG i=FEX 300H; /write values fo the firet 8 output channets of ex-300h module
EX 4014 I =% TW1 ; fread the value of the first input channel of ex-4014 module
%Qﬁ] g =EE_5{}1 4_1; lwrite value to the first output channel of ex-5014 module

Lt 3

Figure 5-6-22 Programming
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5.6.3 Connection and Configuration between TIA Portal and EX-1030.
1. Communication connection diagram, as shown in Figure 5-6-23.

Communication parameters in the case: baud rate 115200bps, data bit 8, stop bit 1, no check;The slave

address is 5.

Programming computer

CM1241| 57-1200 TIA Portal V16

M odbus

Adapter
EX-1030

EX-200H | EX-300H | EX-4014 | EX-5014

Figure 5-6-23 Communication connection diagram
2. Table 5-6-7 shows the hardware configuration

Table 5-6-7 Hardware configuration table

hardware Quantity note
Computer programming 1 Install the Codesys SP16
PLC 1 S7-1212C
Communication module 1 CM1241
EX-1030 1 Modbus RTU adapter
EX-2008 1 Digital quantity input module
EX-3008 1 Digital output module
EX-4014 1 Analog input module
EX-5014 1 Analog output module

3. New project and equipment configuration

Open the TIA Portal V16 programming software and configure the hardware, as shown in Figure
5-6-24. In the network view, double-click the CPU to enter the properties, select "System and Clock
Memory", and select "Enable System Memory Bytes" and "Enable Clock Memory Bytes", as shown in
Figure 5-6-25. Configure the CM 1241 interface parameters. Double-click CM 1241 to enter the properties
and select "Port Configuration" to set communication parameters, as shown in Figure 5-6-26.
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Rack_0

s m

5

T

Hl<]

[7] 100 =

Figure 5-6-24 Configuration hardware

[\ Regular |0 Variables|System Constant [Text |

» Reguiar ~|
» PROFINET Interface System and Clock Memory g
» DIBDQ 6 System Memory Bit

P A2

» High Speed Counter (HSC) |

» Pulse Generator {PTO/PWM) Aaress of System Memary Syles () |
Startup —

Cycle First Cycle: |
Communication Lagd

] Enakls System Memary Bytes
]

Systern and Clo 1 mory )
« Web Server

Always 1 {High Level

Diagnostic Status Altered: | %Mi.1 (DiagStansipdate)

:r Always 0 (Low Level): | %M1.3 (AlwaysFALSE)
Regular d
Auvtomatic Update -- i =
¥ Uszer Defined Page Clock Memory Bit
Time
Protect W Enable Clock Memory Bytes
Connect Resources AOdESS 0 GIook Memory Byles (MBX): | 0 |

Address Overview

10Hz Clock: [ %400 (clock_10Hz)
SHz Clock: | %M0.1 (clock,_SHz)
2.5Hz Clock: | %M0.2 (Ch ck.,z SHz)

> T
mes oAbl lmaanm et 4 mad s L

Figure 5-6-25 Enabling system storage and clock storage

| EiProperty| i, Informatian Iguaj’wn l

| Reguiar (o variabies Bystem Gonstan| Terl |

* Reguiar %) Nare
~ RS4220485 Intertace 7 Disviation from RiB) > RiA)
Regular
Portc Open Circuit
Corfiguration Detery Message
PCenfiguration Raceived Massags Ne Open Civcuit Chsck
Cromble Chaen
q Rate [o5hbos 1=}
I Parity Chack: | =1
: Deta Bit |2 bitcharactor =l
Stop Bt |

Figure 5-6-26 Setting communication parameters

Add the function block "MB MASTER" of Modbus RTU master station to OB1, and write the polling
program. The bit count value of program segment 1 is automatically increased by 1, and program segment
2 is the value of reading the 8 channels of EX-2008, as shown in Figure 5-6-27.Program section 3 is to
write the values of the 8 channels of EX-3008, and program section 4 is to read the values of the first
channel of EX-4014, as shown in Figure 5-6-28.The program section 5 is the value written to the first

channel value of EX-5014, as shown in Figure 5-6-29.
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¥ Module Title:
INote

“Mein Pregram Sweep (Cycle)

*  Program Fragment 1

Mote
M0 .0 ADD
*Chock_10Hz" Auto (Uint)
{7} EN ENO
b w2 Wz
g1 “Count Value" — jni Ut — “Count Value”
e
w2
*Ciount Value” MOVE
| = |
Juim | - EN END ——
a C—1N AW 2

#0UTE — “Count Y alue”

=  Program Fragment 2; Read & channe| values of EX-2008

TaB102
"EX-2008" — DATA_PTR

MNote
e
“MB_MASTER_DB®
MB_MASTER
EM END ——————————————
DOME =t 515 ¢
w2
*Count Value"

== | R
word [ - REQ STATUS

1 5~ MB_ADDR

9 —— MODE
10001 —— DATA_ADDR
& DATALEN

Figure 5-6-27 Program segment 1 and program segment 2

Email:contact@welllinkio.com

145



EX Series Card 1/0 DELUYY ELL

*  Program Fragment 3: Read 8 channel values of EX-3008

Mote
%O81
*MB_MASTER_ DB
MB_MASTER
EN EnNg ———
DONE =t f2li2
g B BUSY — e
*Count YValue” :
1 ERROR =70 152
w;-rd] REQ STATUS — oWl
3 5 — MB_ADDR
MODE
DATA_ADDR
&~ DATA_LEN
WAB100
"EXN-3008" — DATA_PTR

*  Program Fragment 4: Read the first channel values of EX-4014

MNote

%081
“MB_MASTER DB
MB_MASTER
EM ENg ————————i
DONE —4 7522
Az BUSY —1 70
“Count Value® ERBOR —i 1152
I“::"f I — REQ STATIS — 167D
3 5 — MB_ADDR
0 — MODE
30001 — DATA_ADDR
DATA_LEN
AW 18
TEN-

4014 First Channel Value — paa P

Figure 5-6-28 Program segment 3 and program segment 4

w  Program Fragment 5; Read the first channel values of EX-5014

Mote

e
“MB_MASTER_DB"
MB_MASTER
EN Eng —mt
DOME —tialse
w2 BUSY =—izlie
“Count Valus" ERROR —t 25t
== | — 16E
Word | p REQ STATUS bl
i 5 — MB_ADDR
! MODE
[ — DATA_ADDR
| — DATA_LEN
W20
“EX-

5014 First Channel Value — pats_pm

FIG. 5-6-29 Program section 5
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Add an organization block OB100 to the program block, add a Modbus RTU configuration port
function block to the program block, and configure the function block pins, as shown in Figure 5-6-30.

* ] Modbus RTU Communication Program A
e I L U e o —

I Add Mew Davica
#h Dovics and Metwark
= [ PLC.1 [CPU1212C DODCDC]
¥ Device Carfigurston
% Online and Diagnosis
~ g Progam Biock
I Add New Biock

&/ Moir [0B1]
E o 4 Starip [CBI0D]
* o Sysiem Slook

» L4 Tachnology Daject
¥ gl Exvternal Sureas Fie
~ (4 PLC Varishle
4 Display Al Variable
B A03 Mew Varabe Table
5 Default Varisble Tabie 41]
» [§FLC Data Tyoe
» [ Menhor and Esforcement Table
+ [ig orline Bachup
+ (i Device Agent Dats
* Frogram nfonmation
B PLC Alarm Test List
*» [ Local Moduls
b b Lingroupsd Deviess
b 55 Securty Sating

4. Program download and monitoring

~ Biock Tite: &
MNote

~  Program Fragment 1:

Mote:

LR
“FrstScan” — g

EN

ot
"MB_AAETER_DE®

DR
“ME_CORN_
LoaD PR
ME_COMM_LOAD
END
i N
ERROR —4 /<2
STATLS

» | Favoritea
» | Basic Insiraction
» | Extended Inatruction
2 | Technology
~ | Communicanon
Mame Leazrption Version
» | &7 Communication iz
» || Open User Communization ¥31
» [ WEB Server Vi1
w [ | Ohers
» [ MODBYS TCP ¥
» [ MODB US TCP Redungancy iz
"_ C i Processor
» [ AP Commuricativn oz
v | USS Communication k43
v T mopaus (RrU ) 2
+ [ Pairt to Paint vio
» [use Wi
| MODELS r]
BB COMILDAD  on P madkss fer Mad. 421 [
W WE_MASTER UsePPportas M. W22
o MB_SLAVE Use PP portas M... N21
» [ GPRSComm : CP1Z4, Vi3
» | Remole Sewvices LK)

Figure 5-6-30 Adding OB100 tissue block

Add a new monitoring list and add the variables that you want to monitor, as shown in Figure

5-6-31.Compile and download the program into PLC, and monitor the variables in the program, as shown

in Figure 5-6-32.

Sk

=

=

Li¥]

Bu LRI

* | ] Modbus RTU Communicstion Prograrfia . h
‘ Add Mew Device
ﬂ; Device and Network
- [ PC 1IcPruIzizCDODC. @
Y Device Configuration
% OnEne and Diagnosis
) };Fwam Biock
¥ '_'* echnology Object e
¥ @ External Sourse File

» [dPLc
» [RPL

P e

Variable

C Data Type

{5 Manitor and Enforcemient Table
B ~dd New Monitor Table

il Monitor Table 1

il Enforcement Table

& &P 2 A BT =
E Mame Address
"EX-2006" %ME 102
"EX-3008" fia]] %mE 100

"EX-4014 First Channel™ %A1 18

"EX-5014 First Chamnel

Bl 20

Dispiay Format
Lnsigned Decimal
Linsigned De::-im_ﬁ:
Unsigned Degimal
Unsigned Decimal

Figure 5-6-31 Adding variables to be monitored

[T

(N ]

@

é«lame
"EX-2008"
“EX-3008"

Address
SBNE 102

fiaf} snm100
“EX-4014 First Channel"
“EX-8014 First Channel"

®VTS
WhAN1 20
=Nawly Addeds

Display Format Manitor Value

Madify Vaise

Ursigned Degmal 1
Unsignea Decmal [ 255

Unisignad Decimal
Ungigned Decimal

1613
1620

Figure 5-6-32 Monitoring variable values
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5.7 Connection between EX-1120 and PLC
5.7.1 Connection and Configuration between Machine Expert and EX-1120
Note:

(1) The IP address segment is 192.168.0.X by default. You can use the IP Setting Tool to change the network segment
and set the IP address of the adapter dip switch.

@ On the right of ex-1120, input and output bytes for communication between 10 module and EtherNet/IP are

configured

If the ex-1120 has only input or output modules on the right, the output (O-->T) byte length is set to 1Byte or
the input (T- >0) byte length is set to 1Byte. If neither I/O module is available, the input (T- >O) byte length and
output (O- >T) byte length are set to 1Byte.

3 Ex-1120 adapter includes two TYPES of PLC mode: normal PLC mode and special PLC mode.Special PLC
refers to keens PLC, ordinary PLC refers to the other manufacturers except keens PLC, factory default PLC category

mode for ordinary PLC.

The hardware Input (T- >0) Output (O- >T)
configuration bytes bytes
EX-1120 1 1
EX-1120 5 |

EX-200H
EX-1120

1 2
EX-300H
EX-1120
EX-200H 2 o)
EX-300H

1. Communication connection diagram, as shown in Figure 5-7-1

Programming computer

M241 Machine Expert
V2.0
Ethortetip 2>
Adapter
EX-200H | EX-300H | EX-4014 | EX-5014

EX-1120

Figure 5-7-1 Communication connection diagram

2. Table 5-7-1 shows the hardware configuration
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Table 5-7-1 Hardware configuration table

hardware Quantity note

Computer programming 1 Install Machine Expert V2.0

PLC 1 M241

EX-1120 1 EtherNet/IP adapter
EX-200H 1 Digital quantity input module
EX-300H 1 Digital output module
EX-4014 1 Analog input module
EX-5014 1 Analog output module

3. Set the IP address

In this example, the IP address of schneider M241 PLC is 192.168.1.39, and the default network
segment of ex-1120 adapter is 192.168.0.x.

(D Use software IP Setting Tool to modify the network segment to be consistent with PLC;
@ Set the IP address to 192.168.1.33 through the DIP switch on the adapter.
4. Install the EDS file

On the menu bar, choose Tools > Device Repository. In the device repository window, choose Install,
as shown in Figure 5-7-2. In the EDS folder, choose General Version > EX-1120_V1.1 and confirm the
installation.

& Dewvice Memory Library

Location (L) L W Edlit Location (E)...
{C:ProgramData EcoStruoure Machine ExpertiVZ. 0WUser Devices)

Blescrption of Installed Deviee (v}

:l;C-haracier String for Full-text Search 1 Suppiler | Schnsder Electric

£

Mame Supplier  Version Description d Unanstali{U)

* -d Altrvar Experi(E)::
+ (@ Bus Coupler
& [ rsrmony Install OTM. .
*: _j Lexium
+ _-’ TeSys Wemm
E _,_" TME All-in-Cne VO Moduls i
+ 1_{" TS Commaon Power Distribution Medule
# [ TME Transmitter-Recenver Moduiz
+ [ T™mE Dummy Module
X .'3 TME Digital Quartify V'C Module Ditais (D).,
o .':I TMES Anzlog Quantity 1O Module
+ 1) TMS Fieldbus interface Module G |
e
Closs

Figure 5-7-2 Installing the EDS file
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5. New project and equipment configuration

Start Machine Expert V2.0, create a project, right-click "EtherNET 1" in the device tree, and choose
"Add Device", as shown in Figure 5-7-3.

Choose Protocol Manager > Industrial Ethernet Manager in the Add Device window, as shown in
Figure 5-7-4. Right-click "_(Industrial Ethernet Manager)" > Add Device in the device window. Select
DECOWELL AUTOMATION CO.,LTD for the supplier and ex-1120 in the equipment catalog, as shown
in Figure 5-7-5.

8 o1 migital Inouts)
& 0o igital Dutputs)
I Counters (Counters)
L Pudse_Generators (Pulse Generators)
[ cartridge_1 (Cartridge)
% 10_8us (10 bus - TMI)
(] com_Bus (Com bus)
B chemet 1Eher] § Gut
= o m_ma_}{ima:aa Copy
@ Madhine_Expes # Paste et

= 157 Serial Line_2 (Serid % Delete

Disabled Device

Figure 5-7-3 Adding devices
Iﬂ:‘:i-'la.faater-é:t;mg for;-':I-L-tEHE_eaa‘n_h Supplier | Schneder Elacknic b
Mame Supplier Version Description

= 33 Protocol Manager

7 [inausivs Protoon Managed Scheeider Slecte 10,1235 Industral networks can be managed
+ [ Fieldbus

| < |

E Group by Classification [ [Display All Wersions {experts only) [ | Display Expired Versiens

Figure 5-7-4 Adding an industrial Ethernet manager
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& Add Davice x

Name |B(_1120
Action
(@addtional Device ()insert Dewice 1) Fiug out Device (PHUpdate Device (U)

iE*aful&r Sirimg for Fuli-teat Search o Suppler: 'mmﬂm 00 LTD: Lo

Nams Suppler Wersion
= [ eterrest/ie targets
= (@ Other

E ET-OS00 -0t DECOWELL ALTOMATION C0, LTD. Major Revision =161, Minor Ry
ﬂ ET-0S00- thl DECCAWELL AUTOMATION CO. LTD. Major Revision= 1521, Minor luf'
(H Ersso0cony DECOWELL AUTOMATIONCO.ATD.  Major Révision=15%1, Mnor Re
( eeso0-Cit DECOWELL AUTOMATIONCO.LTD.,  Major Revidon=1621, Mnor Ry
() Er-ss00-c2ve DECOWELL AUTOMATION CO, LTD,  Major Revislon= 161, Mmrag
(H B+m00-coMN DECOWELL AUTOMATIONCO.LTD.  Major Revision= 1621, Minor Ry
.E EL-HH00-C 1NN DECOWELL ALTOMATION CO. LTE. Major Revison= 1621, Mnor R
Lﬂ EI-S00:0-ChiNd DECOWELL ALFTOMATION CO. LT, Major Revidon=1621, Minar Re

(2

¥ 1120 | DECOWELL ALTOMATION CO.ATD. | Major Revision=1621, Minor Re
=]

éﬁ‘mm: by Classification [ Display Al vm;[expeﬁs only} [ ] Display Expired Versions.

¥ Hamepenm -
Supplier: DECOWELL AUTOMATION CO.LTD.
Group: Other
Version: Magr Revision=1621, Minor Revision = 1621
Module Mumbers: EX-1120 "

Figure 5-7-5 Adding ex-1120

To configure ex-1120 parameters, double-click EX-1120 in the device tree, and set the IP address to a
fixed IP address, as shown in Figure 5-7-6.

¥ EX_1120 x
= 3§ 20211211-EiP Communization Dema Taei Connect Paameters B poele V0 - = Eetlet® 120 ctans @ infom
- MyControler (TM241CECITAN Address Setting (Configure DHCP Server)
= Bl PLC Logic r

" n O DHCP Asslgn IP Address %1

(8 o1 oigital tnputs) () BOOTP Assign 1P Adoress | - 0 - 00 - 00 100 - 00

&% 0Q (Digital Outputs) e (®) Fived IF Addréss 192 . 1 . 33

! Counters (Counters) - ;

L Pulee_Generators (Pulse Generators) Elsctroniz Keying

g::m;ﬁn‘r::) [ Check Device Type |12 |

[ ‘com_Bus (CoMbus) b EheRt ot Ir£
= B Ethernet_1 (Ethemet Network) £ Check Produst Code [1s
= 33 _ {Industrial Ethemnet Manager) [[] check Major Revision 1
'lilne_l_mu!x-mb; [] Check Secondary Revision ¥
Serigl Line_1 (Serial line}
@ Macine Expert tietwork Manager (Mahing| | Festos Deraulls
= ¥ Sarial Line_2 (Serial line)
) Modbus_Mariager (Modbes Manager) Fleibus Protacol
[ can_i (CAMapen bus) Devics Profosal Ethernatle

This 15 the protocs! used Detween the ioglc controiler and the device.

Figure 5-7-6 Configuring an IP address

Number of bytes occupied by computing modules:
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Table 5-7-2 Number of bytes occupied by modules

The module Quantity Input/output type Occupied bytes
type
EX-2xx8 1 Input (T- >0) 1
EX-2xxH 1 Input (T- >0) 2
EX-2xxS 1 Input (T- >0) 4
EX-3xx8 1 Output (O- >T) 1
EX-3xxH 1 Output (O- >T) 2
EX-3xxS 1 Output (O- >T) 4
EX-4xx4 1 Input (T- >0) 8
EX-4xx8 1 Input (T- >0) 16
EX-5xx4 1 Output (O- >T) 8
EX-5xx8 1 Output (O- >T) 16

To configure connection parameters, double-click the default connection parameters, and set the
output bytes (O- >T) to 10 bytes and the input bytes (T- >O) to 10 bytes in the edit connection window, as
shown in Figure 5-7-7. View the 10 address mapping, as shown in Figure 5-7-8.

T _ i user EtnerNet'it KU EtherNet/|P IEC
S:’l’ﬁtg Connzet parzmeters. = fiaggng ‘Oiju states  @information
.CD_n"EC“O!" Connaction Mame RP1 O-->T (ms) RPI T--=0 (ms) 0-->T &b pytes) T--20 &b (bytes] Configi1 Size (byte) Config#2 Size (bytes)
257 Monitor Diata And Control Dats 10 10 0 10 2
Edil Connection x

General Parameizrs
Connection Name Monitor Data And Contiol Data
Timeout Multiphier 3

Scanner to Target (Output) Target to Scanner (Input)

- Size (bytes) o |o T-->0 Size (bytes) [10
10 3 RPI ms) 1

RP1 {ms) w
Trigger Type Cyd:a =| Trigger Type Cycle
Suppression Time (ms) : Suppression Time (ms)  ©
Fault Preset Mode ‘Transter b Zarn <Defaults
Add connections Display All Farameters == Confirm Cancel

Figure 5-7-7 Configuring the input/output byte size

User w= EtherNetlP VO EtherMet/|? |EC 4 g
= Objact Status . i Information

Filter Show Al

Mapping Channel
Input Monitor Data And Confrol Data
Irpust Moritor Data And Canvirol Dataf0]
Irput Monitor Data And Control Data[1]
Irgust Moritor Data And Control Data[2]
Irpuit Monitor Data And Contrel Data[3]
Inpust Monitor Data And Control Datal4]
Output Monitor Data And Control Data
Output Monitor Data And Controd Datald]
Cutput Monitor Data And Control Datal1]
Dutput Monitor Data And Controf DatalZ]
Cutput Monitor Data And Control Datal3]
Output Monitor Data And Control Datal4]
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Adldress Type Default Walue Unit Description
SLIW7 ARRAY [0..4] OF WORD

SalWr WORD

%3 WORD

(IS WORD

TN 10 WORD

LWL WORD

oW ARRAY [0,.4) OF WORD

oW WORD

BROW3 WORD

%OW4 VIORD

QWS WORD:

HOWE WORD
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Figure 5-7-8 10 address mapping
The physical address assignment corresponding to the actual module in the case:

Note: In actual hardware, the number of I/O modules configured for the EX-1120 adapter is the same as
that of the model, but the sequence of the MODULES is different, and the physical address assignment
for the modules is different, as shown in Figure 5-7-9 and 5-7-10.

Adapter

EX-200H | EX-300H | EX-4014 | EX-5014
EX-1120

W7 Qw2 IWa Qw3

W9 aws4
W10 aws
W11l awe

Figure 5-7-9 1/0 sorting and address assignment #1(application in case)

Adapter
EX-1120

EX-4014 | EX-5014 | EX-200H | EX-300H

W7 awz w1l aws

W8 aws
(] aw4
IW10 aws

Figure 5-7-10 I/O sorting and address assignment #2

In EtherNet/IP I/O mapping, always update variable is selected as "Enable 2 (always in bus cycle
task)", and the program is downloaded into PLC, and the PLC running status and I/O mapping address are
monitored, as shown in Figure 5-7-11.

LT S < § K [ W P 1120 %
= [} 20211211-E)P Communication Demo B E:ﬁﬁ; Dol e ERNCIP VS oy EReNelPIEC  Sgis. @) inormaton B
= I MyControter [Connectes] (TNE41GEC24TI) || Fing Fitter Show Al + o Add FBto 10 channer’’ E“fﬂ',‘""gl'g-"'“‘?
- BPLE Logic et
+ ) Apphcation [0 gl | Warable Mapping  Channs| Auddress Typ= Default Valus Current Valu=
B o1 (igital Trputs) == Input Monitor Data And Cortrol Data WW7 ARRAY [0.,4] OF WORD
4 00 (mgital Outputs) » Input Monitor Data And Cortrol Data[d] W7 WORD a
LI Counters (Counters) b Input Monitor Data And Control Data{1] IWE WORD 1
L Pulse_Gensrators (Pulse Gererators) > Input Monitor Data And Control Data[Z] WIWg WORD 1
8 Cartridoe_1 (Cartridge) k. Input Monitor Data And Control Datal3] IW10 WORD 1
B 10_5us (0 -THE) g " Input Monitor Data And Cortrol Data{+] HlW11 WORD 1
@ com_fus (oM bus) =" , Output Moritor Data And Centrol Data %QW2 ARRAY [0..4] OF WORD
- = Ethernet_1 Ethernet Network) 'ﬁ Dutgaust Monitor Data and Centrol Datald] w2 WORD o
= & _(industrial Ethernst Manager) e Output Monitor Data And Control Datal1]  %QW3  WORD 0
¥ B 120 (Ex-1120) 'v Output Monitor Data And Centrol Datalz]  %QwW4 WORD 0
= &7 Serial Line_1 {Serial Ine} " Output Montor Data And Control Data[3] QWS WORD 0
._.’ Maching_Expart_Networe_Manager (Maching L Oulgmst Maritor Data And Centrol Data[4] QWG WORD o
= 4@ Serial Line 2 (Serial ine)
i Modbus_Manager (Modbus Manager)
(8 can_1 (camopen bus)

Figure 5-7-11 Program download and monitoring

5.7.2 Connection and Configuration between CODESYS and EX-1120

Note:
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(1) The IP address segment is 192.168.0.X by default. You can use the IP Setting Tool to change the network segment
and set the IP address of the adapter dip switch.

@ On the right of ex-1120, input and output bytes for communication between 10 module and EtherNet/IP are

configured

If the ex-1120 has only input or output modules on the right, the output (O-->T) byte length is set to 1Byte or
the input (T- >O) byte length is set to 1Byte. If neither I/O module is available, the input (T- >O) byte length and
output (O- >T) byte length are set to 1Byte.

(® Ex-1120 adapter includes two TYPES of PLC mode: normal PLC mode and special PLC mode.Special PLC
refers to keens PLC, ordinary PLC refers to the other manufacturers except keens PLC, factory default PLC category

mode for ordinary PLC.

The hardware Input (T- >O) Output (O- >T)
configuration bytes bytes
EX-1120 1 1
EX-1120 5 |

EX-200H
EX-1120

1 2
EX-300H
EX-1120
EX-200H 2 2
EX-300H

1. Communication connection diagram, as shown in Figure 5-7-12

Programming
Controller

CODESYS SP16
Ethertetp>>
Adapte
EX-200H | EX-300H | EX-4014 | EX-5014
EX-1120

Figure 5-7-12 Communication connection diagram
2. Table 5-7-3 shows the hardware configuration

Table 5-7-3 Hardware configuration table
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hardware Quantity note

Computer programming 1 Install the CODESYS SP16

The controller 1

EX-1120 1 EtherNet/IP adapter
EX-200H 1 Digital quantity input module
EX-300H 1 Digital output module
EX-4014 1 Analog input module
EX-5014 1 Analog output module

3. Set the IP address

In this case, the IP address of the CODESY'S controller is 192.168.1.198, and the default network
segment of the ex-1120 adapter is 192.168.0.x.

(D Use software IP Setting Tool to modify the network segment to be consistent with PLC;
@ Set the IP address to 192.168.1.33 through the DIP switch on the adapter.
4. Install the EDS file

On the menu bar, choose Tools > Device Repository. In the device repository window, choose Install,
as shown in Figure 5-7-13. In the EDS folder, choose General Version > EX-1120 V1.1 and confirm the
installation.

& Device Memory Library

Location (L) [ System Repository =~ Sl Loedton [E)...
(C:\ProgramData\CODESYS\Devices)

Description of Instalied Device (v}

cter Siing for Fui-text Seach . Supplier: <All SUDpllerss Instal {I)....

Mama Supplier  Version Description Ukninstadl (L}

+ _J Diher Options

Export (E).
i 9 HMI Device
# [ ec
* @ SoftMotion Driver
* J Fieldbus
Batails {D)...
Close

Figure 5-7-13 Installing the EDS file
5. New project and equipment configuration

Open CODESYS SP16, create a project, right-click Device in the Device tree, and choose Add
Device. In the add Device window, choose Ethernet, as shown in Figure 5-7-14.
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Right-click Ethernet in the device tree and choose Add Device. In the add Device window, choose
Ethernet /IP Scanner, as shown in Figure 5-7-15.

i_(halacbel String for Fulktext Search | Supplier: = <All 5L|.p_p|ier§> e
| Hame Supplier Version Descn'p‘tion!
= [ Fieldbus [
- o CAMBuS.
¥ ik Ethercat
=i == Etheme it

+ — Ethernet [P Scanner
- B@ Ethernet Adapter

|ﬂ Ethernet 35 - Smart Software Soktons GmbH 3.5.16.0 EthernetL
+ E Modbus
* 5 profibus
|

[ Group by Category [_] Show All Versions (only for experts) [ Show the Qutdated Versions

Figure 5-7-14 Adding an Ethernet adapter

i[hamn:tEfStringf-:-rFull-thearch | Supplier: | =il Suppliers= e
Hame Supplier Version [:Ies:ri|:|'ci|:-nI
=[] Fieldbus

= == Ethernatif

- == Ethernet IP Scanner

() EtherNet/tP Scanner | 35 - Smart Software Soubons GrbH  3.5.16.0  Etherhie
* = Ethernet |P Local Ada pter
+ wn Modbus

+ =F Profinet 10

] Group by Category [ ] Show All Versions (only for experts) [ ]Show the Outdated Versions

Figure 5-7-15 Adding the EthernetIP scanner

To configure the network adapter, double-click Ethernet in the device tree and select the network
adapter to communicate with the Ethernet /IP slave, as shown in Figure 5-7-16.
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[ Ethemet x

General ]

Metwork interface |
Leg IP Address 192 . 168 . 0 . 1
Subnet Mask 755 . 255 . 255 , 0

Status

Default Gateway, o . o . o . o
El*hemﬁ?“mw Mapping Adapt Operating System Configuration
MNetwork Adapter

=0,
[ Name % cription P Address

Qu comm Atherss AR9SAx Wireless Wetwork Adapter 1927 IGE 5 16

. Ifﬂnﬂﬂrﬂm” Wizrozoft Wi-Fi Direot Virtwel Adipter 0.0.0.0

|Lecal Connection™ 1U1=r¢taft Wi=Fi Direct Virtuadl Adapter 82 0.0 0.0

1P Auddress [1g2. 1660 1 . 196
Subrnet Mask 255 285 . 55, 0 |
Default Gateway :1'92 I 1o 1
MAC Address 00 B0-4C-36 05 F2

Q= -

Figure 5-7-16 Configuring the network adapter for the Ethernet adapter

Right-click EtherNet IP_Scanner in the device tree and choose Add Device. In the add device
window, select EX-1120, as shown in Figure 5-7-17.

i_Ch aracter String for Ful-text Search Suppiier <All Supﬁleq's:a- bl
Mame Su ppher Version ~ -|
= |4 Fialdbus
= &= Elfemetl®
= = Ethemet IF Remote Adapter
() ethertietp Adagter 35 - Smart Software Solutions GmbH Major Reve
¥ eum DECOWELL AUTOMATION O, ATD. Major Reve
() Generic EtherNet/IP device 35 - Smart Software Solubons GmbH  3.5.16.0
L= LMOO53_Ganenic Schneider Elactric Major Reve
Jm TM241_Generic Schneider Blectric Major Revi
s B TMIST Fareric Grbwaiddar Flartrie M.-.wﬂa;-i“"

Group by Category [ Show All Versions fonly for experts) [ Show the Outdated Yersions

Figure 5-7-17 Adding the EX-1120 adapter

To configure the IP address of the EX-1120 adapter, double-click EX 1120 in the device tree, and
enter the IP address (the IP address must be the same as that of the actual module), as shown in Figure
5-7-18.
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¥ 81120 x
General Address Setting
: Connact IP Address 192 .46, 1 . B Ethen |et/":)
: Component

TJsir Parammoters Electronic Keying

] Compatibility check

Log
I B NGB U Mapping vendord  [4457 | [ Check Supplier Code
! : : Devicetype [12 | [EFCheck Device Type
! GtherNet/TP TEC Object Productcade (24 | [ACheck Product Code
. Status Major revision | 1 1 Check Major Revision
| Information Minor revision |_1 [ Check Secondary Revision

Figure 5-7-18 Configuring the IP address of the ex-1120 adapter
Number of bytes occupied by computing modules:

Table 5-7-4 Number of bytes occupied by modules

The module Quantity Input/output type Oceupied bytes
type
EX-2xx8 1 Input (T- >0) 1
EX-2xxH 1 Input (T- >0) 2
EX-2xxS 1 Input (T- >0) 4
EX-3xx8 1 Output (O- >T) 1
EX-3xxH 1 Output (O- >T) 2
EX-3xxS 1 Output (O- >T) 4
EX-4xx4 1 Input (T- >0) 8
EX-4xx8 1 Input (T- >0) 16
EX-5xx4 1 Output (O- >T) 8
EX-5xx8 1 Output (O- >T) 16

Set the input and output bytes of the I/O module of the EX-1120 adapter (you need to set the input
and output bytes based on the actual NUMBER of I/O modules to ensure normal communication), as
shown in Figure 5-7-19. Then view the I/O mapping of EtherNet/IP communication, as shown in Figure
5-7-20.
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¥ EX_1120 x
Generl - -
. | Comnection Name RPIms)  O--=TSize(byic) T—-=0 Size(byic) Lo Cufiamgin,. Timyet ConBuraion Stz (bte)
Connect n | 1. Manitor Data And Cantrol Data 10 =4 54 2
Component l '
Edil Connection |
Uscr Paramclers s |
General Parmmeters Confirm
Log Connection Path [20042456 2¢ 65 2c 64 = e
[ESEUE O Mg Trigger Type [Circular ] #Pi(ms) 10 o
EtherNet/IP IEC Object Transmission Type Propriciary Owner Tamcoud Multiplicaiion| 4 v
Status Scamner to Target (Output) Targel to Scanner (Input)
st 0->TSittyte) @} e 01 SimmDe
Agent Confguration Size [0 ]
Turget Configuration Size :_2
= I
| Connection Type|Point to Point Connection Type w
Connaction Priority | Scheduled ~ Connectionpricrity |Scheduled e
Fived Amount Varisble [Fixed ] Fired AmoantVariabke[Fixed ] |
Transler Format 32 Bit Operating/Tdle | Tramsfer Formal Pure Data i)
Forbidden Time (ms) - Farhidden Time fms} 9 : |
Heartbeat multiplier I B i"
Figure 5-7-19 Configuring the size of input and output bytes
¥ EX_1120 x| |
General Find Filter Show All - 4
[
Variable Mapping Channel Address Type Unit Description
Connect € pping yp P
=l Monitor Data And Contr...
Component + 4 Input Data %IV0 UINT
User P L ] Input Data %IW1 UINT
St aatere % Input Data %IW2 UINT
* N
Log » Input Data I3 UINT
i + % Input Data %IW4 UINT
EtherNet/IP 1/0O Mapping + "p OutputData  %:QWO UINT
> | *=%o OutputData  %QW1 UINT
EtherNet/IP 1EC Object -6 OutnutData | %QW2 St
Status + "9 Output Data QW3 UINT
+ "p OutputData  %QW4 UINT
Information

Figure 5-7-20 10 address mapping

The physical address assignment corresponding to the actual module in the case:

Note: In actual hardware, the number of I/0O modules configured for the EX-1120 adapter is the same as
that of the model, but the sequence of the MODULES is different, and the physical address assignment
for the modules is different, as shown in Figure 5-7-21 and 5-7-22.

Adapter
EX-200H | EX-300H | EX-4014 | EX-5014

EX-1120
IWo Qwo Wi awil
w2 awz
W3 aws
w4 Qw4

Email:contact@welllinkio.com

159



EX Series Card 1/0 DELUYY ELL

Figure 5-7-21 I/O sorting and address assignment #1(application in case)

Adapter
EX-1120

EX-4014 | EX-5014 | EX-200H | EX-300H

IWo awo W4 aw4

W1 awi
w2 awz
W3 aws

Figure 5-7-22 1/O sorting and address assignment #2

In EtherNet/IP I/O mapping, always update variable is selected as "Enable 2 (always in bus cycle
task)", and the program is downloaded into PLC, and the PLC running status and I/O mapping address are
monitored, as shown in Figure 5-7-23.

Device @ x| ¥ 20 x
= [} M2izreEw =y — — —
- 3 (3 Deie i cci B General Find Filter Show All 1
= Bl Toge Lconmat Variable Mapping Channel  Address  Type  Current Value
= [} Apphication |COperating| = [ Monitor Data And Contr...
) Libracy tanager Compotient + Y Tnpust Dsta I uNT D
E] AC_PRG (PRG) L Input Data “lw1 Ut
= @8 Task Configuration User Parameters + iy Input Data W2 umNT 1
& ENPStanneOTask (EC Tasks) Log *» Input Data %IW3 N L
&) Ethertiet_P_Scanner. 10Cyde i % putDaks  %IW4 UM 1
25 BMIPScannerSenviceTask (IEC Tasks) I EtherNet/TP 110 Mapping £y OutputData  3:QWD umT 0
8] Etheiat_[P_Scanner.ServicaCyde || | = + %y OutputDats QW1 uNT 0
& MainTask (TEC-Tasks) EtherNet/IP [EC Object "» OutputDsts  %QW2 uMT 0
&) mc_prc | Siatus “» OutputData  %WQW3 uNT 0
) ethemet (Ethermat) » OutputData Qw4 umNr 0
[ Ethertiet 1P_Scanner (EtherNet/IP Scanner) Information
¥ Ex 1120 (BX-1120) [

Figure 5-7-23 Program download and monitoring
5.7.3 Connection and Configuration between Sysmac Studio and EX-1120
Note:

(1) The IP address segment is 192.168.0.X by default. You can use the IP Setting Tool to change the network segment
and set the IP address of the adapter dip switch.

@ On the right of ex-1120, input and output bytes for communication between 10 module and EtherNet/IP are

configured

If the ex-1120 has only input or output modules on the right, the output (O-->T) byte length is set to 1Byte or
the input (T- >O) byte length is set to 1Byte. If neither I/O module is available, the input (T- >O) byte length and
output (O- >T) byte length are set to 1Byte.

3 Ex-1120 adapter includes two TYPES of PLC mode: normal PLC mode and special PLC mode.Special PLC
refers to keens PLC, ordinary PLC refers to the other manufacturers except keens PLC, factory default PLC category
mode for ordinary PLC.

The hardware
) Input (T- >0) Output (O->T)
configuration
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bytes bytes
EX-1121 1 1
EX-1121
2 1
EX-200H
EX-1121
1 2
EX-300H
EX-1121
EX-200H 2 2
EX-300H
1. Communication connection diagram, as shown in Figure 5-7-24
Programming computer
NE1= Sysmac Studio
Ethortet1P>>
Adapter
EX-200H | EX-300H | EX-4014 | EX-5014
EX-1121

Figure 5-7-24 Communication connection diagram

2. Table 5-7-5 shows the hardware configuration

Table 5-7-5 Hardware configuration table

hardware Quantity note

Computer programming 1 Install the Sysmac Studio

NX1P2 1

EX-1120 1 EtherNet/IP adapter
EX-200H 1 Digital quantity input module
EX-300H 1 Digital output module
EX-4014 1 Analog input module
EX-5014 1 Analog output module

3. Set the IP address

In this case, the IP address of omron NX1P2 PLC is 192.168.1.39, and the default network segment of

ex-1120 adapter is 192.168.0.x.

(D Use software IP Setting Tool to modify the network segment to be consistent with PLC;

@ Set the IP address to 192.168.1.33 through the DIP switch on the adapter.
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4. New project and equipment configuration

Open the Sysmac Studio programming software creation project and configure the EtherNet/IP port as
a fixed IP address (the same as the ACTUAL PLC port IP address), as shown in Figure 5-7-25.

1 | s ' TiDR/MP Qatti o
TCR TCP/IP Setting

¥ [P Address

192168 1_.39_ )
255.255.255. 0 .

TP

Defiut Gotervay I

¥ DNS

DNS O Unusced @ Uscd

4 Data Track Setting

Figure 5-7-25 EtherNet/IP port Settings

Create all variables, and create input and output variables in global variables. The length of the
variables must be the same as the length of input and output bytes in the actual module, as shown in Figure
5-7-26.

Number of bytes occupied by computing modules:

Table 5-7-6 Number of bytes occupied by modules

The module Quantity Input/output type Oceupied bytes
type
EX-2xx8 1 Input (T- >0) 1
EX-2xxH 1 Input (T- >0) 2
EX-2xxS 1 Input (T- >0) 4
EX-3xx8 1 Output (O- >T) 1
EX-3xxH 1 Output (O- >T) 2
EX-3xxS 1 Output (O- >T) 4
EX-4xx4 1 Input (T- >0) 8
EX-4xx8 1 Input (T- >0) 16
EX-5xx4 1 Output (O- >T) 8
EX-5xx8 1 Output (O- >T) 16
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Mulli-view Browser

Data Type Initial Value
|ARRAY[0.9] OF byte |
|ARRAY[0.9] OF byte |

Figure 5-7-26 Creating global variables

On the menu bar, choose Tools > EtherNet/IP Connection Settings. In the EtherNet/IP list window,
double-click the node address to open the EtherNet/IP port connection Settings window, as shown in
Figure 5-7-27.

Deescription

Euilt-in Eff

0 / 256 A ered | T T Export

| Digital Choice |

Figure 5-7-27 Opening the built-in EtherNet/IP port Settings connection Settings window

Register variables. In the built-in EtherNet/IP port Settings connection Settings window, select "Label
Groups" window and click "Register All" to register the newly created global variables, as shown in Figure
5-7-28.
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Export

Type

i B "W Input Label

¥ Input ARRAY[0.9] OF byte
E ¥ Output Label
] Output ARRAY([0..9] OF byte

"All Retumn fo Dty

Figure 5-7-28 Registered variables

Install the EDS file, right-click in the blank area of the toolbox on the right of the connection setting
window, and choose Show EDS Library, as shown in Figure 5-7-29.In the EDS library window, click
Install to open the EDS file to be installed, as shown in Figure 5-7-30.

Figure 5-7-29 shows the EDS library
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EDS library _ D

i3 OMRON Corporation
i1 Omron Adept Technologies, Inc.
B Omron Microscan Systems, Inc.

Install

R

Figure 5-7-30 Installing the EDS file

To add devices to communicate with and set parameters, select "Add Target Device" in the toolbox, as
shown in Figure 5-7-31. Enter the EtherNet/IP slave IP address, slave model, and revised version, and
click "Add" in the lower left corner of the motor.

Tool Box ~ ¥ Tool Box

Figure 5-7-31 Adding a target device

Drag the target device 192.168.1.33 EX-1120 version 1 from the toolbox to the connection, as shown
in Figure 5-7-32.

Set the target device parameters. The input target variable of ex-1120 is 100, the output target variable
is 101, the input and output bytes are 10, and the start variable is the global variable registered, as shown
in Figure 5-7-33.

Switch PLC to online, and switch PLC to programming mode, and then select "Send to Controller", as
shown in Figure 5-7-34;

Transfer PLC online, and then download the program into PLC. IO module sequencing corresponds to
the actual address, as shown in Figure 5-8-35 and 5-8-36.
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Restart ] T

3 Transmit to Cont Transmil [rom Controller Compare

Figure 5-7-34 Transferring the EtherNet/IP configuration to the controller
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EX Series Card 1/0 MU VY R
Channel/mo| EX-1120 EX-200H EX-300H EX-4014 EX-5014
dule
Channel 0 - Input[0][1] | Output[O][1] | Input[2] [3] | Output[2][3]
Channel 1 - - - Input[4] [5] | Output[4][5]
Channel 2 - - - Input[6][7] |Output[6] [7]
Channel 3 - - - Input[8][9] | Output[8][9]
Figure 5-7-35 Mapping between 10 module sequencing and actual address (application in case)
Channel/mo| EX-1120 EX-4014 EX-5014 EX-200H EX-300H
dule
Channel 0 - Input[0][1] | Output[O][1] | Input[8] [9] | Output[8][9]
Channel 1 - Input[2] [3] | Output[4][5] - -
Channel 2 - Input[4] [5] | Output[6] [7] - -
Channel 3 - Input[6][7] | Output[8][9] - -

Figure 5-7-36 Mapping between /O module sequencing and actual addresses
5.7.4 Connection and configuration between KV STUDIO and EX-1120

Note: The default IP address segment is 192.168.0.X. You can use the IP Setting Tool to modify the IP address
segment and set the IP address with the DIP switch of the adapter.

The EX-1120 adapter includes two TYPES of PLC modes: normal PLC and special PLC mode.Special PLC
refers to keens PLC, ordinary PLC refers to the other manufacturers except keens PLC, factory default PLC category
mode for ordinary PLC.

1. Communication connection diagram, as shown in Figure 5-7-37

Programming computer

KV-5500

KV STUDIO
EthortieiP 2>
Adapter
EX-200H | EX-300H | EX-4014 | EX-5014
EX-1120

Figure 5-7-37 Communication connection diagram

2. Table 5-7-7 shows the hardware configuration

Table 5-7-7 Hardware configuration table

hardware Quantity note
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Computer programming 1 Install the KV STUDIO
PLC 1 KV-5500
EX-1120 1 EtherNet/IP adapter
EX-200H 1 Digital quantity input module
EX-300H 1 Analog output module
EX-4014 1 Analog input module
EX-5014 1 Analog output module

3. Set the IP address

In this case, the IP address of KV-5500 PLC is 192.168.1.31, and the default network segment of
ex-1120 adapter is 192.168.0.x.

(D Use software IP Setting Tool to modify the network segment to be consistent with PLC;
@) Set the IP address to 192.168.1.33 through the DIP switch on the adapter.
4. Copy XML files
Copy all files in the "Keens Version" folder to the KV STUDIO software folder:
"C: \ ProgramData \ KEYENCE \ KVS11G_Trial \ KVS\ EIP_Eds"
5. New project and equipment configuration

Open KV STUDIO software, create a new project, and double-click "EtherNet/IP" in the project
device tree to open the EtehrNET/IP Settings window, as shown in Figure 5-7-38.

| Project g peilata
( L EtherNet'TP Seiting

LE B2 QA hE @

Figure 5-7-38 Opening the EtherNet/IP Settings window

Install the EDS file. On the menu bar of the EtherNet/IP configuration window, choose EDS File >
Login. In the EDS folder, choose Common Version > EX-1120, as shown in Figure 5-7-39.
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C)
ni
r
C)

B, Open

Luok—inb‘crpe(l]:l " | General Version VI QT B

*

I:g‘)uick Access

Desktop

EX-1120_V1.1...

Library

3

This Computer

= |

Network

File Name (N): [EFIZD_VI.] VI l Open (O) ]|

Text Type(T)  EDS File (*, eds: *. ezl) |  Cancel

Figure 5-7-39 Installing the EDS file

Set the ex-1120 adapter mode to special PLC mode (the factory default is common mode). Right-click
the blank area in the device Search option on the right and choose Device Search, as shown in Figure
5-7-40.

Add the scanned devices to the scan list. Right-click the devices to be added and choose Add to scan
List, as shown in Figure 5-7-41.

For transmission adapter Settings, right-click "EX-1120" in the device list and choose "Transmission
Adapter Settings", as shown in Figure 5-7-42.

In the transfer adapter setting window, change the adapter No.100 setting value to "1: Special PLC"
and write the adapter, as shown in Figure 5-7-43. After the writing is complete, the EX-1120 must be
powered off and restarted.

In the EtherNet/IP Settings window, select KV-5500 and right click "Auto Configuration" to re-read
the EX-1120, as shown in Figure 5-7-44.
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File (F) Edit (E) Sefiing (S} View (V) Conversion (C) EDS File (D) Communication (N) Tool (T} Help (H)

L BY QA hE @

EtherNetIP Device L)
5 5 | ¥ Display All -~

Devies Name 1P Adidress

Ctrl+A

Cirl+C
" Search Device (8)... Cirl+F
Scarch Fmphy TP Adkdrds$ (T0).

Chanse Communication Patch (1)

Figure 5-7-40 Device search

EtherNet/TP Device Y

Device List (1) | Davice Setting (2 SB&I‘C}IDCHOC@]
%5 03 | o} DisplyAll '

TP Address

Device Name

Choose All (A) Ctrl+A
Copy (C) Ctrl+C

¢ to Scan List nter

Search Device (S)... Ctrl+F

Search Empty TP Address (E)...

Figure 5-7-41 Adding devices to the scan list

BX-1120 : 192 168.1.33
B Monitor Data And Control Data

o6 Cut(T) Ctrl+X
[y Copy (©) Ctrl+C
Paste (1) Ctrl+V
Delete (D) Delete
Choose All (A) Ctrl+A

Connection Setting (N). .. Ctrl+N
Transmission Adapter Setting (E).. . Ctrl+E

FtherNet/TP Device Reservation (B) ltrl+R

Attribute (R)...

Figure 5-7-42 Adapter transfer Settings
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Transmission Adapter Setting - KV-3500[0] — O X

File (F) Communication (T) Communication Options (S) Telp (IT)

¥ BBIEIDEIYYRNe

Node List Parameter Setting  Product Name: EX-1120 [1.1]

Target| Result| Node | Node Name | IP Address | | Fo. | Result Parameters Set Value | Model | Attribute |

192. 166, .. . RGO R/

w1 - [AHold or Clear Output

ALON(X) | [ AllOFF (Y) Display All <l

Deseription For example, KEYENCE FLC belongs to special PLC, and other
PLC belongs to gemeral PLC.

Default Value 0

Range 0-1
Current Set Value
- Remarks
Result List
Result| Node Node Name | IP Address | Ho. P 5 Verification Source ! Verification Intention

Read Adapter (R) | | Witento Alapter @)} | Cancel |

Figure 5-7-43 Write adapter

| 3: BX-1120 : 192.168.1.33
£ Monitor Data And Control Data

EtherNet'TP Setting

: BX-300H

o Automatic configuration
is complete,

Confirm

Figure 5-7-44 Re-reading ex-1120

Download the program into PLC, and choose "Monitoring/Simulator" > "PLC Transmission" from the
menu bar. After downloading, switch PLC to monitoring mode to monitor the communication status
between PLC and EX-1120, as shown in Figure 5-7-35.
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X B

B b [0] Kv-5500 R000/R500
B o EtherNet/IF R30000 IM10000
B o [1-0JEX-1120

# [1] EX-200H

< [2] EX-300H

< [3] Ex-5014

< [4] Ex~014

<. Swift Unit Configuration
Software Component Note

Figure 5-7-36 Monitoring the communication between PLC and EX-1120
5.8 Connection between EX-1121 and PLC
5.8.1 Connection and Configuration between Machine Expert and EX-1121

Note:

(1) The EX-1121 has two modes: special mode and normal mode. The special mode can only be used with

Keens CPU, and the factory default is normal mode.

@ The ex-1121 works in BOOTP mode by default and does not have an IP address.For details about how to set
the IP address, see 6.3.6 SETTING the IP Address of the EX-1121 Adapter.

® In common mode, the input and output bytes of communication between THE 10 module and EtherNet/IP
are configured on the right of ex-1121

If the ex-1121 has only input or output modules on the right, the output (O-->T) byte length is set to 1Byte
or the input (T- >0) byte length is set to 1Byte. If neither I/O module is available, the input (T- >O) byte length
and output (O- >T) byte length are set to 1Byte.

The hardware Input (T- >0) Output (O->T)
configuration bytes bytes
EX-1121 1 1

EX-1121

2 1
EX-200H
EX-1121

1 2
EX-300H
EX-1121
EX-200H 2 2
EX-300H

1. Communication connection diagram, as shown in Figure 5-8-1
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Programming computer

m241 Machine Expert
V2.0
EtherNet/P>>

Adapter

EX-200H | EX-300H | EX-4014 | EX-5014

EX-1121

Figure 5-8-1 Communication connection diagram
2. Table 5-7-1 shows the hardware configuration

Table 5-8-1 Hardware configuration table

hardware Quantity note
) Install Machine Expert
Computer programming 1
V2.0
PLC 1 M241
EX-1121 1 EtherNet/IP adapter
EX-200H 1 Digital quantity input
module
EX-300H 1 Digital output module
EX-4014 1 Analog input module
EX-5014 1 Analog output module

3. Set the IP address

For details about how to set the IP address. see 6.3.6 SETTING the IP Address of the EX-1121 Adapter.

4. Install the EDS file

On the menu bar, choose Tools > Device Repository. In the device Repository window,
choose Install, as shown in Figure 5-7-2. In the EDS folder, select EX-1121 V1.1 and confirm the
installation.
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S e bl T R

-

'x Device Memory Library

Location (L) U-su'

Device Installation Description(v)

(C:\ProgramData\EcoStruxure Machine Expert\V2.0\User Devices)

l(_'harav:tcr string for full-text search ISupph’er: Schneider Electric

v

Name Supplier
Iﬂ Altivar

[ Bus Coupter

(B Harmony

(@ Lexium

Eﬂ TeSys

() s One-piece 1/0 Module

(f s Public Distribution Module
Eﬂ TS5 Transmitier Receiver Module
(A s Dummy Module

(@ s Digital 1/0 Module

[ s Analog 1/0 Module

+ [ ™s CANbus Interface Module

3

. O A SO U

~

Edit Location(E)... |

Uniload (L)
Export {E)..

Install DTM... |

- Update Device
Management
Library

Detailsi D).

Close

Figure 5-8-2 Installing the EDS file

5. New project and equipment configuration

Start Machine Expert V2.0, create a project, right-click "EtherNET 1" in the device tree,

and choose "Add Device", as shown in Figure 5-8-3.

Choose Protocol Manager > Industrial Ethernet Manager in the Add Device window, as
shown in Figure 5-8-4. Right-click " (Industrial Ethernet Manager)" > Add Device in the device
window. Select DECOWELL AUTOMATION CO.,LTD for the supplier and ex-1121 in the

equipment catalog, as shown in Figure 5-8-5.
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@& o1 (Digital Inputs)

4% DQ (Digital Outputs)

U Counters (Counters)

ML Pulse_Generators (Pulse Generators)

(@ cartridge_1 (Cartridge)

i 10_Bus (10 bus - TM3)

[ com_Bus (COMbus)

E Ethernet_1 (€ % Cut

= @ Serial Line 1 (Serid @y Copy
(@ vachne_Exper gy

= 67 Serial_Line_2 (Seriz % Delete

() modbus_Manaq ‘

@ cAN_1 (CANopen & Attribute. ..

Paste

2 Add Object
) AddFolder...

| Add Deyice. |
Add Deyige

Disabled Device
Update Device...

Figure 5-8-3 Adding devices

[Clamcter string for full-text scarch | Suppticr |Schneider Electric v
Name Supplier WVersion Description
= [ Protocol Manager
5 SomedeGcic 101235 [ o s
# [ cANbus
< >
Et‘.rmpﬁy(_'segn_v D Showe All Vienaena (Espert Only) D Sthews Expmad Vs

Figure 5-8-4 Adding industrial Ethernet manager
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Name EEK_H.ZJ. i
Action
@ Additional Device(#) O Insert Device (T)  I'uz o Device (1) O Update Device (U)
IChamclcr String for Full-text Search o Supplier IDECOWE.I.A.LH'OMAHDN €O, LTD. v
Name Supplier Version o)
= [ other
() e1-0s00-NONN  DECOWELL AUTOMATION CO.,LTD.  Major Revision=1621, Mino
() e1-0500NINN  DECOWELL AUTOMATION CO..LTD.  Major Revison=1621, Mino
() e1-8300CONN ~ DECOWELL AUTOMATION CO.,LTD.  Major Revision=16=1, Mino
() e1-8300-CINN ~ DECOWELL AUTOMATION CO..LTD.  Major Revision=1621, Mino
(H e1-8300C2MN  DECOWELL AUTOMATION CO.LTD.  Major Revision=1621, Mino
() E1+H00-CONN  DECOWELL AUTOMATION CO..LTD.  Major Revison=16=1, Mino
() e1+#H00-CINN  DECOWELL AUTOMATION CO.LTD.  Major Revison=1621, Mino
([ E1-s000-CNNN  DECOWELL AUTOMATIONCO. LTD.  Major Revision=16=1, Mino
¥ ex-1120 DECOWELL AUTOMATION CO, LTD.  Major Revision=16=1, Mino.
e ) DECOWELL AUTOMATION CO. LTD.  Major Revison=1621, Mino v
< >

EAGroupby Classifeasim I Display ATL Versions (experts only) CJ Display Expired Versions
%

Name: EXN-1121 A
Supplier: DECOWELL AUTOMATION CO., LTD.

Group: Other

Version: Major Revision=16%1, Minor Revision = 16¢1

Module Numbers: EX-1121 v

Figure 5-8-5 Adding ex-1121

To configure ex-1121 parameters, double-click EX-1121 in the device tree, and set the IP
address to a fixed IP address, as shown in Figure 5-8-6.

Device

> 3 x| 9 e x|
=) Unttied: ¥ | |Target Settimg: Comneet User Parametors) S [itherNetIP 1O Mapping 58
= - MyController (TM241CEC24TU) Address Setting (Configure DHCP Server)
= Bl PL.C Togic
= ) Application () DHCP Assign [P Address [DEVICE_1 ]
W o (O BOOTP Assign [P Address | 0a - 00 00 100 00 00
) Library Manager @ Fixed [1' Address 192 . 168 , 1 . 33
8] sr_pan pro)
= Lﬂ gsk Conliguration Fle e Pl
= ¢ masT
. 4 Check Deviee Type 12
w oI (Digital Inputs) [ Check Supplier Code l&|
& 00 Pigital Outputs) [ Check Product Cods 26 ]
U Counters {Counters) [ Check Major Revision 1
Azt 2 SRy i [ Check Secondary Revision 1
() cartridge_1 (Cartridge)
& 10_8us (10 bus - M3) Restore Defults
() com_gus (combus)
= [ Ethemet_1 (Ethernet Network) Fieldbus Protocol
Device Protocol Ethernatl?

= Iii (Industrial Ethernet Manager)
o ¥ Ex 1121 (Ex-1121)

= 0 Serial_Line_1 (Serial lng)

vontriller and e device

Figure 5-8-6 Configuring the IP address
Number of bytes occupied by computing modules:

Table 5-8-2 Number of bytes occupied by modules
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The module Quantity Input/output Occupied bytes
type type
EX-2xx8 1 Input (T- >0) 2
EX-2xxH 1 Input (T- >0) 2
EX-2xxS 1 Input (T- >0) 4
EX-3xx8 1 Output (O->T) 2
EX-3xxH 1 Output (O->T) 2
EX-3xxS 1 Output (O->T) 4
EX-4xx4 1 Input (T- >0) 8
EX-4xx8 1 Input (T- >0) 16
EX-5xx4 1 Output (O->T) 8
EX-5xx8 1 Output (O->T) 16

To configure connection parameters, double-click the default connection parameters, and set
the output bytes (O->T) to 10 bytes and the input bytes (T- >O) to 10 bytes in the edit connection
window, as shown in Figure 5-8-7. View THE IO address mapping, as shown in Figure 5-8-8.

Tamget Setting Cannest U Pramelss S 0be et TP 10 Mappre,. = FherNet 1P 110 Ohel Status | @t

|Conmsetion ¥ Connection Name RPI O-->T (s RPI T--20 (o) 0= T HBuza (hytes) T--=0 Bize (hyles) Config®1 Size (byles) Canfig=2 Sise (hyies)
257 Manstor Data And Contrel Data 0 10 0 0 2
Edil Conmection. ®
Gieneral Parameters
Conreclivn Mame Manitor Data And Control Data
Timeout Multiplier 3 w!
Heamer to Target {Outpul) Target to Scanncr {Tnput]
01— Size (das) 10 o T AT Size {hanas) n e
B2 {nw) w ¥ P {msh n v
Trigger Tvpe L,\\:Ic “Trigaer Type |CW]‘
Suppresion Fime fms) a & Suppression Time (ms] |0
Pt Prosst Mok et by ety < gl
Add Comnaction,.. | D 2 o> | Cuaeel

Figure 5-8-7 Configuring the input and output byte sizes

Tared Setting Conmect User Pty ™= EtherNet TP 1O Mapping. 32 EtherNetTP IEC Object. Status - @ iliman

TFind Filter Show All v o Add T 1o 10 chinsel. . ™ = T to Lavines Exanple
Variable Mapping Chamel Address Type Default value Uit Deseription
= Input Monitor Data And Control Data %IW7 ARRAY [0..4] OF WORD

» Input Monitor Data And Control Data[0] %IWT WORD
“» Input Manitor Data And Control Data[1] %IWE WORD
» Input Monitor Data And Control Data[2] %IWS WORD
*» Input Monitor Data And Control Data[3] %IW 10 WORD
» Input Monitor Data And Control Data[4] %IW1L WORD
= T Output Monitor Data And Control Data %QW2 ARRAY [0..4] OF WORD
"# Output Monitor Data And Control Data[o]  %QW2 WORD
"% Output Monitor Data And Control Data[l]  %QwW3 WORD
" Output Monitor Data And Control Data[2]  %QW4 WORD
"» Qutput Monitor Data And Control Data[3]  %QW5 WORD
"# Output Monitor Data And Control Data[d]  %QWs WORD

Figure 5-8-8 10 address mapping
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The physical address assignment corresponding to the actual module in the case:

Note: In actual hardware, the number of I/O modules configured for the EX-1121 adapter is the
same as that of the model, but the sequence of the MODULES is different, and the physical address
assignment for the modules is different, as shown in Figure 5-8-9, 5-8-10, and 5-8-11.

Adapter
EX-200H | EX-300H | EX-4014 | EX-5014
EX-1121
wo awo W1 aw1
w2 awz2
W3 Qw3
IWé awa

Figure 5-7-9 I/O sorting and address assignment #1(application in case)

Adapter
EX-4014 | EX-5014 | EX-200H | EX-300H
EX-1121
IWo awo w4 Qw4
w1 awil
IW?2 aw?2
W3 aws3

Figure 5-7-10 I/O sorting and address assignment #2

Adapter
EX-1120

EX-4014 | EX-5014 | EX-2008 | EX-3008

IWo awo w4 aw4

W1 awi1
w2 awz
W3 aws

Figure 5-7-11 I/O sorting and address assignment #3

Note: the 8-channel digital input/output module occupies one word. The 8-channel module address is
used in the corresponding physical address

Low bytes correspond to 8 bits.

In EtherNet/IP I/O mapping will always update variable to choose "enable 2 (always in the bus cycle
task)", and download the program to PLC, and monitor the PLC running status and I/O mapping address.

5.8.2 Connection and Configuration between CODESYS and EX-1121
Note:

(1) The EX-1121 has two modes: special mode and normal mode. The special mode can only be used with

Keens CPU, and the factory default is normal mode.
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@ The ex-1121 works in BOOTP mode by default and does not have an IP address.For details about how to set
the IP address, see 6.3.6 SETTING the IP Address of the EX-1121 Adapter.

® In common mode, the input and output bytes of communication between THE 10 module and EtherNet/IP
are configured on the right of ex-1121

If the ex-1121 has only input or output modules on the right, the output (O-->T) byte length is set to 1Byte
or the input (T- >0) byte length is set to 1Byte. If neither I/O module is available, the input (T- >O) byte length
and output (O- >T) byte length are set to 1Byte.

The hardware Input (T- >O) Output (O->T)
configuration bytes bytes
EX-1121 1 1
EX-1121 5 |
EX-200H
EX-1121 . 5
EX-300H
EX-1121
EX-200H 2 o)
EX-300H

1. Communication connection diagram, as shown in Figure 5-8-12

Programming computer

Controller
CODESYS SP16
EthorNiet/P>>
Adapter
EX-200H | EX-300H | EX-4014 | EX-5014
EX-1121

Figure 5-8-12 Communication connection diagram

2. Table 5-8-3 shows the hardware configuration

Table 5-8-3 Hardware configuration table

hardware Quantity note
. Install the CODESYS
Computer programming 1 SP16
The controller 1
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EX-1121 1 EtherNet/IP adapter
EX-200H | Digital quantity input
module
EX-300H 1 Digital output module
EX-4014 1 Analog input module
EX-5014 1 Analog output module

3. Set the IP address

For details about how to set the IP address, see 6.3.6 SETTING the IP Address of the EX-1121 Adapter.

4. Install the EDS file

On the menu bar, choose Tools > Device Repository. In the device repository window, choose
Install, as shown in Figure 5-8-13. In the EDS folder, select EX-1121 V1.1 and confirm the
installation.

‘ 3B Device Memory Library |

Lacation (1) | System Repository v | Edit Location(E)...
(C:\ProgramData\CODESYS\Devices)

Device Installation Description(v)

|(‘Ilar:ll::l:r.ﬁl|‘i|1::fnrfull-lml search !Supplier: <All Suppliers> | [ Install(T)... |

Nume Supplier Version  Description
* _'ﬁ Other Options Export (E),,

+ Bl ivIDevice

+ [ rc

+ & SoftMotionDriver |
+ B Canbus .

Figure 5-8-13 Installing the EDS file
5. New project and equipment configuration

Open CODESYS SP16, create a project, right-click Device in the Device tree, and choose
Add Device. In the add Device window, choose Ethernet, as shown in Figure 5-8-14.

Right-click Ethernet in the device tree and choose Add Device. In the add Device window,
choose Ethernet /IP Scanner, as shown in Figure 5-8-15.
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-

lC'h;lramcr string for full-text search

Name

Supplier ir<A.|] Suppliers>

s

= (@ Ficldbus
+ €AN CANbus
+ ook Ethercat
= = EthemnetIP
+ - = Ethernet IP Scanner
= BB Fthernet Adapter
[ ethernet
+ 18 Modbus
+ - ¥ profibus

Supplier Version  Deseription

3S - Smart Software Solutions GmbH

3.5.16.0 EthernetlL

[ Group By Catezory ] Show All Versions (Expert Only) [_] Show Expired Version

Figure 5-8-14 Adding an Ethernet adapter

[Character string for full-text search

Name

| Supplicr <A1l Suppliers>

W

= EB CanBus

= EthernetlP

= Ethemnet [P Scanner

+ K Modbus

G} 35 - Smart Software Solutions GmbH
* - —Ethernet IP Local Adapter

Supplier Version  Dgseripticn

3.5.16.0  EtheriNe

[ G B Categore [ Show All Versions (Expent Crilys

D Show Expured Versicn

Figure 5-8-15 Adding the EthernetIP scanner

To configure the network adapter, double-click Ethernet in the device tree and select the
network adapter to communicate with Ethernet /IP slave, as shown in Figure 5-8-16.
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Ej Ethernet X

General

b Neworkinetoce [ Iy {1
Log IP Address 192,168 . 0 . 1

Status Subnet Mask 255 . 255 .255 . O |

Default Gateway 0 .0 .0 .0
Ethemet Device /O mapping
Adapt to the operating system configuration

I “thermne e Family 0. 192. 168. 1. 198

Qualcoma Ath
Local Link* | Mierosoft Wi-Fi Direct Virtusl Adapter

Logal Link® 10 Mierosoft Wi-Fi Direct Virtual Adspter #2

1P Address 192 168, 1 . 198 |
Subnet Mask 255 . 285 , 255, O
Defaolt Gateway (192 . 168 . 1 . 1

MAC Address 00:E0:4C:36:05:F2

Oﬁ Confirm I Cancel |

Figure 5-8-16 Configuring the network adapter for the Ethernet adapter

Right-click EtherNet IP Scanner in the device tree and choose Add Device. In the add
device window, select EX-1121, as shown in Figure 5-8-17.

= (@ Fieldbus
= = EthernetlP
= — Ethemnet IP Remote Adapter
EI-8300-CONN DECOWELL AUTOMATION CO.,LTD. Major Revisi
EtherNetiP Adapter 35 - Smart Software Solutions GmbH Major Revisi
EtherNetIP Scanner 35 - Smart Software Solutions GmbH Major Revisi
¥ Bx-1120 DECOWELL AUTOMATION CO.,LTD. Major Revisi
[Ex-uzx | DECOWELL AUTOMATION CO.,LTD. Major Revish

(=~ . - e e R - v e e N -

< }

[] Group By Caregory [ ] Show All Versions (Expert Only) [ ] Show Expired Version

Figure 5-7-17 Adding the EX-1121 adapter

To configure the IP address of the EX-1121 adapter, double-click EX 1121 in the device tree,
and enter the IP address (the IP address must be the same as that of the actual module), as shown
in Figure 5-8-18.
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¥ EBx 1120 X
I Conge Address Setting
Link IPAddress |192 . 168 . 1 . 33 Eth ] -
: en'et/IP
| Component
.. Electronic Keying
User Parameters g
| o [[] Compatibility check
EtherNet/IP Parameters Vendor D |+‘5? | B Check Supplier Code
| Devicetype |12 | [ Check Deviee Type
EtherNet'IP 'O Mapping -
| Product code (214 —| A Check Product Codz
| EtherNet IP IEC Object Major revision i -| [A Check major revisions
I Status Minorrevision |1 _| [ Cheek miner revisions

Figure 5-8-18 Configuring the IP address of the EX-1121 adapter

Number of bytes occupied by computing modules:

Table 5-8-4 Number of bytes occupied by modules

The module Quantity Input/output Occupied bytes
type type

EX-2xx8 1 Input (T- >0) 2
EX-2xxH 1 Input (T- >0) 2
EX-2xxS 1 Input (T- >0) 4
EX-3xx8 1 Output (O->T) 2
EX-3xxH 1 Output (O->T) 2
EX-3xxS 1 Output (O->T) 4
EX-4xx4 1 Input (T- >0) 8
EX-4xx8 1 Input (T- >0) 16
EX-5xx4 1 Output (O->T) 8
EX-5xx8 1 Output (O->T) 16

Set the input and output bytes of the /O module of the EX-1121 adapter (you need to set the

input and output bytes based on the actual NUMBER of I/O modules to ensure normal
communication), as shown in Figure 5-8-19. Then view the I/O mapping of EtherNet/IP

communication, as shown in Figure 5-8-20.
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¥ i1 x|

General
| Connection Mams RPlfms)  O--=T Sice(byte) T-->0 Size(byte) Ao oo, Tuge Confpndtion St thsle)
Connect o 1, Moritor Data And Control Dats 10 504 504 2
I Component
|
Ut,cr Paramiotors Edil Conneciion
] General Parameters Conlinm
| Loz Conettion Paih 20042436 2065 3¢ 64 i Cancel
EtherMNet/TP 10 M; Ao— :
| thethet/Ik: 102 Mapp(ng Trigger Type  |[Circular RPI{ms) |10 k&
| EtherNet/IP 1EC Object Transmissien Type ﬂ‘?_’?_l_?_"_iﬁlf!'.\_r_'_@_\t_’_!ﬁ!‘_ | Timeat Muliplicaion 4 T
: Status Seamer Lo Targel (Outpul) Targel 1o Scamer (lipul)
| Information O ==>T Sive(byle) |C|e 0o T Shzes bf_nclue
| S ——
Agent Canligurition Sive [0
Target Configuration Size [2
| Conneetion Type Point to Point | Caonnection Type -
Connection Priority. | Schaduled w Connection priofity | Scheduied b
Ficed AmoetVaciable | ined | Fined §mlm."-:ari?ble[ﬂ&ed | 1
Transfer Format 32 Bil Operating/ldle| Transfer Format [Purc Data |
Forbidden Time ms) 0 - Farbidden Tiw (nei®
Heartbeat multiplier E 2 t
Figure 5-8-19 Configuring the size of input and output bytes
¥ EX 1120 x|
- General Find Filter Show All v o
i [ Variable M & E : L . !
| Eonnact ariable {apping Channel Address  Type Unit  Desription
- =3 Monitor Data And Contr...
Component + 4 Input Data %IW0 UINT
i + % Input Data LIw1 UINT
| User Parameters + Input Data %IW2 UINT
' Log + 4 Input Data %IW3 UINT
+ Input Data BaIw4 UINT
EtherNet/IP 1/0 Mapping + "9 OutputData  %QWO UINT
: + "9 OutputData  %QwW1 LINT
EtherNet/TP IEC Object RS OutputData | %QW2 e
LY A
Siatus + : Output Data %QW3 UINT
! 9 OutputData  %QW4 UINT
| Information
!

Figure 5-8-20 IO address mapping

The physical address assignment corresponding to the actual module in the case:

Note: In actual hardware, the number of I/0 modules configured for the EX-1121 adapter is the
same as that of the model, but the sequence of the MODULES is different, and the physical address
assignment for the modules is different, as shown in Figure 5-8-21, 5-8-22, and 5-8-23.

Adapter

EX-200H | EX-300H | EX-4014 | EX-5014
EX-1121

Wo awo w1 aw1

w2 awa
W3 aw3
wa awa

Figure 5-8-21 I/O sorting and address assignment #1(case application)
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Adapter
EX-4014 | EX-5014 | EX-200H | EX-300H
EX-1121
IWo awo w4 Qw4
w1 awil
IW?2 aw?
W3 Qw3

Figure 5-8-22 I/O sorting and address assignment #2

Adapter

EX-4014 | EX-5014 | EX-2008 | EX-3008
EX-1120

IWo awo w4 aw4

W1 awi1
w2 awz
W3 aws

Figure 5-8-23 1/O sorting and address assignment #3

Note: the 8-channel digital input/output module occupies one word. The 8-channel module address is
used in the corresponding physical address

Low bytes correspond to 8 bits.

In EtherNet/IP I/O mapping will always update variable to choose "enable 2 (always in the bus cycle
task)", and download the program to PLC, and monitor the PLC running status and I/O mapping address.

5.8.3 Connection and Configuration between Sysmac Studio and EX-1121
Note:
Note:

(1) The EX-1121 has two modes: special mode and normal mode. The special mode can only be used with

Keens CPU, and the factory default is normal mode.

@ The ex-1121 works in BOOTP mode by default and does not have an IP address.For details about how to set
the IP address, see 6.3.6 SETTING the IP Address of the EX-1121 Adapter.

® In common mode, the input and output bytes of communication between THE 10 module and EtherNet/IP
are configured on the right of ex-1121

If the ex-1121 has only input or output modules on the right, the output (O-->T) byte length is set to 1Byte
or the input (T- >0) byte length is set to 1Byte. If neither I/O module is available, the input (T- >O) byte length
and output (O- >T) byte length are set to 1Byte.

The hardware Input (T- >O) Output (O->T)
configuration bytes bytes
EX-1121 1 1
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EX-1121
EX-200H

EX-1121
EX-300H

EX-1121
EX-200H
EX-300H

1. Communication connection diagram, as shown in Figure 5-8-24

NX1P2

EtherNieyiP->>

Programming computer

Sysmac Studio

Adapter

EX-1121

EX-200H | EX-300H | EX-4014 | EX-5014

Figure 5-8-24 Communication connection diagram

2. Table 5-8-5 shows the hardware configuration

Table 5-8-5 Hardware configuration table

hardware Quantity Note
Computer programming 1 Install the Sysmac Studio
NXI1P2 1
EX-1121 1 EtherNet/IP adapter
EX-200H | Digital quantity input
module

EX-300H 1 Digital output module
EX-4014 1 Analog input module
EX-5014 1 Analog output module

3. Set the IP address

For details about how to set the IP address, see 6.3.6 SETTING the IP Address of the EX-1121 Adapter.

4. New project and equipment configuration

Open the Sysmac Studio programming software creation project and configure the
EtherNet/IP port as a fixed IP address (the same as the ACTUAL PLC port IP address), as shown

in Figure 5-8-25.
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Multi-vicw Browser ~ 7 [

———
[new_Controlier ) v | =] Tlﬂlg TCP/IP Setting

A\dl Configuration and Setting

7B EtherCAT ¥ [P Address
¥ = CPU/ Extension rack © Fix Setting

IEWVa Vi 192, 168. 1__.39_ 2
Bl 255 . 255.255._0

Lgf Built-in ( g ;
LI Buillin 10 Seuing Default Gateway | N
. ¥ DNS

DNS O Unused @ Used
Preferred DNS Server
Backup DNS
Domain Name

¢ Cam Data Seiling
> Event Setling
B, Task Sctting

F# Data Track Sctfing ¥ CPU-IP address

Figure 5-8-25 EtherNet/IP port Settings

Create all variables, and create input and output variables in global variables. The length of
the variables must be the same as the length of input and output bytes in the actual module, as
shown in Figure 5-8-26.

Number of bytes occupied by computing modules:

Table 5-8-6 Number of bytes occupied by modules

The module Quantity Input/output Occupied bytes
type type
EX-2xx8 1 Input (T- >0) 2
EX-2xxH 1 Input (T- >0) 2
EX-2xxS 1 Input (T- >0) 4
EX-3xx8 1 Output (O->T) 2
EX-3xxH 1 Output (O->T) 2
EX-3xxS 1 Output (O->T) 4
EX-4xx4 1 Input (T- >0) 8
EX-4xx8 1 Input (T- >0) 16
EX-5xx4 1 Output (O->T) 8
EX-5xx8 1 Output (O->T) 16
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Multi-view Bro

|mew. nnlmlluﬂ v Name Data Type Inttial Value

Figure 5-8-26 Creating global variables

On the menu bar, choose Tools > EtherNet/IP Connection Settings. In the EtherNet/IP list
window, double-click the node address to open the EtherNet/IP port connection Settings window,
as shown in Figure 5-8-27.

| Deescription |

— 0 —

Built-in EtherNet/IP Port

ornnation

Export’

| Digital Choice | Size (Byies) 3 (Bit) Tnstance 1D Controller Status | I

Figure 5-8-27 Opening the connection Settings window for built-in EtherNet/IP port Settings

Register variables. In the built-in EtherNet/IP port Settings connection Settings window,
select "Label Groups" window and click "Register All" to register the newly created global
variables, as shown in Figure 5-8-28.
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Lmport Export

Dala Type

i B "W Input Label

¥ Input ARRAY[0.9] OF byte
E ¥ Output Label
] Output ARRAY([0..9] OF byte

Locted ltem  Canvel.

"All Retumn fo Dty

Figure 5-8-28 Registry variables

Install the EDS file, right-click in the blank area of the toolbox on the right of the connection
setting window of the built-in EtherNet/IP port, and choose Show EDS Library, as shown in
Figure 5-8-29.In the EDS library window, click Install to open the EDS file to be installed, as
shown in Figure 5-8-30.

Figure 5-8-29 shows the EDS library
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EDS library - O

i3 OMRON Corporation
i1 Omron Adept Technologies, Inc.
B Omron Microscan Systems, Inc.

Install

R

Figure 5-8-30 Installing the EDS file

To add devices to be communicated with and set parameters, select "Add Target Device" in
the toolbox, as shown in Figure 5-8-31. Fill in the IP address of EtherNet/IP slave, slave model,
and revised version, and click "Add" in the lower left corner of the motor.

R T v A

Figure 5-7-31 Adding a target device

Drag the target device 192.168.1.33 EX-1121 version 1 from the toolbox to the connection,
as shown in Figure 5-8-32.

Set the target device parameters. The input target variable of EX-1121 is 100, the output
target variable is 101, the input and output bytes are 10, and the starting variable is the global
variable registered, as shown in Figure 5-8-33.

Switch PLC to online, switch PLC to programming mode, and then select "Send to
Controller", as shown in FIG. 5-8-34;

Transfer PLC online, and then download the program into PLC. IO module sequencing
corresponds to the actual address, as shown in Figure 5-8-35 and 5-8-36.
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¥ Lk
Link

Figure 5-8-34 Transferring the EtherNet/IP configuration to the controller

Channel/mo| EX-1121 EX-200H EX-300H EX-4014 EX-5014
dule

Channel 0 - Input[0][1] | Output[0][1] |Input[2][3]|Output [2][3]

Channel 1 - - - Input[4] [5] | Output[4][5]
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case)
Channel/mo| EX-1121 EX-4014 EX-5014 EX-200H EX-300H
dule
Channel 0 - Input[0][1] | Output[O][1] | Input[8] [9] |Outputf[8][9]
Channel 1 - Input[2] [3] | Output[4][5] - -
Channel 2 - Input[4] [5] | Output[6] [7] - -
Channel 3 - Input[6][7] | Output[8][9] - -

EX Series Card 1/0 DELUYY ELL
Channel 2 - - - Input[6][7] | Output[6] [7]
Channel 3 - - - Input[8][9] | Output[8][9]

Figure 5-8-35 Correspondence between IO module sequencing and actual address (application in

Figure 5-8-36 Mapping between I/0O module sequencing and actual addresses
5.8.4 Connection and Configuration between RSLogix 5000 and Ex-1121

Note:

(1) The EX-1121 has two modes: special mode and normal mode. The special mode can only be used with

Keens CPU, and the factory default is normal mode.

@ The ex-1121 works in BOOTP mode by default and does not have an IP address.For details about how to set
the IP address, see 6.3.6 SETTING the IP Address of the EX-1121 Adapter.

® In common mode, the input and output bytes of communication between THE 10 module and EtherNet/IP
are configured on the right of ex-1121

If the ex-1121 has only input or output modules on the right, the output (O-->T) byte length is set to 1Byte
or the input (T- >O) byte length is set to 1Byte. If neither I/O module is available, the input (T- >O) byte length
and output (O- >T) byte length are set to 1Byte.

The hardware Input (T- >0O) Output (O->T)
configuration bytes bytes
EX-1121 1 1
EX-1121 5 |
EX-200H
EX-1121 . 5
EX-300H
EX-1121
EX-200H 2 o)
EX-300H
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1. Communication connection diagram, as shown in Figure 5-8-37

1769-L23E- e comput
QB1 RSLogix 5000
Etmertietnp 2>
Adapter
~ " | EX-200H | EX-300H | EX-4014 | EX-5014
EX-1121

Figure 5-8-37 Communication connection diagram
2. Table 5-8-7 shows the hardware configuration

Table 5-8-7 Hardware configuration table

hardware Quantity note
Computer programming 1 Install RSLogix 5000
PLC 1 1769-L23E-QB1
EX-1121 1 EtherNet/IP adapter
EX_200H | Digital quantity input
module
EX-300H 1 Analog output module
EX-4014 1 Analog input module
EX-5014 1 Analog output module

3. Set the IP address

For details about how to set the IP address, see 6.3.6 SETTING the IP Address of the EX-1121 Adapter.

4. Install the EDS file

On the menu bar, choose Tools > EDS Hardware Installation Tool, as shown in Figure 5-8-38.
In the EDS installation window, select the specified folder, as shown in Figure 5-8-39.
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8 RSLogix 5000

File (F) Edit(E) View(V) Search(S) Logic (L)Cmmmicdin(C) Tools (T) Window (W) Help (H)

B & B © o |: Options (O)...

Confidential(S) >

No Controller f. = ruE
File La L)..
No Mandatory | IF ox e e Language(L)
No Edit = g i‘g e :
Redundancy 39 Export®) .

Motion(M)

Monitor Device (P)

Custom Tools...

Ef ControlFLASH

Figure 5-8-38 Installing the EDS file

Rockwell Automation's EDS Wizard X

Registration
Electronic Data Sheet file(s) will be added to your system for use in Rockwell = S
Automation applications.

" Register a single file
& Register a directory of EDS files [~ Lock in subfolders
In folder:

C:\Users\WTQ\Desktop\decowel\EX-1121-V1.1General Version

@ * If there is an icon file (ico) with the same name as the file(s) you are
registering then this image will be associated with the device.

To perform an installation test on the file(s), click Next

Figure 5-8-39 Selecting the EDS folder path
5. New project and equipment configuration

Open RSLogix 5000, select a new project, and select the corresponding CPU and version, as
shown in Figure 5-8-40.
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New Controller X

Supplier Allen-Bradley

Type: [T] | 1769-L23E-0B1 CompactLogix5323E-QB1 Controller | | Yes |

Version: [V] 20 v . Cancel .

Started Redundant[P] : Help
Name: [M] AB1769

Introduction: |[P]

Case Type [C] <N/A>

Slot [O] o F] Safety Partner Slot: <N/A>

Create Location: [E] C:ARSLogix 5000iProjects Browse|B]..
Security Authorization: [S| No Prot;ct “’:

Only use selected security authorization for 1D
validation and authorization

FIG. 5-8-40 New construction project

Configuration EtherNet/IP communication, in Controller Manager, select EtherNet and right
click New Module, as shown in Figure 5-8-41.
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®-C3 Controller AB1769
-0 Task
=-3 Motion Team
-3 Unclassified Axis
1 Add-on Customize Password
=3 Data Type
L User Definition
@ (@ Character String
(3 Add-On-Defined
- Predefinition
@ O Module Definition
3 Trend
=23 Input/Output Configuration
& 85 Compactlogix5323E-QB1 System
fa 1769-L23E-QB1 AB1769
& 1769-L236-QB1 Ethernet Port LocalENB
- Comp[ % New Module.. |
=8 Find I\'!utlull:.!'."ix

m

4 2 Paste Culsy |PPUts
- 4 Dutputs
Gy Print »

Figure 5-8-41 Creating a Module

Add IO module, select DECOWELL in filter, and select the actual IO module model, as

shown in Figure 5-8-42.

Select Module Type

Cluteperry  Muodule Find - Favorites

| Enter seareh text of module type.., Clesi filter (C) Hide filter
E—g Modube Type.. ™ E Maodule Type..
| [ Consunication [0 Allenfradley
|4 Conmunications Adspter O Cogaex Corporntle'n
|4 Centroller f1 DL L
M Digital !miress'ﬁmer i
| < > L § >
w*  Turget Number Deseription Supplier Type A
E-1121 EX-1121 DECOWELL AV... Communications
FS Series ET2-6500-CONN DECOWELL AV... Communications
FS Series EIZ-6800-C1KN DECOWELL AV... Conmunications
FS Series EI2-G800-C2HN DECOWELL AV... Communications
: I'S Series EI2~HHDO-CONN DECOWELL AV... Comeunications
5 EIZ2-HADO-CINN LE ELL Al Communi cations
FS Seriec R Fae L1 L 1L TIFCIWFTT, air Cananni aatiane
< >

9/ 220 Module I'vpe Vound

D Close on Cieation (T.)

Figure 5-8-42 Selecting the IO module
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Configure the module name and IP address. The IP address must be the same as the actual IP
address. Otherwise, the communication fails, as shown in Figure 5-8-43.

B Mew Module x
Gemeralk Cocmection Medule Infs Internst Protocol [Port Configuration Network
Tips: EXA121EX1121
Verds DECOWELL ALTOMATION CO LT
Parert LacdEHE
i [ | Etheeret Addess
- " | O Piieale Nelwork. 1927681 z
e@;lPAddlw 190 Te8 , 1 . 182
(7 Host M zme:
Mohd= Dfnbon
Rieion. 11
Elecko Kmang  Compsbble Modue
Connechons: =nomes
Charge ..
Sratas  Crsatisg Canoel Help

Figure 5-8-43 Edit module IP and name

In the New Module window, select Change to set the INPUT and output bytes of the EX-1121

(the number of bytes must be the same as the actual /O Module; otherwise, the COMMUNICATION
fails), as shown in Figure 5-8-44.

L] v Maod =
Gemeral® Comnection Module Info Internct Protocol Bt Cubesnie Nerwork i

Type: B2 Bx1

2| Module Definition™ X
Vendor DECOWELL AUTOMATION £0.LTD
Pasent LocaENR Revisin 1 ¥ i
Mame: [Ex 21 || ElectiorscKesing | Compatile Madue -
Deescription: Connechons:

Hame ll'wmte Data Size

Montor Deta And Controg hput [ putce | 100 L TN
Data Output: [ Owput cP| 101 |f 10 i

Moduie Defirition e
Rlevision: 11

Electionic Keging:  Compatibie Modde
Connechons: <nonex @

| i
A Faies|
Status: Creating 114 Cancel Help !

Figure 5-8-44 Configuration module input and output bytes
Number of bytes occupied by computing modules:

Table 5-8-8 Number of bytes occupied by modules

The module Quantity Input/output

(0] ied byt
type type ccupied bytes
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EX-2xx8 1 Input (T- >0) 2
EX-2xxH 1 Input (T- >0) 2
EX-2xxS 1 Input (T- >0) 4
EX-3xx8 1 Output (O->T) 2
EX-3xxH 1 Output (O->T) 2
EX-3xxS 1 Output (O->T) 4
EX-4xx4 1 Input (T- >0) 8
EX-4xx8 1 Input (T- >0) 16
EX-5xx4 1 Output (O->T) 8
EX-5xx8 1 Output (O->T) 16

Choose to communicate with the online PLC and download the program, choose
"Communication" > "Activity" from the menu bar, select the online CPU, as shown in Figure
5-8-45, and download the program into the PLC, as shown in Figure 5-8-46.

85 Activity item O X

[ Autobrowse Refresh

&- X Workstation, DESKTOP-BOTHGHQ 9 Online(G)

Yo Linx_Gateways, Ethernet Upload(U)...
|5 55 AB ETHIP-1, Ethernet Sowmicadiit
9 192.168.1.115, Unrecogized Device, EX-1120 — B3
¥ 192.168.1.182, EX-1121, EX-1121 Update Firmware(F)...
—§5 192.168.1.191, EI2-HHOO-CINN, EI2-HHOO-C1NN Close(C)

K 192.168.1.38, Unrecognized Device, KV-7500

=-m 192.168.1.63, 1769-L23E-QB1 Ethernet Port, 1769-L23E-Ql Halp
£-f]f) Backplane, Compactlogix System

-9 01, 1769-L23E-QB1 Ethernet Port

3 J 03, Local 1769 Bus Adapter, VA1769/A - :
_Set Prqlect P’alh{E)_
Clear Project path(L)

< >
Path: AB_ETHIP-1\192. 168. 1. 63\Backplane\0

Path in Project:<N/A>

Figure 5-8-45 Choosing to communicate with online PLC
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Comnecied o "Online™ -

Option Regular Date/Time Serious Fanlt Minor Fault  File

Condition: Opened item does not match the tem in the controller

Linked Controller;
Controller Name: AB20220628
Controller Type: 1769-1L23E-QB1 CompactLogix5323E-QB1 Controller
Commumication Path: AB_ETHIP-11192,168.1.63\Backplane\0

Serial Number: COOFE737
Confidential: No Protect
Offline Project:

Controller Namk: AB1769
Controlker Type: 1768-123E-QB1 Compactlogin$323E-QB1 Controller

File: CARSLogix 5000\Projects\AB1769.ACD
Serial Number, <NfA>
Comfidential- No Protect

Eﬂiﬁﬁd{\v\fi Select File(S)... Cancel Help

Figure 5-8-46 Program downloaded into PLC

Monitor whether the communication is normal, bring the CPU online, and monitor whether
the communication between EX-1121 and PLC is normal, as shown in Figure 5-8-47.
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Rem Run E' F Run Mmle WG,

No Mandatory  »_| B Controller OK *
e a‘ E Battery Normal

NoEdit = &|mimox :

I_ i

. Controller Manager v L X '
E_- @ (7 Controller AB1769 A

% | =3 Task

-3 Motion Team
3 Add-on Customize Password
= SIData Type
U User Definition
+-Cg Character String
£l Add-On-Defined
® ;ﬁ Predefinition
i#-Cj Module Definition
3 Trend
=3 Input/QOutput Configuration
= Compactlogix5323E-QB1 System
o 1769-L23E-QB1 AB1769
= 1769-L23E-QB1 Ethernet Port LocalENB
=-ag Ethernet
-4 1769-123E-QB1 Ethernet Port LocalE
s
=0 CompactBus Local
= &3 Embedded IO
# [1] Embedded IQ16F Discrete _Input:
# [2] Embedded OB16 Discrete_Outpt
3 Extend /O g
< >
—] Module Defined Tag
L BX 1121

EX_1121:0
A e 1121C

Note

 Status | Running
Module Fault!

Figure 5-8-47 Monitoring module running status
5.8.5 Connection and Configuration between KV STUDIO and EX-1121

Note:

(1) The EX-1121 has two modes: special mode and normal mode. The special mode can only be used with
Keens CPU, and the factory default is normal mode.

2 The ex-1121 works in BOOTP mode by default and does not have an IP address.For details about how to set

the IP address, see 6.3.6 SETTING the IP Address of the EX-1121 Adapter.

® In common mode, the input and output bytes of communication between THE 10 module and EtherNet/IP
are configured on the right of ex-1121

If the ex-1121 has only input or output modules on the right, the output (O-->T) byte length is set to 1Byte
or the input (T- >O) byte length is set to 1Byte. If neither I/O module is available, the input (T- >O) byte length
and output (O- >T) byte length are set to 1Byte.
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UELUVWEL

e

The hardware Input (T- >0) Output (O- >T)
configuration bytes bytes
EX-1121 1 1
EX-1121 ) .

EX-200H
EX-1121

1 2
EX-300H
EX-1121
EX-200H 2 2
EX-300H

1. Communication connection diagram, as shown in Figure 5-8-48

KV-7500

Ethernet/P>>

Programming computer

KV STUDIO

Adapter
EX-1121

EX-200H

EX-300H

EX-4014

EX-5014

FIG. 5-8-48 Communication connection diagram

2. Table 5-8-9 shows the hardware configuration

Table 5-8-9 Hardware configuration table

hardware Quantity note
Computer programming 1 Install the KV STUDIO
PLC 1 KV-7500
EX-1121 1 EtherNet/IP adapter
EX-200H | Digital quantity input
module
EX-300H 1 Analog output module
EX-4014 1 Analog input module
EX-5014 1 Analog output module

3. Set the IP address

For details about how to set the IP address, see 6.3.6 SETTING the IP Address of the EX-1121 Adapter.

4. Copy XML files
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Copy all files in the "Keens Version" folder to the KV STUDIO software folder:
"C: \ ProgramData \ KEYENCE \ KVS11G_Trial \ KVS \ EIP_Eds"

5. New project and equipment configuration

Open KV STUDIO software, create a new project, and double-click "EtherNet/IP" in the
project device tree to open the EtehrNET/IP Settings window, as shown in Figure 5-8-49.

T Setting
Project R X M@ EtherNetIP Setting
- File(F) Edit{E) Seuing(S) View (V) Conversion (C) [ El_)S?ilc fD:| Communication (N) Tool (T) Help (H)
P
5 .

Figure 5-8-49 Opening the EtherNet/IP Settings window

Install the EDS file. On the menu bar of the EtherNet/IP configuration window, choose EDS
File > Login. In the EDS folder, choose Common Version > EX-1121, as shown in Figure 5-8-50.

B Open x
] @@

* Name Date Changed i
| TEx-1121 v1.1 2022/4/7 12:56 It

Quick Access

Desktop

(|
Library

La

This Computer

@ . ;

Network I I
- File Name (N): llx—llZl_\r'l. : VJ Siaidite

Text Type (T) | EDS File (%, eds; *. ezl) v [ Caneel

Figure 5-8-50 Installing the EDS file
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Set the ex-1121 adapter mode to special PLC mode (the factory default is common mode).
Right-click the blank area in the device Search option on the right and choose "Device Search", as

shown in Figure 5-8-51.

Add the scanned devices to the scan list. Right-click the devices to be added and choose Add
to scan List, as shown in Figure 5-8-52.

For transmission adapter Settings, right-click "EX-1121" in the device list and choose
"Transmission Adapter Settings", as shown in Figure 5-8-53.

In the transfer adapter setting window, change the adapter No.100 setting value to "1: Special
PLC" and write the adapter, as shown in Figure 5-8-54. After the writing is complete, the
EX-1121 must be powered off and restarted.

In the EtherNet/IP Settings window, select KV-7500 and right click "Auto Configuration" to
read ex-1121 again, as shown in Figure 5-8-55.

B EiherNet/IP Setting - o %
File (Fy Edit (B} Setting (31 View (V) Conversion (C) EDS File (D) Ceamnumicaiion (N)  Tool (T)  Help (H)
* @ - Hh B CAA¥ hi @
Device Lis (13 | Device Settis ;-
*ﬁ "ﬁ | aﬁ Lhisplay- Al o~
Dievicn M 11 Adulrass | MAC Address
Ctri+a }
: L) Enter
I ‘_' Y. Ctri+F
Search Frpls TP Address (T7)
Cheese Commmunieation Faich [1)...
I1* Auliresss Satlinsa (1

Figure 5-8-51 Device search
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Deviee List (1) | Device Setting (2} Search Device (3}'
5n 1 | Y | Display All vl

Device Name IP Address MAC Address
- F % 1

B Ex-2004 Choose All (A) Ctrl+A

§ Ex-z00K Copy (O) Ctrl+C

B Ex-so14 e ._

' EX-5014 Adde to Scan E,EIST (L) Enter

Search Device (S)... Ctrl+F
Search Empty 1P Address (E)...
Choose Communication Patch {T). .

IP Address Setting (I)...

[P Address Initialization (1)
CEX-112101.11 Reset Message Sending (R)

Figure 5-8-52 Adding devices to the scan list

2: BX-1120 : 192. 168. 1. 33
B Monitor Data And Control Data

| 3 cut(n) Ctel+X
I Copy (C) Ctrl+C
Paste () Ctrl+V
Delete (D) Delete
Choose All (A) Ctrl+A

Connection Setting (N). .. Ctrl+N
“Transmission Adapter Setting (E)... Ctrl+E

EtherNet/IP Device Reservation ( B]L&TI’HR

Attribute (R). ..

Figure 5-8-53 Adapter transfer Settings
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Transmission Adapter Setting - KV-7300[0] — m| X

File (F) Comnunication (T) Communication Options (S) Help (H)

FINBR LR 9V &N

Node List Parameter Setting  Product Name: EX-1120 [1.1]

arget Result) Node  Node Name | 1P Address . | Ho. | Result Pammeters Set Value | Model Attribute
- 1-3 § Ex-014 = 101, = [“Hold or Clear Output
ALON(X) |ALOFF(Y) Display All v
Description For example, KEYENCE PLC belongs to special PLC, and other
PLC belongs to general PLC.
Detfault Value 0
Range 0-1
Cumrent Set Value 1
- Remarks
Result List
Result | Node Node Name | IP Address | No. Parameters Verification Source Verification Intention

Read Adapter (R) = | Wnile mio Adipter (W) Cancel

Figure 5-8-54 Write adapter

2: BX~1121 : 192.168.1.19
B Monitor Data And Control Data

EtherNet/IP Setting

By

o Automatic configuration
is complete.

Confirm

Figure 5-8-55 Re-reading ex-1121
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Download the program into PLC and choose "Monitoring/Simulator" > "PLC Transmission" from
the menu bar. After downloading, switch PLC to monitoring mode to monitor the communication

status between PLC and EX-1121, as shown in Figure 5-8-56.

il Unit Configuration
B o [0] Kv-78500
B o EtherNet/IP R30000 IM10000

B 5 [2-0]Ex-1121
< [1] Ex-200H
# [2] EX-300M
# [3] EX—4014
# [4] EX-5014

Figure 5-8-56 Monitoring the communication between PLC and EX-1121

5.9 Connection between Ex-1112 and PLC

5.9.1 Connection and Configuration between TIA Portal and EX-1112

1. Communication connection diagram, as shown in Figure 5-9-1.

Programming computer

AFAE TIA Protal V16

T

Adapter

EX-1112

EX-4014 | EX-5014 | EX-200H | EX-300H

Figure 5-9-1 Communication connection diagram

2. Table 5-9-1 shows the hardware configuration

Table 5-9-1 Hardware configuration table

hardware Quantity note
Computer programming 1 Install TIA Portal V16
The controller 1 S7-1214C
EX-1112 1 PROFINET adapter
EX-4014 1 Analog input module
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EX-5014 1 Analog output module
EX-200H | Digital quantity input
module
EX-300H 1 Digital output module
Ethernet cable A number of

3. Install the GSD file

Open TIA Portal V16 and choose Options > Support Device Description File (GSD) from the
menu bar, as shown in Figure 5-9-2.

Options (N} Window (W) Help (H)
Y Set(8)
Support Package (P)

ion eseription File
ﬁtamqu\uzcmenon License Managergii g

"_| Show Reference Text (W)
LL] Global Library (G) >

Teamcenter »

Figure 5-9-2 Installing GSD files
4. New project and equipment configuration

Open TIA Portal V16, select a new project and configure it, as shown in Figure 5-9-3.

Add New Device
® Show All Devices Deviee Name:
[t |
1 ~ L Controllers o~ Device:
- [ SIMATIC 5741200 |
v @ crPu
i :
Canttollar » (@ cPU1211C ACIDCRYY
» [m cPu 1211¢ DUDCIDC
[ 2 i
ngcpm_nc DCDCIRly e s
» L CPU 1212C ACIDCIREY
D | » i@ cPuU 1212¢ DEBCIDE |
* e ",
| » (i) cPu 1212¢ DUDCRYY Po No.: [SES7 214-1AGI00XB0
Hia » (13 CPU 1214C ACDTiRlY oo, Y
(@ CPU 1214cC DCIDCIDC " = =
8 sE57 214-1AE30-0X80 Note:
[l ses7 214-14631-0x80 100KB working memery; 24VDC power
| GEST 214-1AG40-0%80 supply, DI =« 240 an-hoard drain |
CPU 1214C DCIDCIRly source, 13010 = 24VDC and AIZ; 6
PC System » [ CPU 1215¢€ ACDCIRY high-speed on-board counters {which can
(il be extended by digital signal board) and
[“T-' = 4-chanmel pulse output;, on-hoard
b L CPU 1215C DCIBCIRly expansion [0, up to 3 communication
» [m cpu 1217¢ ncioeibe modules can be used for serial
» [@crui2i2Fcocioope | communication; up to # signal modules
» [[li CPU 1212FC DCIDCIRlY can be used for [0 CXPENSIH;

PROFINET centroller. Smart devices.
TCPAP transmission protocol. Open user
security communication. 87

» r_J] CPU 1214FC DCIDCIDE
» [[@ CPU 1214FC DCIDCIRlY

» [ cPu 1215Fc DUDCIDC pommunication. Web server, OPC TTA:
» [[§ CPU 1215FC DCIDCIRlY server 1A
» [ cPUSIPLUS =
Lo b i AW IR T T, ﬂ
<] ] [1>]

@ Help

4 Open Device View e’ Add
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Figure 5-9-3 New construction project

To configure the device, expand the hardware directory in the network view and select the

adapter, as shown in Figure 5-9-4. Double-click the adapter to access the CONFIGURATION I/O
module in the device view, as shown in Figure 5-9-5.

ﬁ'?Tu e #Network Vlmmfl)evme V]e\ﬂ_ Options
(R 2 =

[>!

~ [Category
|<Search Filter>
MFlter tanfiguriion ile| = ATl =
» [l Detecting & Menitoring
» [ Diztributed o
» [ Power supply and distribution
18 Field devices
[/ Other field devices
3 fa Additional Ethernet devices
= [l PROFINETIO
» [ Drives
» I"_i Encoders
L3 ﬁ Gateway
» Ei General
=[mo
» r‘j Beckhoff
» [l Beckhofi Automation
» [ DEC
« [ DECOWELL
~l@exanz
[ E%1112 Profinet Device
» [ P2 F5 Series
» [ ooot
» [ Redtech Co., Ltd.
» [l SIEMENS AG
» [ soLpoT
» [ weidmuller Interface GmbH & Co. KG
L3 E Sensors

Figure 5-9-4 Configuration equipment

[ Topology View [ o U8 MBI Device View| | Option
d¢ [Ex11i2[Ex-1112ProfinetDe | = B é" = |Device0\'en'iew
2 % - Module Rack | ¥ Catalog
- Ex1112 o |<Search>
- b Interface ® | @ Filter Confyumton il [ <Full>
0 » [l Head module
B | ﬂ ~ (@ Module
: = @A
»[mao
9 » [ comm
B 2 » (@O
' - » [@0Q
5 » [ FUNC
» (@ TENP
o
0

Figure 5-9-5 Configuration I/O module

To assign controllers to I/OS in the network view, click Unassigned in the I/O module and
select PLC 1.PROFINET interface 1, as shown in Figure 5-9-6.
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CPU 1214C .

Figure 5-9-6 Assigning IO controllers

= '.Option 10 Controller
 PLC_1.PROFINET Interface

Set the IP address of the I/O module. In the device view, double-click the module to go to the
properties view, as shown in Figure 5-9-7.

X-1112 [EX-1112 Profine

[ Regutar | 10 Variables !System Constant| Toxt |
» Regular
Content Information Ethernet Address
= PROFINET Inferface [X1] ntes
Regular
» Advanced Opli
Identification and Maintenance
w Module Parameters

met: | PNIIE_1

] Add Subnet ]

Parameter Configuration
@ Sﬁttmg mPfﬁJGctIP' Address
ess: [192.168.1 .1 |
i SubnnLMa&k [ 255 . 255 . 255 .0 |

Figure 5-9-7 Assigning IP addresses

To assign a device name to a remote I/O module, right-click the module and choose Assign
Device Name, as shown in Figure 5-9-8. Select the interface type, update the interface list, and
assign the device name, as shown in Figure 5-9-9.
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ey o PROFINET Detvice Nanie

y Configured mmmrrm«»
.! RO Do, (115 =
Device Type: mm | |
_ Ontne v
PR s Tire (R PrAE [l :

“Inre it Nerme T MV | PGPC nferfacer B0 ASi A X88772C US22.0 1o Fast Ethemet Aga. | *) W9/ Gl
Xty sk =
& CopmiY) cic Device Filler:
= PP} Qv | 5 S Qnly Bovioes: of Ths Smmé Type
X Deleie(D) Del | R
N e | (] Oy o devie with ermneoss parametern
s Change To Network Viow 7] tnly show ihe untiied deviee

Canpile 3 ; -

Downboad To The DeviesiLy # Accessilbile Node in Nevwork: ek : - :
p'u..‘@n\mnﬂm ek TP address  MAC Address  Dovce  PROTINGT Deviee Nome  Stahas
B ol : E T = ¥ Usassignf Dovies Name

e “‘Nm.-\»dl)ngumql,}ﬂﬂln | = Lbi

o e e ] [« u _ [3]
[ Export Module Label BarlL} | Updote Last Aasign Kame |
& Properties Alragnter | g

Figure 5-9-8 Assigning device names Figure 5-9-9 Writing device names

Modify the input channel filtering parameters of ex-2XXX series modules. In the overview
view of the device view, right-click the input module and set the input channel filtering time (the
default value is 3ms, and the range can be 0.5-10ms), as shown in Figure 5-9-10.

= W [Module Rack |

| - EX1112 0

| b Interface 0

| EX4014_1 [

& 2 EX5014_1 0

o EX-200H_) 0

EX-300H_1 0

| o

0

= | 0

I 0

| 0

o

L ! 0

EX-200 00t & Attribute | ¥ fomaim u|lﬂD1‘agnosis W

{[Regutar [0 Variables{System Constant| Text |
i Reag talog Tnformation Parameter Configuration ‘i
|
- Module Parameters Channel 0 il
"Parameter Configurati '
Madule Faull Ch 0: Inputdelay: 2 ms [=]
O Address
Channel 1
chi delay: |3 m: [~)

Figure 5-9-10 Configuring filtering parameters of the input module
5. Program download and equipment monitoring

Select all devices in the network view and download, as shown in Figure 5-9-11. After
downloading the program, start the CPU and switch to online monitoring for normal
communication, as shown in Figure 5-9-12.
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ﬁﬁemd{ .3 Comneation| 1M1 Connestion

B EEE s

PLC_1.PROFINET I0-Syste. . o m

EX-1112 Profine....
PLE 1

[PNJIE_1: 192.168. 1631 1

[ 10 System: PLC

[ 4 @ ~ec Ready for Download. LoadingPLC 1" [A
o 1 ¥ Protect Protect system to prevent unauthorized access
_|: Device connected Lo corporate network or directly connected to the
internet must be properly protected to prevent unauthorized access, f=;
]i e.g. lirewall or network segment. For more information about
strial safety. please visit:
I & lutp Swww siemens, comy industrialsecurity
:
{ [v] »  Stop Module Module is stopped after downloading to device. All Stopped
{
{ Q » Device Configuration Delete and Replace Svstem Data in the Target Download to Device
¢
° » Sofiware Download the software to the device Consistent Download
0 » More Infi There are differences between projict settings and PLC programming settings. W] Cover All |
[<] u l

Iﬂlﬂ 1]
cri1214C

PM/IE_1: 19316

B.1:B1

Figure 5-9-12 Equipment monitoring

5.9.2 Connection and Configuration between Step7 smart devices and EX-1112

1. Communication connection diagram, as shown in Figure 5-9-13.
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Programmﬁlg computer
STEP 7-MicroWIN
SMART

CPU ST40
(Dc/DC/DC)

i

Adapter

“ T | EX-4014 | EX-5014 | EX-200H | EX-300H
EX-1112

Figure 5-9-13 Communication connection diagram

2. Table 5-9-2 shows the hardware configuration

Table 5-9-2 Hardware configuration table

hardware Quantity note
. Install STEP7 - MicroWIN
Computer programming 1 SMART
The controller 1 CPU ST40(DC/DC/DC)
EX-1112 1 PROFINET adapter
EX-4014 1 Analog input module
EX-5014 1 Analog output module
EX-200H 1 Digital quantity input
module
EX-300H 1 Digital output module
Ethernet cable A number of

3. Install the GSD file

Open Step 7-Microwin SMART, and choose GSDML Management from the menu bar, as
shown in Figure 5-9-14.
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Tool Help

| GSDML Manager ®
Brief Introduction

“GSDML Manager™ can install and delete GSDML file for PROFINET.

Imported GSDML File

:j i I GSDML2.4-DECOWELL-EX-1112-2022061 0.xml

| 2022:0629 15:34:14 |Normal

Import New GSDML

[K: DesktlopGEDMI-V2 4-DECOWELL-EX-1112% 9 Brows.e' Delete |

0O i

Figure 5-9-14 Installing GSD files
4. Assign the device name

On the menu bar, choose Tools > Find PROFINET Device, select the network adapter
connected to the module in the window and find the device, select the module in the network and
edit its device name, as shown in Figure 5-9-15.

Note:

(@ When you select a NIC, two options are displayed for the same NIC, as shown in the following
figure. Select the NIC without Auto.

Fiealtek PCIe GBE Family Controller. TCPIP. 1

Realtek PCIe GBE Family Controller, TCPIP. Auto. 1

(2) After the device name is assigned, note that the device name must be the same as the assigned
name when configuring the IO module; otherwise, PLC cannot communicate with the IO module
normally.
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IR Rl 2 L

Put Data log  PROFINET || Spart Control Panel — piD SMAR Search
Control Pa.ncl Dnve L‘onﬁgmilm PROFINET Deuue

Search PROFINET Device

Communication interface Press the “Edit” to change the name of the selected device.
|n51x AX88772C USB2.0 to Fast Ethernet Adapter. TCPIP.1 ;; Press the “Flashing Indicator” to keep the LED of the device
flashing so as to independently test the connected device.

L'_ﬂ PROFINET Device MAC Address
= izlg-1112 o |AD:EC:20:!1:54:?A Flash indicalor[
0.0.0.0
1P Address

A R I ]

Subnet mask (code)
0 .0 .0 .0

Default Gateway |
0 .0 .0 .0

Station Name (Chinese, ASCII Characters such as "a™~'z",
“0°-9°, “and “-" which shall not begin with “.", *-” and |
‘port-n (n=0..9)" nor end with *." and *-".

jex-1112 e Setting | |

Converted name: ex-1112

Search Device Ie

Cancel I

Figure 5-9-15 Assigning device names
5. New project and equipment configuration

On the menu bar, choose Tools > PROFINET, select the PLC role as the controller, as shown
in Figure 5-9-16, add the adapter, assign the device name (the same as that assigned in Step 4)
and IP address, as shown in Figure 5-9-17, add the 10 module, as shown in Figure 5-9-18, and
select Generate.

Email:contact@welllinkio.com 2 1 4



EX Series Card 1/0 DELUYYELL

&

TI:\IDisp]a» Gtti'PUt Data log PROFINEI‘

= I

Sport Coutrol Panzl  PID Option
Cunrru] Pnnul mwefud’u;mnun' PROFNETDcucc

PROFINET Network

[E PROFINET:ctmik:
[ comraler{CPU ST40_plc200smart) Introduction

This Guilde Allows You to Configure the PROFINET Network Step by Step.
FROFINET Comfiguration Information Is Generaled and Slored in the Project
and Can Be Used with The Project

PLC Role
Select PLC Role

e ¥ Controlter

I™ Intelligence Device

I FROITNET Tnterface Paramicrers Are Aflocared Ty The Uppet Contrallar

Figure 5-9-16 Selecting PLC roles

PROFINIT Configuration Guidaline x
Metwark Ca
ke {CPU ST20)_plc200smart) 2-PLC $7-200 SMART
[] Ex-1112 Profet DeviceV' 1.0, D-ex-1 ECPUSR20
7 EX-1112 Profinet Device (0] Bl CPUSRI0
7 Fanish B CPUSR40
B CPUSRED
1 112EX:1112 Profinel & cPUSTI
- CPUSTI0
) CPUST40
[ CPU ST60
2-FROFINET-IO
B10
[ DECOWELL
EEFEX-1112
The device table lists all devices currently configured for this PROFINET network.
Devices ean be added from the device content tree an the right b
Dheviee 1ist
Drevice Num! Type Device MNane 1P et TP Address
1 EX-1122 Profinet DeviceV... ex-1112 User Sciing W22
2
3
4
5
6
7
B
< >
sl Dot | |
|
Biuck Naxt I Generats Cancel
< »

Figure 5-9-17 Adding an adapter
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OFT ant oty i
PREFINET Mabword A #1112 Profinet Desiesi 1.0.0
Comrallor{CPU ST20 plcdi0srr) | Clek the ¥Ad" button to add a module for this deviee. Major Modula
EX~1112 Profinet DeviceV 1,0.0ex-1112 EX-1112 Profinet Device
I Ex-1112 Prafinet Device {d) N Module Name |l Kl | Moduls
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|5 11 [Exaois 1 128 EX-3008
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Figure 5-9-18 Adding an I/O module

Moditfy the filtering parameters of the input channel of ex-2XXX series modules. In
PROFINET network, select the DI module to view its filtering time (the default is 3ms, and the
range can be set to 0.5-10ms), as shown in Figure 5-9-19.

H PROFINET Configumtion Guidclin

FHPROFINED Networh

& (CPUST20_ple2otsmart) | This Page Config Each Sub of the Selected Module,
; EX-1112 Profinet DeviceV 1.0)

[l Ex-1112 Profinet Device

ﬁ Ex-m-n(:; 2004 |

Parsmeter Configuration

Chanmel 0

Ch 0: Input delay [Gm =
Chasnel 1

Ch 1- Toput delay [3o.7 o
Chasmel 2

th2 Isput dalw [G, o]
Chasmel 3

Ch 3: Trgut dalwy (3. -
Chanmel 4

Ch 4 Input delay [3r0 +
Chanmel &

Ch 5 Toput delwy [32 o

Chanmel &

Ch & Input dedey [3pe ] o
Back Next Gcmmui Cancel "

Figure 5-9-19 Configuring input module filtering parameters
6. Program download
Choose "PLC" > "Download" in the menu bar, and select "Find CPU" in the communication

window, select the PLC that needs to download the program, and download the program.
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Note: For PROFINET communication using STEP 7-Microwin SMART configuration 200 SMART, the
CPU firmware version of PLC must be >V2.4. For firmware = V2.3, you can directly upgrade the

firmware online. For firmware < 2.3, you must update the firmware with a memory card in the CPU.
5.9.3 Connection and Configuration between Step7 and Ex-1112

1. Communication connection diagram, as shown in Figure 5-9-20.

Programming computer

315-2
PN/DP Step7 V5.6

#Go0E

Adapter

o EX-4014 | EX-5014 | EX-200H | EX-300H
EX-1112

Figure 5-9-20 Communication connection diagram
2. Table 5-9-3 shows the hardware configuration

Table 5-9-3 Hardware configuration table

hardware Quantity note
Computer programming 1 Install Step7 V5.6

The controller 1 315-2 PN/DP

EX-1112 1 PROFINET adapter

EX-4014 1 Analog input module

EX-5014 1 Analog output module

EX_200H 1 Digital quantity input

module

EX-300H 1 Digital output module

Ethernet cable A number of

3. Install the GSD file

After the new project is created, click "SIMATIC300", double-click "Hardware", in the HW
Config window, choose "Options" > "Install GSD file" from the menu bar, as shown in Figure
5-9-21.
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8 SIMATIC Manager - PROFINET
File (F} Edit(E) Insert(Il)y PLC Wiew (V) Option(Q} Window (W) Help (H)

@ R delo % > 6]

Y| 8® mEMIN

Ctrl+Alt+E

Customive(Z)...
Specily Module(Y)...

Configure Networks(N)

Symbal Table(S) Cirl+Alt+T
Report Systenm Ermor(R ).

Edit Content Profile(E)

Update table of Contents{U)

a Insiall HW Updale..

N
Find and Creaie in service (F)...

Created GSDy Files Devices for I Device..(C)

Figure 5-9-21 Installing GSD files

3. New project and equipment configuration

Open SIMATIC Manager, choose New Project from the menu bar, name the project, and
select a path to save the project, as shown in Figure 5-9-22.
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ATIC Manager
PLC View(V) Options(O) Window(W) Help(H)

M

New Project

User Project | Library | Multi-Project]

Name| Storage Path

™ Add Current Multi-Project(A)
Namoe(M) Type(T)
70 9 =

] ™ F Library(F)
Memory Location(Path)(S):

|B:\Stup? V5. 6\sTpro) e Browser(B)... |
Cancel |  Help

Figure 5-9-22 New construction project

Add 300 sites in the project, as shown in Figure 5-8-23.Click the newly added 300 site and
select "Hardware" to enter the HW Config configuration interface, as shown in Figure
5-9-24.Add RACK Reil for RACK 300, as shown in Figure 5-9-25.To add a CPU module, click
HW Config, select CPU315-2 PN/DP VERSION V2.6 of CPU-300 in the right pane, and drag the
CPU module to slot 2 of the rack, as shown in Figure 5-9-26.In the Ethernet interface properties
interface, you can use other IP addresses as required, here use the default IP address and subnet
mask, and select the New button, create a new subnet Ethernet (1) click OK, as shown in Figure
5-9-27.
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BEII‘D‘I’ F 4 .

Cul Ctrl+X
Copy Ctrl+C
Paste Ctrl+V
Delete Del

SIMATIC 400 Site
PLC SIMATIC 3(
SIMATIC H Site
SIMATIC PC Site
Other Sites
SIMATIC S5
PG/PC

MPI

PROFIBUS
Industrial Ethernet
PTP

Foundation Fieldbus

Rename
Object Properties... Alt+Return

: S7 Program L
-

Figure 5-9-23 Adding 300 sites

[
@'cpu 315 -- D:\Step? 7prof\Cpu 315

Hardware

I HW Config - SIMATIC 300(1)
Site(S) Edit (E) Insert(I) PLC View(V) Option(O) Window (W) Help (H)
Dse® & &|ne da @3 R

"

A SIMATIC 300(1) (Configuration) — CPU 315

Figure 5-9-24 The HW Config page is displayed
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Figure 5-9-26 Adding a CPU module to the rack

I}:-'ml.\-u) tihiermed Luerface B- 10 RIBSZ 1)

Raegular Paemision
1P Address; I‘SZ.‘“IL! {
Submer muskleade By |Z§5~ﬁ§255«0
EulneyH):

I b 3% seleeted,

the ne gwailable addrees

Comewny
= Mot use routerly)
L romer addressgL

Addreas{ Ay
Rew ().

Prup s B

D:Iupu 2

x 1 |

=]

E—

i °

Help

o |

Troperiy - ow Subnet Fedestrol Frhgmet

chu]m'l

fierecic)
eIW-FW

Projest Path |

SN
57 Sutner T

%“w " [pasiept vsmeTpronCRu 315

AutheA) |

Creite Thity, 2020-11-20 024811
Lot Modily: 2020-11-20 08:48:11
ol

—~— 10 o | e |

Figure 5-9-27 Adding an Ethernet subnet
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On Ethernet (1), configure the I/O device station. On the right, select EX-1112 and drag it under
the Ethernet (1) subnet, as shown in Figure 5-9-28.

A

Find (F}|
= Profile (P)[Standard
& gy PROFIEVS DF
1 - PROFIBUS-FA
2 E CPU 315-2 PH/DP e = PROFINET I0
X1 || MPIDP =12 Additional Field Davices

i o) Ethornot(1): PROFINET-T0-Susten (100) i =@
f FI Pore i [E ] BLADE I0 Systen
=0 -z
4 = (1) Exch - EO-1112 Frofinet Dovics
§ | - PHZ FS Series
? B (2] VELL-LINE-1,/0
8
]

| B Gateway
=1 e
v =14
i [ Tdent Systens
< 2 51 ] Hetwork Components
@] Sensors
«.I (1)  Ei-1112 | @1 Switching devices
Slot | @ Module . |PONo. .. | [estiks| Note: g ﬁ:ﬁﬁ
[ £r-1112 |02-01-05—1 2047¢ B SDWTIC HE-Station
Fl Inverface i 092 7 [{] SDWTIC FC Based Control 300,400
¥t Pr|[) RFe5 107700 WPivss |eodze @ &, SIMATIC FC Statien
11 p2((] RpE5 107500 Whiere Bz o

Figure 5-9-28 Adding IO to an Ethernet (1) subnet

Add an I/O module, expand the ex-1110 on the right, and drag the EX-4014 and EX-5014 to
the lower slot on the left, as shown in Figure 5-9-29.

Find (E)
= Profile (P)fStandard
: 1 X PROFIBNS OF
1 ~ ¥ EROFIBVS-FA
z TFU 315 2 FH/OF £ B eROFIIET TO
¥ WA £ (] Addi tionsl Field Devices

i Lol Ethernet(l): FROFINET-I0-Systen {100} {10
e Pl [ BLADE 10 Systes
=0 B-1112

3
F @ B | B B2 Profinet Device
5 EH AT

6 R

; -] comt

g

[CRER
“ =g
% |~ [§ Ex-3008
< = [ Ex-3001
[§ Ex-som
duep| (1) Ex-inz 1 [ Ex-soos
== — [§ Ex-3018
Module = PO No. i b Al e 14 MNate: Ml ex-snis
Fr—iiiz 0z-01-05—1 2043% - | [ m-nina
Ll Tazerfoce 2 (W Ex-3100
[l s to/100 MPies 2 in ~[§ Ex-qios
Kt £2| 1} RIS 187560 MBreds - [§ Ex-3u18
1 E—i014 [ Ex-z208
3 [|§ e .- 24 @5 P
EX-200H =] 1BE

[ 0) PRE FS Serins

Figure 5-9-29 Adding an I/O module

To change the IP address of the I/O device station, double-click ex-1112 on the subnet, and
choose Ethernet in the Ethernet property window. You can change the IP address in the Ethernet
property window, as shown in Figure 5-9-30.
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Figure 5-9-30 Changing the MODULE IP address

Set the device name for the I/O module, select the subnet icon, choose PLC on the menu bar,
Ethernet > Assign Device Name, as shown in Figure 5-9-31. In the Assign Device name window,
select the name to be assigned, and press Ok.
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Figure 5-9-31 Assigning device names

To check whether the name is assigned successfully, select the subnet icon, choose PLC on
the menu bar, and Ethernet > Verify Device Name, as shown in Figure 5-9-32.
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Figure 5-9-32 Verifying the device name
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Modify the filtering parameters of the input channel of the ex-2xxx series modules. In the
ex-1112 slot, double-click the DI module to view the filtering time (3ms by default, and the range
can be 0.5-10ms), as shown in figure 5-9-33.
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Figure 5-9-33 Configuring input module filtering parameters

6 Module Application

6.1 Module Configuration

6.1.1 How many 1/0 modules can an adapter support

The number of modules an adapter can support depends on the device master protocol (for
example, CC-Link), the maximum number of I/O extensions of the adapter (the maximum
number of I/O extensions of the adapter is 32 10), the number of input and output bytes of the
adapter (for example, PROFINET input and output bytes are 340 bytes, EtherCAT input and
output bytes are 1024 bytes), Table 6-1 lists the maximum input/output bytes of an adapter. Table
6-2 lists the maximum input/output bytes of an I/O module

Table 6-1 Maximum number of input and output bytes of an adapter

Maximum Maximum
The adapter

Maximum number of input number of
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I/O quantity bytes output bytes
EtherCAT 32 1024 1024
PROFINET 32 340 340
DeviceNet 32 - -
CC-Link 32 128 128
CANopen 32 512 512
PROFIBUS-DP 32 244 244
Modbus RTU 32 512 512
EtherNet/IP 32 504 504
Table 6-2 I/O module input/output bytes
Number of Output
Module type | input bytes bytes
8DI 1 -
16DI 2 -
32DI 4 -
4A1 8 -
8AI 16 -
8DO - 1
16DO - 2
32DO - 4
4A0 - 8
8DO - 16
TC 8 -
RTD 8 -
The encoder 9 5
Positioning
module 5 18
RS232 66 66
RS485 66 66

® To calculate how many IO modules an adapter can carry, the following two equations

must be met:

The NUMBER of I/O modules configured with the adapter is less than or equal to 32.

The number of INPUT and output bytes of the I/O module with the adapter is less than or
equal to the number of input and output bytes specified by the adapter.

® For example, cc-link supports a maximum of 4 x (32DI+32DO+4AI+4A0) for a single
adapter (128 bytes in input / 128 bytes in output).

Note:
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(1) The greater the sum of the input and output bytes of the I/O module, the longer the communication

period between the adapter and the I/O module.
(2) Terminal modules and power modules are not counted in the I/O module count.
6.1.2 Adapter Parameter Setting Problems
® EtherCAT adapter
Current versions of the EtherCAT coupler do not support setting the slave address via dip.
® PROFINET adapter
Assign IP addresses and names, such as TIA Portal and Step7, to the host computer.
® PROFIBUS DP adapter

The communication address is assigned by dip switch, and the baud rate is set by the host
computer, such as TIA Portal and Step7.

® CC - Link adapters

Assigns address and baud rate by DIP switch.
® DeviceNet adapter

Assigns address and baud rate by DIP switch.
® CANopen adapter

Assigns address and baud rate by DIP switch.
® Modbus RTU adapter

Modify communication parameters (such as data bits and parity check) by software, and
assign communication address and baud rate by DIP switch.

6.1.3 Maximum output current of the digital output module
® 8§ do module

The maximum output of a single channel is 500mA. When eight channels are simultaneously
output, the total output current of the eight channels is 2A.

® 16 do module

The maximum output of a single channel is S00mA. When 16 channels are simultaneously
output, the total output current of the 16 channels is 4A.

® 32 do module

The maximum output of a single channel is S00mA. When 32 channels output at the same
time, the total output current of 32 channels is 8A.
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® 8§ RELAY module
Single channel 2A, DC30V/0.5A, AC125V.
6.1.4 Differences between system Power Supplies and 1/O Power supplies

® System power supply: provides power for the communication of the EXTENSION I/O
module.

® [/O power supply: Supplies power to the output channels of the expansion I/O module, such
as digital output and analog output.

6.1.5 Can the output module control the inductive load
® Yes, all transistor digital output modules have continuous diode protection.
6.1.6 DeviceNet Adapter Networking

® The communication terminal of the adapter must be connected to an independent DC24V
power supply.

® You need to configure two terminal resistors, one is the two terminals of the network, the
specification is 121 w, 1/4W.

6.1.7 Whether the Thermal resistance/thermocouple module supports filtering configuration
® Yes. You can configure different filtering levels (0-40) by parameter. The default value is 10.

6.1.8 Analog input module 2-wire / 3-wire / 4-wire connection method

Y ¥ - v i
| Elocoo | {
| L4
ry d ._. 1
Binary 9 stz Quaternary
«f =TI ol =11 T
=T} J=Im 2
= i y au!
=] =] =2
(ST} Tl o1
g ot =1 <=
¥ 131 | = -\ A
8 T -,'->\ h_'f: / [Z T LN
< R B3y (o1

Figure 6-1-1 Analog input 2/3/4 line wiring
6.1.9 EX-1120/EX-1121 Output Hold Settings

® Schneider Machine Expert V2.0 software is configured with EX-1120 output 10 hold, as

shown in Figure 6-1-2.Clear indicates that the output is not held, and Hold indicates that the
output is held.
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Figure 6-1-2 Schneider programming software configuration output hold

® EX-1120 output I/O hold is configured in CODESY'S programming software, as shown in

Figure 6-1-3.

Clear indicates that the output is not held, and Hold indicates that the output is held

¥ 120 x

General

Connect

1. Monitor Data And Control Data 10 10 10

Component

User Parameters

Log

EtherNet/IP 1/O Mapping
EtherNet/IP IEC Object
Status

Information

= Hold or Clear Paramter

<

Connection Name RPI(ms)  O-->T Size(bytes) T-->0 Size (bytes) L

| Add Connection... | | Delete Connection | :_ Edit Comnection... |
Configuration Data

Joriginal Data Valuds] Display Parameter Groups

Parameters Valie Lnit Data Type
= Monitor Data And Control Data

+  Connecting Path Parameter

= Target Configuration Data

Minimum  Mazimum

Figure 6-1-3 CODESYS programming software configuration output retention
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® Ex-1120 output IO hold is configured by Omron Sysmac Studio programming software, as
shown in Figure 6-1-4 and 6-1-5.Clear indicates that the output is not held, and Hold indicates
that the output is held.

I.’(ﬁ!iﬁ_
Del=t= (TH l

il 38 Libeary 1) |

| Link Mume | Lk the 0 bpe  log

Variable Nans | 5.

Figure 6-1-4 Editing ex-1120

e
i _HOH or Clear | {471

sembly Ing | Clear

20001 Qutput Dot

Figure 6-1-5 Omron Sysmac Studio programming software configuration output hold

® The PROGRAMMING software of KV STUDIO is configured with EX-1120 output 1O
retention, as shown in Figure 6-1-6.Clear indicates that the output is not held, and Hold
indicates that the output is held.
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6.2 Common communication exceptions and exclusion methods

6.2.1 EtherCAT Communication is abnormal

Display All v)
Deseription Set whether to hold w:rut if the cyclic communication is
not established, Only valid in special PLC mode,
Default Value 0
Range 0-1
Current Set Value
- Remarks
Result List
Resull Node | NodeName | IP Address | No. | Parameters | Verification Source |

Verification Intention

® Figure 6-2-1 shows the troubleshooting process when the communication with OMron PLC

is abnormal.

‘Whether to Write

EtherCAT Checking Module Whether to power off Check the Network
Communications Configuration P Device Node Address [P and restart > Line
abnormal

Figure 6-2-1 Troubleshooting process
® Ex-1100 adapter indicator

SYS indicator light

System light status instructions

Blinking at long intervals (1HZ)

The system runs normally.

destroy

The I/O module type does not match

1 shine 1 fade

Communication with the I/O module fails

2 Flash 1 Off

The I/O module fails to be configured

Blinking at short intervals (SHZ)

1/O module missing
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6.2.2 PROFINET communication Is Abnormal

® Figure 6-2-2 shows the troubleshooting process when communication is abnormal.

PROFINET Checking Module Check IP Address and Check the Network

Communications __’ Configuration _,’ Device Name __-’ Line

abnormal

Figure 6-2-2 Troubleshooting process

® During module configuration, check whether the host configuration is consistent with the actual
hardware configuration.

® When assigning IP addresses, ensure that the I[P addresses do not overlap with those of other devices
on the network.

® Before downloading the configuration, you must write the device name into the device. The device
name is unique and cannot coincide with other device names on the network.

6.2.3 DeviceNet Communication Is Abnormal

® Figure 6-2-3 shows the troubleshooting process when communication is abnormal.

DeviceNET Is the module inal Check Dial : Check terminal Check Input Output Check the Network
Communications |—p communication termina || Parameter Settings || resistance on both |— Byte Settings ] Line
abnormal connected t(’lﬂ“ye power sides of the network
supply?

Figure 6-2-3 Troubleshooting process
6.2.4 CC-link Communication is abnormal

® Figure 6-2-4 shows the troubleshooting process when communication is abnormal.

CC-link Checking Module Check Input Output | Check the Network

Communications =N Configuration f—z| Byte Settings | —gs] Line

abnormal

Figure 6-2-4 Troubleshooting process
6.2.5 Modbus RTU Communication Is Abnormal

® [f the communication is abnormal, the troubleshooting process is shown in Figure 6-2-5

Modbus RTU Check whether Check the Network
Communications communication Line
abnormal ’ parameters are consistent ’

Figure 6-2-5 Troubleshooting process
6.2.6 EtherNet/IP Communication Is Abnormal

® Check for abnormality of Keens EtherNet/[P communication:
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EtherNET/IP Whether IP address Configuration and | EX-1120 whether the Mode configured to 1
Communications . conflict . Actual Module B . mode is set to 1 E requires power outage
abnormal Model/Number ' and restart

Figure 6-2-6 Troubleshooting flowchart for Keens EtherNet/IP

® Fault diagnosis of EtherNet/IP based on CODESYS software platform (including Omron, Schneider,
Huichuan) communication:

EtherNET/IP Whether IP address . Configuration and
Communications . conflict ’ actual module byte size
abnormal

Figure 6-2-6 Troubleshooting process for EtherNet/IP of other manufacturers
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6.3 Using Modules

6.3.1 Encoder Module

® In the encoder module, there are three signal types: differential, NPN and PNP, but the
modules are used in the same way. The input and output are shown in Table 6-3-1, and the
basic configuration process is shown in Figure 6-3-1.

Table 6-3-1 Input and output channels of the encoder module

No. Channel name Channel type| Data type description
1 Set Initvalue Enable Output BOOL | Setting the initial value
2 Z Phase Enable Output BOOL Z-phase enabler
3 Counting Direction Output BOOL Counter direction
4 Count Enable Output BOOL Count enabler
5 Latch Enable Output BOOL Lock-in enabler
6 Initial Count Value Output UDINT Initial count
7 Latch Signal Input BOOL Latch signal
8 Count Value Input UDINT count value
9 Latch Value Input UDINT Latch value
10 Temperature Alarm Input BOOL Temperature alarm
11 Voltage Alarm Input BOOL Voltage alarm
. gg;r::;;; . Y Count enabler L l\g{itﬁr
I | I
I I I
| | I
Setting the initial value Counter direction count value
Z-phase enabler Lock-in enabler Latch value
Latch signal

Figure 6-3-1 Basic configuration process
6.3.2 High-speed pulse output module

® In the high-speed pulse output module, there are three signal types: differential, NPN, and
PNP, but the modules are used in the same way. The input and output are shown in Table
6-3-2 and the basic configuration process is shown in Figure 6-3-2.
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Table 6-3-2 Input and output channels of high-speed pulse output module

No. Channel name Channel type| Data type description
1 Direction Control Output BOOL Direction control
2 Inching Enable Output BOOL dot mode enabler
3 Inching Control Output BOOL Inching operation
Location mode enabler
4 Location Enable Output BOOL
Positioning operation
5 Location Control Output BOOL Emergency stop
6 Emergency Stop Enable Output BOOL Pulse direction
7 Direction Pulse Mode Output BOOL CW/CCW mode
8 CW/CCW Mode Output BOOL Orthogonal mode
Positive and negative
9 Orthogonal Mode Output BOOL
orientation
10 Negative[0] Or Positive[1] Logic Output BOOL Slope start
11 Ramp Enable Output BOOL Initial pulse frequency
12 Start Pulse Frequency Output UDINT Pulse output frequency
13 Output Pulse Frequency Output UDINT Locating pulse number
14 Location Pulse Output UDINT Acceleration Time
15 Ramp Increase Time Output UINT Deceleration time
) Locate the complete flag
16 Ramp Decrease Time Output UINT =
1t
17 Location Finish Flag Input BOOT Operating status bit
Pulse output feedback
18 Operation Status Flag Input BOOT
number
19 Location Or Inching Pulse Feedback Input UDINT Temperature alarm
20 Temperature Alarm Input BOOL Voltage alarm
Primary parameter is
21 Voltage Alarm Input BOOL
invalid
22 Master Station Parameters Ilegality Input BOOL Pulse output fault
23 Pulse Output Failure Input BOOL Direction control
confiuraion || Mode choce Diccionconsal || Mo

| I

[

|

Pulse mode Inching mode

Inching operation

Operating status bit

Acceleration/decelerati

Positioning mode
on time

Positioning operation
Positioning pulse

Pulse output feedback
number

Pulse output frequency
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Figure 6-3-2 Basic configuration process

® Figure 6-3-3 shows the process for configuring the control mode

| Direction pulse M Acceleration/deceleratio H Pulse output feedback H dot mode enabler I
et number

| Motor inversion H Direction control |<_| dot operation l

motor rotating

Figure 6-3-3 Dynamic mode configuration process

® Figure 6-3-4 shows the process for configuring the location control mode

| Direction pulse I_’l Acceleration/decelerati]_’ Pulse output frequency H dot mode enabler I
on time

dot pulse number
Reverse operation Positive and negative positioning operation
positioning direction

Figure 6-3-4 Configuration of the positioning control mode
6.3.3 EX-6311/6301 Free communication module use
® There are four modes of module communication:
(1) Send-rev mode: trigger mode and receive data at character intervals.
@ Send-send mode: trigger sending mode;
(3 Rev-send mode: triggers the sending mode and receives data at character intervals.
@ Rev-rev mode: Receive data at character intervals.

® Table 6-3-3 lists the communication parameters

Table 6-3-3 Communication parameters

Parameter
parameter name . parameter
meaning
1200/2400/4800/9600 (default) / 19.2 K/ 38.4 K
BaudRate Baud rate
/576 K/1152K

Data Bits Data bits 5 bit /6 bit /7 bit /8 bit (default)
Parity Bits Check digit None Check (default)/parity check/even check
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Stop Bits

Stop bit 1 bit (default) /2 bits

Interval Time

Automatic timing | Timing send interval from 50ms to 10s optional
sending function (1s by default)

Comm Mode

Communication
. M/S (master/slave), default master mode
mode selection

Note: Parameter Settings need to be configured before the module runs. For example, if you use

TwinCAT, set the parameters in Startup.In OMROM software, the corresponding module needs to be

found and set in the edit initialization parameter setting of the module.If no operation is required, use the

default value.

® Process data - Output

data

The output data length is 66 bytes. The first two bytes are data length and control word

respectively, and the last 6

4 bytes are data bytes, as shown in Figure 6-3-5.

B e1 | Byte2
Data Control
length word Data

Figure 6-3-5 Process data - Output data

The data length and the meanings of single bits in the control words are shown in Table 6-3-4.

Table 6-3-4 Data length and control words

The The .
Bit
name of length o
definition
the of the
The . .
The length of the data is N, and the maximum value of N
length of | 1 byte - )
is 64
the data
TxE starts sending flags
When TxM =0, it is the trigger mode. At this time, only
when TxE changes from 0 to 1 (rising edge), a sending
is triggered.
Bit0 Automatic send mode when TxM=1
Control b In this case, only when TxE is 1, the module
e
word vt automatically sends packets continuously according to
the Automatic sending Interval specified in the
configuration information.
TxM sending mode
Bitl TxM=0: triggers the sending mode
TxM=1: automatic timing sending mode
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Relen receives by length

Relen =0 Received by character interval: 3.5 consecutive
characters (with baud rate, number of characters, and
Bit2 check whether or not) after a character is received

When the next character is not received, the packet is
considered to be closed

Beam.
Bit3 Channel 0:0
Bit4 keep
Bit5 keep
Bit6 Set_re forcibly waits for receiving

Bit7 Set_tr Forcibly sets the receive completion/send permit
i
status

Table 6-3-5 describes the Bit0 and Bitl modes in the control word.

Table 6-3-5 Control word Bit0 and Bitl modes

. . Delivery instructions
Bitl state Bit0 state

mode

0 The 0-1 Trigger mode Complete a send

0 0 Trigger mode Don't send

! ! Automatic According to Auto Send Interval,
mode automatic continuous sending is enabled

{ 0 Automatic Don't send
mode

The mode definitions of Bit6 and Bit7 in the control words are shown in Table 6-3-6.

Table 6-3-6 Control word Bit6 and Bit7 mode definitions

. State of .
Bit7 state . function
Bit6

1 0 Set_tr: Force reok TREn =1, so that RS485 is in the
receiving complete/sending allowed state

0 { Set re: Force REok tren =0 to make RS485 in the waiting
for receiving state

1 1 No role

0 0 No role
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® Process data - Input data

The input data length is 66 bytes. The first two bytes are data length and communication status
respectively, and the last 64 bytes are data bytes, as shown in Figure 6-3-6.

Data Communic

lengt aton status Data

Figure 6-3-6 Process data - Input data

For example, if the received data is 04 01 01 02 03 04, the data length is 4 bytes. The
communication status is receiving completed or sending allowed. The received data is 01 02 03
04.

Table 6-3-7 shows the data length and the meaning of a single bit of the communication status
word.

Table 6-3-7 Data length and communication status words

Bit
definition

name length

The length of The length of the data is N, and the maximum value of N
1 byte - .
the data is 64

Reok tren Receiving completed or sending allowed
Reok tren =1: The RS485/RS232 interface is in the
Bit0 receiving complete/sending Allowed state.

Reok tren =0: The RS485/RS232 interface is in waiting
state.

Tr_ing is sending

Tr_ing =1: The RS485/RS232 interface is sending data.
Tr_ing =0: THE RS485/RS232 interface is not sending
1 byte data.

Re_ing is receiving

Re ing =1: The RS485/RS232 interface is receiving

Bitl

Communication

status

Bit2 data.
Re ing =0: The RS485/RS232 interface is not receiving
data.

Bit3 keep

Bit4 keep

Bit5 keep
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Bit6 keep
Bit7 keep

The Bit0, Bitl, and Bit2 modes in the communication status word are defined as shown in Table
6-3-8.

Table 6-3-8 Definition of Bit0, Bitl and Bit2 modes in the communication state word

Bit2 state Bitl state Bit0 state function

RS485 is in the state of "receiving
completed/sending allowed". If TxE starts from
0 0 1 0 to 1, RS485 switches to D2D1D0=010, that is,
data in the output data area is sent to
RS485/RS232 equipment.

RS485/RS232 packets are being sent to the

0 1 0 )
RS485 device.
RS485/RS232 is in the waiting state, that is,
0 0 0 waiting to receive data packets from the
RS485/RS232 device.
! 0 0 RS485/RS232 receiving packets from the
RS485/RS232 device.

® Module operation mode
@ Send_Rev mode :(trigger mode, receive at character intervals)

(1) The module is powered on (configuration information is in main mode by default), D2D1D0
of Status byte =001, and the RS485 interface is in receive completed/Send Allowed state.

(2) Control byte = 0x0801, trigger mode, start sending mark, according to character interval,
channel number 0,TxE start sending mark changes from 0 to 1, rising edge sends 8 bytes of data;

(3) D2D1D0=000 in status byte, the status word is 0, and the RS485 interface is in the "Waiting
for receiving" state.

(4) Module status STATUS D2D1D0 of BYTE is 001, and the RS485 port is in the receive
completed/Send Allowed state.

(5) The master station waits for D2D1DO0 of Status byte =001 and the module is in the "receiving
completed/sending allowed" state before sending the next operation.

(6) Go to Step 1.
@ send-send mode :(trigger sending mode)

(1) The module is powered on (configuration information is in main mode by default), D2D1D0
of Status byte =001, and the RS485 interface is in receive completed/Send Allowed state.
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(2) Control byte = 0x0801, trigger mode, start sending mark, according to character interval,
channel number 0,TXE start sending mark changes from 0 to 1, rising edge sends 8 bytes of data;

(3) D2D1D0=000 in status byte, the status word is 0, and the RS485 interface is in the "Waiting
for receiving" state.

(4) The master station detects the communication state word D2D1D0=000, and the strong
control word D7d6 =10, namely set tr=1,

Set_re = 0;Make the bus bridge enter the state of "receiving completed/sending allowed", and the
communication status word D2D1D0=001.

(5) Master station recovery control word D7 D6=00;
(6) Go to Step 1.
® rev-send mode :(Triggering the sending mode and sending at character intervals)

(1) The module is powered on (the configuration information is changed to slave mode), and the
communication status word D2D1D0=000, that is, recOK_TREn =0;Waiting for receiving state;

(2) When the RS485/RS232 interface finishes receiving packets, the communication status word
D2D1D0=001, namely reOK_TREn =1;Receiving completed/sending allowed status;

(3) master station start send TxE start send mark from 0 to 1, control word control byte = 0x0801,
trigger mode, according to character interval close, channel number 0,TXE start send mark from 0
to 1, rising edge send 8 bytes of data;

(4) D2D1D0=000 in status byte, the status word is 0, and the RS485 interface is in the waiting for
receiving state.

(5) Go to Step 1
@ rev-rev mode :(Receive at character intervals)

(1) The module is powered on (the configuration information is changed to slave mode), and the
communication status word D2D1D0=000, that is, recOK TREn =0;Waiting for receiving status.

(2) When the RS485 interface finishes receiving packets, the communication status word
D2D1D0=001, that is, REOK TREn =1;Receiving completed or sending allowed status.

(3) The master station detects the communication state word D2D1D0=001, and the strong
control word D7D6 =01, that is, set _tr=0,

Set_re =1, make RS485/RS232 enter "waiting for receiving" state;
(4) Master station recovery control word D7 D6=00;

® Figure 6-3-7 shows the process for using the EX-6301 with the serial port Debugging
Assistant.
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Configure ex-6301
parameters such as baud rate,
data bit, parity bit, and stop
bit

—>

Configure serial debugging
assistant parameters (baud
rate, data bit, parity bit, stop

PLC sends data: -04 01 01 02
03 04

—

bit)

The serial port receives the
following data :0102 03 04

Figure 6-3-7 Usage process
6.3.4 TIA Portal Configures ex-6321 modules

The serial assistant sends data:
0401010203 04

Data received by PLC :04 01
010203 04

After ex-1110 is configured on the TIA Portal, add ex-6321 (Modbus RTU Master module) to

the slot, as shown in Figure 6-3-8.

& Topology View |y Network View |} Device View| | Option
i [oec 1 [ex111g] SRR A EE | e | Devios Orvericn: |
W Module - [Rack Slot |1 Address { Addss Type | ¥ Catalog
v DEC o 0 eern | B ]
74 ;K_’:;c: 1 g ?M 113 LT ::fs L T
& £ e = | +La Module
e e T = vima
_ v g Ao
= i
-
» [@Hsc
L R 1)
» [ FELAY
| » (@ Rs232
- (@ rsans

\ MRLEx 30!
» [ ROIC

» m Front End Modile

Figure 6-3-8 Configuration of the EX-6321 module

To configure ex-6321 communications parameters, right-click module in the slot and choose
Properties to set communications parameters, as shown in Figure 6-3-9.
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; =
¥ cu Ty Culex 4 |
1 Copy (Y) CulsC 3 5 |
Tz Puste (P) culsv § 6 [
i % Delete (D) el D 7 =
£ Renare (N} F2 B 2
n : B 9
L
- -] 10
] 11
*h 12
Download to Deviee (L] ¥ 5 13
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- I T ,
b
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; b
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= 1'trm e Dhevive View
Catalog Information Module
e 2 T
10 i +| 9500bps -
Data Bits: |8 |
! Farytis: [ione B
‘ stopais: [1bit [~}
E] Response Tmecut Low: [232 i
| Response Timeout High: |3 i
Char Pitch: |Schars [=]

Table 6-3-9 lists the configurable parameters of ex-6321, such as baud rate, parity check, stop

Figure 6-3-9 Configuring ex-6321 communication parameters

bit, and communication timeout

Table 6-3-9 Definitions of communication parameters

The
serial parameter instructions
number
1 BaudRate Baud rate Users can choose standard baud rate
2 Data Bits Data bits Fixed for 8 bit
3 Patity Bits parity This parameter is configurable by default
4 Stop Bits Stop bit The default value is 1 bit
For example, if the communication
5 Reapons Timeout | Timeout low timeout is 1000ms, it is converted to
Low bytes hexadecimal 0x03E8, whose decimal
value is 232
For example, if the communication
6 Reapons Timeout | Timeout high timeout is 1000ms, it is converted to
High byte hexadecimal 0x03E8. The decimal value
of 03 is 03
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7 Char Pitch

Characters in The default value is Schar, which is

length

configurable

EX-6321(Modbus RTU Master module) address assignment table in case 6-3-8, as shown in

Figure 6-3-9.

Output area (Q area)
No Address Description Note
0 —1: data is sent
1 Q1.0 Data sending
1 —0: sending is disabled
2 QW2 Modbus RTU Slave station 0-255
. Supported Function
3 Qw4 Modbus Fuction code
code :01/02/03/04/05/06/15/16
4 QW6 Slave station Depository Address 0-65535
5 QWS The length of data read or written Length value: 1-4
6 QW10 The master station sends data #1
7 QW12 The master sends data #2
Valid only for register writing
8 QW14 The master sends data #3
9 QWI16 The master sends data #4
input area (I area)
No Address Description Note
1 11.0 Send complete flag bit 0—1: Data is sent
2 11.1 Receive completion flag bit 0—1: Data is received
Modbus RTU returns from the Returns the slave address
3 w2 secondary address
Modbus RTU communication error 0: The communication is normal
4 w4 code from
5 IW6 The station returns data #1
6 W8 Return data #2 from the station
7 IW10 Return data #3 from the station
8 IW12 Return data #4 from the station

Figure 6-3-9 Address allocation table

For example, read Modbus RTU slave station #1 register 400001/40002/40003/40004:

QW2, QW4, QW6, and QWS correspond to 01 03 00 04

Then set Q1.0 to TRUE

In IW6/ITW8/IW10/IW 12, you can view the data of register 40001/40002/40003/40004.
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For example, write data to Modbus RTU slave station #2 register 40010/40011/40012/40013
to 100, 3000, 80, 300 respectively:

QW2 QW4 QW6 QW8 QW10 QW12 QW14 QW16 The corresponding data is 01 16 00 04 100
3000 80 300

Then set Q1.0 to TRUE
Note: Q1.0 pin from 10, IW6/IW8/IW10/IW12 data will be automatically cleared

6.3.5 TwinCAT3 configuration EX-6321

After TwinCAT3 is enabled, configure ex-1100, and add ex-6321 to the slot, as shown in
Figure 6-3-10.

« @wo
= ”‘]:; Devices
4 =% Device 1 (EtherCAT)
2% image
2 Image-Infa
b 2 SyncUnits
b Inputs
b Wl Outputs
b @ InfoData
« W Box1(EX-1100]
4 B Moduls 1 [EX-5321)
4 RHFDO
% Modbus Data Send Flag
* Modbus Data Recsive Flag
# Modbus Slave Station Num
# Modbus Error Code
# Dataln0
# Dataini
% DatzIn2
# Datain3
4 W TXPDO
&+ Send Enabls
W Slave ID
B Function
K- Address
B Coil Or Register Quantity
B Datz Out 0
E- Dota Out 1
B Data Our 2
Er Dats Cut 3

Figure 6-3-10 Configuration of the EX-6321 module

To configure ex-6321 communication parameters, double-click Box 1 (EX-1100) > StartUP,
right-click the blank area, and choose Add New Item. In the StartUP parameter window, select
EX-6321 to set communication parameters, as shown in Figure 6-3-11.
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Figure 6-3-11 Setting ex-6321 communication parameters

Table 6-3-10 lists the configurable parameters of ex-6321, such as baud rate, parity check,
stop bit, and communication timeout

Table 6-3-10 Definitions of communication parameters

The

serial instructions

parameter

number

1 BaudRate Baud rate Users can choose standard baud rate
2 Data Bits Data bits Fixed for 8 bit
3 Patity Bits parity This parameter is configurable by default
4 Stop Bits Stop bit The default value is 1 bit
5 Reapons Timeout timeout Communication timeout value, in ms

. Characters in The default value is Schar, which is
6 Char Pitch

length configurable

Table 6-3-11 describes the functions of the EX-6321 INPUT and output addresses

Table 6-3-11 Functions of the INPUT and output addresses and their descriptions

parameter

instructions

Output area (Q area)

The
serial

pin

instructions

note
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number
0 to 1: data is sent
1 Send Enable Data sent L
- 1 to 0: sending is disabled
2 Slave ID Modbus slave address 1-255.
S rt functi de:
3 Funtion Mdobus function code HPPOTt FuRietion code
01/02/03/04/05/06/15/16
4 Address Slave register address 0-65535.
Coil Or Register The length of data read or
5 ) i Length value: 1-4
Quantity written
The master station sends
6 Data Out 0
data #1 Valid only f ist
Data Out 1 The master sends data #2 andon y .or regtster
writing
Data Out 2 The master sends data #3
Data Out 3 The master sends data #4
Output area (I area)
The note
serial pin instructions
number
Modbus Data Send . .
1 Send complete flag bit 0 to 1: Data is sent
Flag
Modbus Data Receive completion flag ) )
2 . . 0—1: Data is received
Receive Flag bit
Modbus RTU returns
Modbus Slave
3 ) from the secondary Returns the slave address
Station Num
address
Modbus RTU 0: The communication is
4 Modbus Error Code L.
communication error code normal
Return data #1 from the
5 DataIn 0 .
station
Return data #2 from the
6 Dataln 1 ) )
station The read slave register data
Return data #3 from the 1s returned
7 Data In 2 .
station
Return data #4 from the
8 Dataln 3 .
station

For example, read Modbus RTU slave station #1 register 400001/40002/40003/40004:

Slave ID --"1"

Funtion - 03 (03 Function Code Reading)

Address - "00" (start Address 40001 corresponds to Address 0)

Coil Or Register Quantity -- 04
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Send Enable -- TRUE (Sending data)
The data returned from station #1 in register 40001/40002/40003/40004 are stored in:
Data In 0, Data In 1, Data In 2, Data In 3.

For example, write data to Modbus RTU slave station #2 register 40010/40011/40012/40013
to 100, 3000, 80, 300 respectively:

Slave ID --"2"

Funtion - 16 (03 Function Code Reading)

Address - "00" (start Address 40001 corresponds to Address 0)
Coil Or Register Quantity -- 04

Data Out 0-100

Data Out 1 -- 3000

Data Out 2 -- 80

Data Out 3 -- 300

Send Enable -- TRUE (Sending data)

Note: Send_Enable pin from 10, Data outl-out4 Data will be cleared automatically
6.3.6 Setting the IP address of the EX-1121 Adapter

The DIP codes for the EX-1121 adapter are defined as follows:

IP Address
Hundred
Bitsx100

1P Address ten

<10

IP Address L
*Bitx 1

Figure 6-3-12 DIP switch of the EX-1121 adapter

Dip switch definition

Three combination

IP address setting method

dip set values
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0 Set through BOOTP.
001-254. Set the low 1byte of the IP address by turning the switch.
The module status indicator (MS) is blinking red because the
More than 255 ) .
Settings are incorrect
(1) Through BOOTP

When setting the IP address through BOOTP, the three DIP switches of the adapter must be 0
before power-on. Run the IP Seting Tool software to scan for the online EX-1121 adapter, as
shown in Figure 6-3-13.To configure the IP address of the module, double-click the EX-1121
adapter that needs to be configured with an IP address and configure the IP address, as shown in
Figure 6-3-14.After the IP address is set, the software prompts that the IP address is set, as shown
in Figure 6-3-15. Figure 6-3-16 shows the process for setting an IP address through BOOTP.

Note: When the IP address is first set in BOOTP mode, the three DIP switches must be 0.When an IP
address has been set through BOOTP, the IP address is set through the rotation switch along with
the high byte of the IP address set through BOOTP, and the low byte of the IP address becomes the
set value of the rotation switch.

B3 1P Setting Tool - O X
File (T) Communication (CC) Set (8) Language(l.) Telp (TT)

[Status]  MAC Address | Device Name [ 1P Address | Next Power Supply v IP Adddres
@ ADIEC:20:11:60:99 EX-1121 (EtherNet/IF) [Tnset | BOOTP Start > L o

CIDetailed Display(D)

Figure 6-3-13 Scanning EtherNet/IP devices
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E IP Setting Tool — O X
b Comnmunication (C) Set (S) Language(L) LHelp (1)
Next Power Sup I Address
3OOTP Start ?SE[(D”‘ )
IP Address Setting ‘—M'
Please Set [P Address # 1P Device (..
MAC Address AD:EC:20:11:60:99
Device Name EX-1121 (EtherNet/IF)
CPU Name (Options (HJ|
TP Address Setting for
Next Power Supply (N) J Lo
| Searh Bk TP Addes ).
[ Details (D) Exit (X)
Figure 6-3-14 Setting the IP address
B 1P Setting Tool — O X
File (T) Communication (CC) Set (8) Language(l.) Telp (TT)
IP Address
Set (D...
IP Setting Tool [ A Scan EtherNet/ | Scan EtherNet/
* Device (A)..,
The IP address is set.
Ifthe next power is ON, the [P address is not set to “fixed [P start”_ the IP
address will be initialized when the power is OFF.
If you use an EtherNet/IP machine, start the [P address setting dialog hox
again as needed, and change the IP address setting methed to “fixed IP
O Detailed Display(D) Exit (X)
Figure 6-3-15 IP address setting completed
The three DIP switches are . Set the DIP switch combination to Set the COMBINATION of DIP
UP Steing Tool IP address fc : !
rovonandtt | ) 2okt s E| g Jo epoue o tien |y f st Setins b Afer e sty
192.168.1.225 192.168.1.156
Figure 6-3-16 Setting the IP address using BOOTP
(2) Set by dip switch

Set the IP address using dip switches. The combination of the first three DIP switches is not 0
(1-254). Start the IP Seting Tool software and scan for the online EX-1121 adapter, as shown in
Figure 6-3-17.To configure the IP address of the module, double-click the EX-1121 adapter to be

250
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configured with an IP address and configure the IP address, as shown in Figure 6-3-18.After the
IP address is set, the software prompts you that the IP address is set, as shown in Figure 6-3-19.
Figure 6-3-20 shows the process for setting an IP address through BOOTP.

Note: The PC IPv4 network segment must be in the same network segment (192.168.0.x) as the
EX-1121 adapter when you first set the IP address using the DIP switch.

B e setting Tool — O x
File (T') Conmuication () Set (S)  Language(l) elp (1)

|Status|  MAC Address Device Name [ 1P Address | Next Power Supply v IP Addres
@  ADIEC:20:11:60:99 EX-1121(EtherNet/IF) 192.168.0.222 Fixed IP Start %’R

[IDetailed Display(D)
Figure 6-3-17 Scanning EtherNet/IP devices
B e setting Tool — O x
K] 1 y  Comnmunication (C) Set (S) Language(L) Help (1)
? i A:Idr:ss
Scan EtherNet/
3 TP Device (A @A)
MAC Address ﬁ:ﬁ::m:u:w:w
Device Name EX-1121 (EtherNet/IF)
P hlkes (earsd)
CPU Name (Optional) (H) |
IP Addres f
= s Selting %lmnﬁm
[ Details () Exit (X)

Figure 6-3-18 Modifying the module network segment
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B e Setting Tool — O X
File (F} Communication (C) Sat (8) Language(l) Halp (H)

1P Address

Set (1)...

[ ﬂ Scan EtherNet .
1P Device (A)...

Retry(R) || Shu($)

Find Fmpty IP Address (7)) |

[ Details (D) Exit (X)

Figure 6-3-19 IP address setting completed

The combination of the three DIP switches is IP Steing Tool Set the IP address segment Set the DIP switch combination to 225. If E
not 0(1254), and the system is powered on of the module to 192.168.1.x the power is off and the system restarts,
and restarted (default network segment: {5 ] the IP address of EX-1121 is ]
192.168.0.x). 192.168.1.225

Figure 6-3-20 Setting the IP network segment using DIP switches

The Appendix

1. Modbus address table of ex-1030 module

Register Data area Description
address
0x0000 | Input process | Input process
0x00FF | data area data area
Output
0x0800 Output process
process data
0x08FF data area
area
MODBUS .
0x1000- L The character is ex-1030. Unused characters are filled
indicates the )
0x1006 with 0
name
Read-only
] ) Software o )
0x1007 | diagnostic . A value of 0x1000 indicates version V1.0.0.0
Version number
data area 1
Hardware
0x1008 . Same as above
Version number
0x1009- keep
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0x100E

0x100F

0x1010

RTU coupler
status

Bit0 is the local bus state (a value of 1 indicates that
the local bus is abnormal)

Bitl5 is the fieldbus state (a value of 1 means
watchdog times out)

Other bits reserved

0x1011

Slave status
(high 1 byte)
Number of slave

stations (low 1

byte)

Slave state:
0-Connect
to normal

1- Disconnect from the station

0x1012

The total byte
size of the data
area occupied
by the analog

output

For example, if a 4-channel AO module is connected
and a single channel occupies 2 bytes, the value of this

item is 8

0x1013

The total size of
the data area
occupied by the
analog input in

bytes

For example, if a four-channel AI module is connected
and a single channel occupies 2 bytes, the value of this

item is 8

0x1014

The total size in
bytes of the data
area occupied
by the digital

output

If the 8-channel DO module is connected, the data
should be 1 byte

0x1015

The total size of

the data area

For example, if a 7-channel DI module is connected,

0x1016

occupied by the | the value of this item is 1 byte. If the value is less than
digital input in 8 bits, the value is 8 bits

bytes

Current

watchdog time

It can be set by dip switch or address 0x2000

0x1017

0x1035

ms
Module ID(2 bytes). Each model has a unique ID. If

The topology of ) C .

) 10 exists, the module ID is displayed; if no module
exists, 0 is displayed.

The topology of

) Same as above

The topology of

1 Same as above
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Read Set watchdog
0x2000 (0x03)/write | time ms. The maximum support is 65000MS and the minimum
X
(0x10) Watchdog is unit is 100ms.
configuration | disabled by 0 indicates that the watchdog function is disabled
data area factory default
The watchdog ) .
You must use function code 06 or OF and write the
0x2001 resets the
. value 0OXxAEOQ]1 first and then 0XxAE02
register
0-Indicates packet watchdog (default)
0x2002 Watchdog type 1-Indicates that the watchdog writes packets
See Note 1
0-No check
0x2003 Check digit 1-Odd parity
2-Parity checking
1-1 stop bit
0x2004 Stop bit po
2-2 stop bits
Ms (default 0, depending on baud rate, other values
0x2005 Frame end time ( P g i
such as 1, Ims, maximum 10ms)
Note 1:
Guard dog

The watchdog is disabled in factory Settings.The watchdog can be enabled by writing time (say 1000ms) to
address 0x2000.The watchdog registers (0x2000, 0x2002) are written and restart to take effect. The data in this
register is reserved.

After receiving the request packet for the first time, the watchdog timer is started. After receiving the request
packet, the watchdog timer is triggered again.In the second method, after the first telegram is written, the
watchdog timer starts and is triggered each time a written telegram is received from the device.To do this, write
1 to register 0x2002(default "0").If the slave's watchdog timer has expired, it can be rewritten by writing twice
to register 0x2001.This must be written to the register by function code 06 or OF :0xAE01 0xAE02.

Note 2.
All configuration data areas except reset watchdog register (0x2001) Settings do not need to be powered off, all

other Settings need to be powered off to take effect.

2. Order information of remote 10 products

Product o The order
The product description
model no.
The adapter
EX-1010 DeviceNet adapter 02-01-01
EX-1130 Modbus TCP adapter 02-01-07
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EX-1030 Modbus RTU adapter 02-01-03
EX-1100 EtherCAT adapter 02-01-04
EX-1110 PROFINET adapter 02-01-05
EX-1112 PROFINET adapter 02-01-05-1
EX-1040 CC - Link adapter 02-01-06
EX-1120 EtherNet/IP adapter 02-01-08
EX-1121 EtherNet/IP adapter 02-01-08-1
EX-1140 CC-link IE Filed Basic 02-01-09

Digital input module

compatible

EX-2008 8 channel digital input module NPN type 02-02-01

EX-2108 8 channel digital input module PNP type 02-02-02

EX-200H 16 channel digital input module NPN type 02-02-03

EX-210H 16 channel digital input module PNP type 02-02-04
32 channel digital input module NPN&PNP

EX-2C0S 02-02-05

Digital output module

accuracy 0.1%

EX-3008 8-channel digital output module NPN type 02-03-01
EX-3108 8 channel digital output module PNP type 02-03-02
EX-300H 16 channel digital output module NPN type 02-03-03
EX-310H 16 channel digital output module PNP type 02-03-04
EX-3208 8 channel relay output module 02-03-05
EX-300S 32 channel digital output module NPN type 02-03-06
EX-310S 32 channel digital output module PNP type 02-03-07
Analog input module
EX.4014 4-channel analog input module 0-10V 12-bit 02-04-01
accuracy 0.1%
4-channel analog input module 0-5V 12-bit
EX-4014 02-04-02
accuracy 0.1%
4-channel analog input module £10V 12 bit
EX-4114 02-04-03
accuracy 0.1%
4-channel analog input module +5V 12-bit accuracy
EX-4114 02-04-04
0.1%
4-channel analog input module 0-10V 16-bit
EX-4054 02-04-05
accuracy 0.02%
4-channel analog input module 0-5V 16-bit
EX-4054 02-04-06
accuracy 0.02%
4-channel analog input module £10V 16-bit
EX-4154 02-04-07
accuracy 0.02%
EX4154 4-channel analog input module +5V 16-bit accuracy 02-04-08
0.02%
4-channel analog input module 4-20mA 12-bit
EX-4414 02-04-09
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4-channel analog input module 0-20mA 12-bit

accuracy 0.1%

4 channel thermocouple (TC) input module (2 wire)

EX-4414 02-04-10
accuracy 0.1%
4-ch 1 analog i le 4-20mA 16-bi
EX4454 channel analog input module 4-20 6-bit 02-04-11
accuracy 0.02%
4-channel analog input module 0-20mA 16-bit
EX-4454 02-04-12
accuracy 0.02%
8-channel analog input module 0-10V 12-bit
EX-4018 02-04-29
accuracy 0.1%
8-channel analog input module 0-5V 12-bit
EX-4018 02-04-30
accuracy 0.1%
8 channel analog input module £10V 12 bit
EX-4118 02-04-31
accuracy 0.1%
8 channel analog input module £5V 12 bit accuracy
EX-4118 02-04-32
0.1%
EX4418 8-channel analog input module 4-20mA 12-bit 02-04.33
accuracy 0.1%
8-channel analog input module 0-20mA 12-bit
EX-4418 02-04-34

Thermocouple (TC) input module

EX-4754

system) voltage measurement

4 channel thermal resistance (RTD) input module 2
wire or 3 wire (default 3 wire) PT100

EX-4654 02-04-13
TYPEK
EX.4654 4 channel thermocouple ("JFC) input module (2 wire) 02-04-14
EX.4654 4 channel thermocouple (TC) input module (2 wire) 02-04-15
Model T
EX.4654 4 channel thermocouple (TC) input module (2 wire) 02-04-16
Type E
4-channel thermocouple (TC) input module
EX-4654 i 02-04-17
(2-wire) Type N
4-channel thermocouple (TC) input module
EX-4654 ) 02-04-18
(2-wire) model S
4-channel thermocouple (TC) input module
EX-4654 ) 02-04-19
(2-wire) Type R
EX.4654 4 channel thermocouple (TC) input module (2 wire) 02-04-20
Type B
EX.4654 4 channel thermocouple (TC) input module (2 wire) 02041
Type C
EX.4654 4 channel thermocouple (TC) input module (2 wire 020422

Thermal resistance (RTD) input module

02-04-23
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4 channel thermal resistance (RTD) input module 2
EX-4754 i i _ 02-04-24
wire or 3 wire (default 3 wire) PT200
4 ch 1 th 1 resi RTD) i le 2
EX.4754 c anne. therma .re51stance( ’)mput module 02-04-25
wire or 3 wire (default 3 wire) PT500
4-channel thermal resistance (RTD) input module
EX-4754 ) ) ) 02-04-26
2-wire or 3-wire PT1000 (default 3-wire)
4 channel thermal resistance (RTD) input module 2
EX-4754 ) ) i ; 02-04-27
wire or 3 wire (default 3 wire) Ni120
4 channel thermal resistance (RTD) input module 2
EX-4754 wire or 3 wire system (default 3 wire system) 02-04-28
resistance measurement
Analog output module
4-channel analog output module 0-10V 12-bit
EX-5014 02-05-01
accuracy 0.1%
4-ch 1 anal le 0-5V 12-bi
EX.5014 channel analog output module 0-5V 12-bit 02-05-02
accuracy 0.1%
4-channel analog output module £10V 12 bit
EX-5114 02-05-03
accuracy 0.1%
4-channel analog output module £5V 12 bit
EX-5114 02-05-04
accuracy 0.1%
4-channel analog output module 0-10V 16-bit
EX-5054 02-05-05
accuracy 0.02%
4-channel analog output module 0-5V 16-bit
EX-5054 02-05-06
accuracy 0.02%
4-channel analog output module +10V 16-bit
EX-5154 02-05-07
accuracy 0.02%
4-ch; 1 anal le £5V 16-bi
EX.5154 channel analog output module £5V 16-bit 02-05-08
accuracy 0.02%
4-channel analog output module 4-20mA 12-bit
EX-5414 02-05-09
accuracy 0.1%
4-channel analog output module 0-20mA 12-bit
EX-5414 02-05-10
accuracy 0.1%
4-channel analog output module 4-20mA 16-bit
EX-5454 02-05-11
accuracy 0.02%
4-channel analog output module 0-20mA 16-bit
EX-5454 02-05-12
accuracy 0.02%
8-channel analog output module 0-10V 12 bit
EX-5018 02-05-13
accuracy 0.1%
-ch 1 anal le 0-5V 12-bi
EX-5018 8-channel analog output module 0-5V 12-bit 02-05-14
accuracy 0.1%
8-channel analog output module +£10V 12 bit
EX-5118 02-05-15
accuracy 0.1%
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8-channel analog output module £5V 12 bit

accuracy 0.1%

EX-5118 02-05-16
accuracy 0.1%
EX.-5418 8-channel analog output module 4-20mA 12-bit 02-05-17
accuracy 0.1%
8-channel analog output module 0-20mA 12-bit
EX-5418 02-05-18

Function module

EX-6001 Single-channel NPN encoder module 02-06-01
EX-6011 Single channel PNP encoder module 02-06-02
EX-6021 Single channel differential encoder module 02-06-03
EX-6101 Single channel NPN pulse output module 02-06-07
EX-6111 Single channel PNP pulse output module 02-06-08
EX-6121 Single channel differential pulse output module 02-06-09
EX-6301 1 channel 485 free port communication module 02-06-12
EX-6311 1 channel 232 free port communication module 02-06-13
EX-6321 1 Modbus RTU Mater communication module 02-06-14
EX-TERO1 Terminal module 02-00-00
EX-0100 System power supply and I/O power module 02-00-01
EX-0300 I/O power module 02-00-03
cable Bt04-100 40P cable 10-02-00
Terminal
station ATO04 10-02-01
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